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INTRODUCTION 
Healthgrades has aligned with Crownpeak as its exclusive Healthcare web technology partner to create 
the latest version of CMS.  CMS was built leveraging the best of Crownpeak’s capabilities with 
Healthgrades’ innovation. 
 
The Crownpeak tool has been built with the marketer in mind, which makes editing in CMS intuitive and 
easy.  You can edit pages in a familiar browser mode without actually leaving the page.  Most 
importantly, your marketing team and content editors will no longer be dependent on IT or web 
development support for simple site revisions.  You are the editor, with no coding required. 
 
However, if markup or style language is your preference, CMS's editing tools are every bit as intuitive 
and convenient. 
 

CMS is designed with the marketer in mind. No coding required. 

 

Conventions Used in this Document 
References to screens and components of the application are in Bolded Initial Caps.  Field values are 
represented in italicized text.  Italicized text is also used for emphasis. 
 

Disclaimer 
The screen samples included in this document may vary from those you see in your software, based on 
configuration options selected.  Screen samples are included in this documentation to serve as a guide 
and training tool and are not intended to represent actual replicas of screens in your software.  Any 
patient names used in this documentation are fictitious. 
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THE EVENTS CONTENT APP 
The Events Content App allows consumers to search for events that are associated with the health 
care organization.  In this app, services and associated content can be customized based on the health 
care organization’s preferences. 
 
ACCESSING EVENTS 
To access Content App components from anywhere within CMS, click the Content Apps icon from 
the CMS left menu, as shown in the screen image below.  
 
The Content Apps console displays.  From the Content Apps console, you can manage Providers, 
Events, Locations and Services.  Each content app has its own menu of management items. 
 
Click the Events Content App image, outlined in red below, or the Events List link from the Events 
menu to open the Events page. 
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HOW TO PERFORM A FILTERED SEARCH 
The Events List page presents a multi-tabbed screen.  Available tabs are listed below.: 

• Home (Click this tab to return to the Content Apps console.) 
• Data (Events opens to this tab, by default.) 
• Settings 
• Dynamic Columns 
• Reports 

 
From the Home tab page, you can perform a filtered search by category, narrowing your search results, 
as you make selections from the following: 

• Keyword (free-text entry) 
• Create Date (free-text entry) 
• Publish Date (free-text entry) 
• Event Topic (drop-down, listing topics such as: ACLS CPR NRP COURSES, ACLS Topic, 

Bariatrics Weight Loss Surgery, Bone Health, Cancer, Cancer Support Groups to Transplant 
Organ, Weight Management, Wellness Programs, Women’s Health Education) 

• Event Type (drop-down, listing topics such as: Childbirth Education, Class, Fair or Health Fair, 
Free, Health Education, Online Class, Online Gift Shop, Screening, Seminar and Webinar) 

• Status (drop-down, options are: All, Enabled, Disabled) 
• Location (drop-down, listing your hospital locations) 

 
Search for an Event record by Keyword, Create Date, Publish Date, Event Topic (drop down list), 
Event Type, Status (All, Enabled, Disabled) or Location), with options to Apply (run the filter based 
on your selections), or to Clear Filter. 
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• ID (This field is generated by the system on creation of a new event.) 
• Title (This is the title of the event.) 
• Summary Description (This is the description of the event that was entered on creation.) 
• Location (This is the location where the event will be held.) 
• Created Date (This is the date the event record was created.) 
• Updated Date (This is the date the event record was updated.) 
• Enabled (If enabled, this event is viewable and searchable.) 
• Actions (Applicable to the selected record, or row, these are: Edit, Copy Event or Copy Event 

and Occurrence.) 
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USING THE COLUMN SORTING OPTIONS 
There are filtering options for each column, or sortable field of the record.  Sort Ascending, Sort 
Descending and Hide Column.  Once a column has been sorted, the Remove Sort option becomes 
available. 

 
UNHIDING A HIDDEN COLUMN 
To unhide a hidden column, select Edit > Publishing Refresh > Current. 
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USING THE ACTIONS BUTTONS 
Under the Actions column are additional options that are applicable to a selected record, or row: Edit, 
Copy Event or Copy Event and Occurrence. 
 
To select a record to perform an action on, use the checkbox button to the left of the record, then select 
the desired Actions option. 
 

   
  

Actions 
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HOW TO EDIT AN EVENT 
With your record selected, click the Edit (pencil icon) as depicted in the Using the Actions Buttons 
topic.  The selected event displays.  The fields are similar to the Create New event screen.  In order for 
this event to appear in the search filter options, ensure that the event is enabled, has a publish date 
and has at least one occurrence. 
 

 

Tabs on the left update the Edit screen context. 
• Basic Fields 
• Content 
• Event Topics 
• Event Types 
• Prerequisites 
• Occurrences 
• Registration Form 
• Email Templates 
• Direct URL History 
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Basic Fields 
Basic fields create your Registration Form.  A checkmark beside the field on the right indicates that 
the field is required.  They are as follows: 

• ID (This is system-generated when the event is created.) 
• External ID (If an external ID exists, it will display here.) 
• Enabled (Enable/deactivate the event using this checkbox. This field must be enabled for this 

event to appear in the search filter options) 
• Title (This is the event title.) 
• Description (Enter the description of the event.) (ü) 
• Contact Name (Enter a contact name in this free-text field.) 
• Contact Phone (Enter this information in contiguous numbers. The field auto-formats as a 

dash-delineated phone number, for example: 800-555-5555.) 
• Extension (Enter the phone extension number, where applicable.) 
• Contact Emails (Enter the contact emails for the event in email format.) 
• Notify Contacts (Check this box to notify contacts.) 
• Notify Frequency (Defaults to Immediately. Future functionality will include Weekly, Daily and 

Monthly.) 
• Publish Date (Begin typing in this date field to enter the publish date. The calendar widget 

displays for formatted selection. This field must be completed in order for this event to appear in 
the search filter options.) (ü) 

• Unpublish Date (Begin typing in this date field to enter the unpublish date. The calendar widget 
displays for formatted selection. Your event content will be removed from display on this date.) 

• External URL (Enter the external URL.) 
• Direct URL (Enter the direct URL.) (ü) 
• Custom Keywords (These are keywords that will be associated with the event.) 
• Generated Keywords (These are non-editable system-generated keywords that are related to 

the location.) 
• SEO Page Title (This is found in the <head> element. Title tags are often used on Search 

Engine Results Pages (SERPs) to display preview snippets for a given page, and are important 
both for SEO and social sharing. 

• SEO Page Description (Also found in the <head> element, this describes what a page is about 
in 150 characters or less. In search results, this returns as the main descriptive text.) 

• SEO Custom Meta Tags (Use custom <meta> tags to provide search engines with additional 
information about your pages. Search engines use this information to create rich snippets, or 
enable sorting of search results.) 

• SEO H1 (This heading 1 tag element is used near the top of the page as the page version of the 
page title, or to describe the page's content and is important for optimal SEO.) 

• SEO Primary Keyword (The primary keyword is the one searched most frequently.) 
• SEO Secondary Keyword (The secondary keyword is the one searched the second-most 

frequently.) 
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• SEO Canonical URL (The tag attribute bears similarity to a 301 redirect, but it communicates to 
search engines that multiple pages should be considered as one, without actually redirecting 
visitors to the new URL, so that you can still track visitors separately to unique URL versions, 
such as: Payment Gateway (PayFlow Pro, Authorize.net). The term, canonical, refers to 
conforming to an accepted rule or procedure.) 

• Registration Enabled (Check this box to enable registration for your event.) 
• Include Guest Demographic Info (Check this box to include guest demographic information.) 
• Maximum Attendees (Enter a number in this field by which to restrict the number of attendees.) 
• Business Unit ID (Enter the business unit ID.) 
• Cost (Enter the price of admission in this free-text field.) 
• Location (Select the location of the event from the drop-down list options.) 
• Cost Center (Enter the name of the department or other type of unit within your organization to 

which costs may be charged, for accounting purposes.) 
 

Show  
Click the Show/Hide button to reveal a contextual-content WYSIWYG editor for each of the below: 

• Special Instructions / Show (Format your message as it will be viewed by users.) 
• Custom Field 1-3 (Add your Custom Field content.) 
• Food Choice (drop-down, select from the available options for your event, such as Vegan, Non-

Dairy, etc.) 
• Interested in Being Waitlisted (drop-down, select Yes or No.) 
• Enable Add Registrant Button (This checkbox defaults to True, or enabled, meaning 

the Event Cart Add Additional Registrant label and button is available.  Uncheck it to hide 
the Event Cart Add Additional Registrant label and button.) 
 

Choose Cancel to return to the previous screen without saving any of your changes.  Choose Save to 
commit your changes and remain in the edit screen.  Choose Save and Return to the List to commit 
your changes and return to the list page. 

Event Occurrences 
To help Events Administrators run Event Reports more efficiently, display-only Occurrence IDs are 
now viewable in the Active Occurrences list, within Events admin. 
 

How to Access Event Occurrences 
To access Occurrences, go to Content Apps > Events (Events List in the default Data tab).  Select 
an event and under the Actions tab, click the Edit (pencil) icon.  When the Edit screen opens, in the 
left panel, choose the Occurrences tab.  Active Occurrences display here.  
 
For our example below, we chose an event named Event - ACLS Preparatory Course 2 Day Session 
with an Active Occurrence (ID 495).  Table view, or grid fields are as follows: 

• ID (This ID is system-generated when the event occurrence is created.) 
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• Date & Time (This is the date and time of the event occurrence.) 
• Location (This is the location of the event occurrence, whether All, Enabled or Disabled.) 
• Presenter (This field holds the name of the event occurrence presenter.) 
• Contact (This field holds the name of the event occurrence contact.) 
• Edit (Click the Edit pencil icon to edit this event occurrence record.) 

 

Email Templates - Email Cancellation Template 
Once a registrant has been removed from an event, a configurable cancellation email is generated and 
sent to the registrant.  With this template, an administrator will be able to design a custom “Thank You“ 
message for each event. 
 
Locate the Email Cancellation Template tab in the left navigation of the edit screen for your selected 
event.  The Email Cancellation Template has the same configuration fields, tokens, and functionality 
used in the Email Confirmation Template. 
 
Note: 

This is not the same as the email that is automatically generated when an event is cancelled. 

• From Address (Enter a properly-formatted From email address (email@domain.com) in this 
free-text field.) 

• Subject (Enter the subject of your email in this free-text field.) 
• Body (The fields in this section comprise the body of your email.  Use the formatting tools in the 

included WYSIWYG editor to style the text elements of your email.  Use the tokens throughout 
(as listed) the body text where needed to personalize your message with existing data about the 
recipient and event.) 

• Hide (Expand/contract this control to Show/Hide the Body section of this email template.) 
 

Available Tokens 
These tokens populate with information from the Event Registration. 

• $EventsInfoStart$  
• $EventTitle$  
• $EventDateTime$  
• $LocationName$  
• $LocationAddress$  
• $RegistrantFirstName$  
• $RegistrantLastName$  
• $DiscountCode$  
• $RegistrantAddress$  
• $RegistrantPhone$  
• $RegistrantEmailAddress$  
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• $EventSpecialInstructions$  
• $EventOccurrenceSpecialInstructions$  
• $CostOfEventOccurrence$ 
• $EventsInfoEnd$  

Registration Confirmation Template 
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HOW TO CREATE A NEW EVENT 
Click the Create New button from the lower right of the Event Data tab List screen.  

 
The New Event screen displays, as shown below, 

 
Complete the following fields to create a new Event record.  These fields are similar to those in the 
screen that opens to edit an existing record.  In order for this event to appear in the search filter 
options, ensure that the event is enabled, has a publish date and has at least one occurrence. 
 

• Enabled (Enable/deactivate the event using this checkbox. This field must be enabled for this 
event to appear in the search filter options) 

• Title (Enter the title of the event.) (*required) 
• Description (Enter the description of the event.) (*required) 
• Event Topic (Choose an event topic from the drop-down options.) (*required) 
• Event Type (Choose an event type from the drop-down options.) (*required) 
• Contact Name (Enter a contact name in this free-text field.) 
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• Contact Phone (Enter this information in contiguous numbers. The field auto-formats as a 
dash-delineated phone number, for example: 800-555-5555.) 

• Extension (Enter the phone extension number, where applicable.) 
• Contact Emails (Enter the contact emails for the event in email format.) 
• Notify Contacts (Check this box to notify contacts.) 
• Notify Frequency (Defaults to Immediately. Future functionality will include Weekly, Daily and 

Monthly.) 
• Publish Date (Begin typing in this date field to enter the publish date. The calendar widget 

displays for formatted selection.) (*required) 
• Unpublish Date (Begin typing in this date field to enter the unpublish date. The calendar widget 

displays for formatted selection. Your event content will be removed from display on this date.) 
• External URL (Enter the external URL.) 
• Direct URL (Enter the direct URL.) (*required) 
• Internal Event (Checking this box indicates that the event is internal.) 
• Public Event (Checking this box indicates that the event is external.) 
• Generated Keywords (These are non-editable, system-generated keywords that are related to 

the location.) 
 
 

The majority of consumers use search engines to make purchase decisions; therefore, top 
digital marketing organizations prioritize the practice of Search Engine Optimization (SEO). The 
following page elements are essential to SEO success, because combined, they communicate 

the essence of your message. 

 
• SEO Page Title (This is found in the <head> element.  Title tags are often used on search 

engine results pages (SERPs) to display preview snippets for a given page, and are important 
both for SEO and social sharing.  
 
The title element of a web page should be a concise description of a page's content.  Users see 
the title in two places: as the page's name in the browser tab and in search results.) SEO Page 
Title (This is found in the <head> element. Title tags are often used on search engine results 
pages (SERPs) to display preview snippets for a given page, and are important both for SEO 
and social sharing. 

• SEO Page Description (Also found in the <head> element, this describes what a page is about 
in 150 characters or less. In search results, this returns as the main descriptive text.) 

• SEO Custom Meta Tags (Use custom <meta> tags to provide search engines with additional 
information about your pages. Search engines use this information to create rich snippets, or 
enable sorting of search results.) 



 
 
 

 

The contents of this document are confidential and proprietary to Healthgrades and are meant for private circulation only.  No part of this document may be 
disclosed, reproduced, transmitted or copied in any form or by any means without the express written permission of Healthgrades  

©2019 HEALTHGRADES.  All rights reserved. 

21 

• SEO H1 (This heading 1 tag element is used near the top of the page as the page version of the 
page title, or to describe the page's content and is important for optimal SEO.) 

• SEO Primary Keyword (The primary keyword is the one searched most frequently.) 
• SEO Secondary Keyword (The secondary keyword is the one searched the second-most 

frequently.) 
• SEO Canonical URL (The tag attribute bears similarity to a 301 redirect, but it communicates to 

search engines that multiple pages should be considered as one, without redirecting visitors to 
the new URL, so that you can still track visitors separately to unique URL versions, such as: 
Payment Gateway (PayFlow Pro, Authorize.net). The term, canonical, refers to conforming to 
an accepted rule or procedure.) 

• Registration Enabled (Check this box to enable registration for your event.) 
• Include Guest Demographic Info (Check this box to include guest demographic information.) 
• Maximum Attendees (Enter a number in this field by which to restrict the number of attendees.) 
• Business Unit ID (Enter the business unit ID.) 
• Cost (Enter the price of admission in this free-text field.) 
• Location (Select the location of the event from the drop-down list options.) 
• Cost Center (Enter the name of the department or other type of unit within your organization to 

which costs may be charged, for accounting purposes.) 
• Special Instructions (Click the Show/Hide button to reveal a content WYSIWYG editor that 

allows you to format your message as it will be viewed by users.) 
• Custom Field 1-3 (Click the Show button to reveal a content WYSIWYG editor, so that you can 

create custom fields with rich-text formatted content, as it will be viewed by users.) 
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EVENT TOPICS 
The Event Topics option allows you to add, edit and remove event topics.  This page contains a filter 
to assist with locating event topics by Status (All, Enabled, Disabled). 

Accessing and Editing the Event Topics Page 
To access this page, choose the Event Topics link from the Events Content App menu, we discussed 
earlier, or from the Data drop-down option, within the Events Content App.  
 

 
The Event Topics management page displays.  
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The Event Topics management columns are sortable, as described in the Using the Column Sorting 
Options topic. 

• Name (This is the name of the event topic.) 
• Enabled (True or False) 
• ID (This is the system-generated Event Topic ID. It is non-editable.) 
• Actions (Click the Edit pencil icon to revise any of these editable field values.) 

 
Note:   

Event Topics can also be added directly from a Location record. 
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HOW TO EDIT AN EVENT TOPIC 
With your target row selected, click the Edit (pencil) icon under Actions.  Make your edits using the 
available fields.  

• ID (This is the system-generated Event Topic ID. It is non-editable.) 
• Name (This is the name of the event topic.) 
• Enabled (True or False) 
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HOW TO CREATE A NEW EVENT TOPIC 
Click the Create New button from the lower right of the Event Types management page.  
The New Event Topic screen displays, as shown below, 

 
Complete the following fields to create a new Event Topic record.  These fields are similar to those in 
the screen that opens to edit an existing record. 
 

• Name (Enter the name of the event.) (*required) 
• Enabled (Enable/deactivate the event topic using this checkbox.  This field must be enabled for 

this event topic to appear in the search filter options.) 
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ACCESSING AND EDITING EVENT TYPES 
The Event Types option allows you to add, edit and remove event types.  This page contains a filter to 
assist with locating event types by Status (All, Enabled, Disabled). 
 
To access this page, choose the Event Types link from the Events Data tab menu. 
 
 The Event Types management page displays.   

 
The columns are sortable, as described in the Using the Column Sorting Options topic. 

• Name (This is the name of the event.) 
• Enabled (True or False) 
• ID (This is the system-generated Event Type ID. It is non-editable.) 
• Actions (Click the Edit pencil icon to revise any of these editable field values.) 

  

Edit 

Remove Add 
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HOW TO CREATE A NEW EVENT TYPE 
Click the Create New button from the lower right of the Event Types management page.  
 

 
The New Event Type screen displays, as shown below. 
 
Complete the following fields to create a new Event Type record.  These fields are similar to those in 
the screen that opens to edit an existing record. 
 

• Name (Enter the name of the event.) (*required) 
• Enabled (Enable/deactivate the event using this checkbox.  This field must be enabled for this 

event to appear in the search filter options.) 
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REGISTRANT SEARCH 
The Registrant Search option allows you to search and view event registrant information.  This page 
contains a filter to assist with locating event registrants and events by name, with options to Apply (run 
the filter based on your selections), or to Clear Filter. 

To Access the Registrant Search Page 
To access this page, choose the Registrant Search link from the main Content App Events menu, or 
from the Events Data tab drop-down menu option. 
 
The Search Events Registrants screen displays.  Search filters at the top of the screen help refine 
your search, by Select Registrant, Select Event and Select Event Occurrence.  To quickly locate 
registrants for a specific event, first make a selection from the Select Event drop-down options, then 
use the Event Occurrence filter.  The type-ahead feature is available in both the Select Registrant 
and Select Event fields. 

Each registrant row, or record displays columns as listed below.  The columns are sortable, as 
described in the Using the Column Sorting Options topic. 

• Name  
• Event Title  
• Email Address  
• Address  
• Phone Number  
• Occurrence ID 
• Date Time 
• Actions (View additional detail on a record.) 

 
This information is for reference and is read only. 

  

Begin 
typing. 
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USING THE EVENT REGISTRANT EDIT SCREEN 
From the Registrant Search screen, click the Edit pencil icon next to any record, or row  to open that 
registrant’s edit screen.  The Event Registrant [Registrant Name] screen displays, with the following 
fields: 

• Registrant ID (This field is system-generated and is not editable.) 
• First Name (Edit the registrant’s first name with this field.) 
• Last Name (Edit the registrant’s last name with this field.) 
• Address 1 (Edit the registrant’s street address with this field.) 
• Address 2 (Edit the registrant’s apartment number if applicable, with this field.) 
• City (Edit the registrant’s city with this field.) 
• State (Select the name of the state in which the registrant resides from the drop-down menu.) 
• ZIP Code (Edit the ZIP code in which the registrant resides in this field.) 
• Email Address (This field is not editable.) 
• Phone Number (Edit the registrant’s phone number with this field.) 
• Notes (Editable. Enter or edit notes regarding the registrant with this multi-line field. This field is 

now also a display field option within Event reporting.) 
• Event Title (Non-editable link. The link displays the title of the event. For example: Joint Pain 

Seminar. Click this link to open the Event edit screen for that event.) 
• Date Registered (Non-editable) 
• Location (Non-editable This is the location of the event. For example: Peachtree Hospital.) 
• Presenter (This field is system-generated and is not editable.) 
• Start Date (Non-editable. This is the start date of the listed event.) 
• Start Time (Non-editable. This is the start time of the listed event.) 
• Price (Non-editable. This is the price of the listed event.) 
• Transaction ID (This field is system-generated and is not editable. 

 
At the bottom-right of the screen are four buttons. 

• Cancel (Click this button to clear any changes you have made and close the screen.) 
• Remove (Click this button to remove this event registrant from this event.) 
• Save And Return To List (Click this button to commit any changes you have made and return 

to the Search Events Registrants screen.) 
• Save (Click this button to commit any changes you have made.) 
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About Removing a Registrant from an Event 
Clicking the Remove button removes a registrant from the event, the Registrant Search list and the 
emailed event roster.  On removing a registrant, the available seat count for the event is updated and a 
cancellation notice is emailed to both the registrant and event contact email address. 
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HOW TO ENABLE OR DISABLE THE ADD ADDITIONAL REGISTRANT LABEL AND BUTTON 
It is now possible to enable and disable the ability to add additional registrants for individual events, 
through the API. 
 
In this release, the Isaddregistrantbuttonenabled field has been added to the Event table in the 
database. In the Event Administrative view, this field displays as a checkbox, labeled Enable Add 
Registrant Button, which is defaulted to True, or enabled, meaning the Event Cart Add Additional 
Registrant label and button is available. 
 
When this checkbox is not checked, or is disabled, the Add Additional Registrant section and button 
will be hidden from the Event Cart page. 
 
Problem Solved: 
Many childbirth education classes have "per couple pricing" wherein two people (mother/partner) can 
attend for the cost of one registration fee. Users often add the spouse as an additional registrant, which 
previously resulted in double charging the user and occupying an additional seat in the class, 
unnecessarily. 
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How to Enable or Disable the Event Cart Add Additional Registrant Section and Button 
To access the configuration checkbox for this new feature, go to Content Apps > Events List.  Add a 
new Event using the Create New button, or select your event from the list and choose Actions > Edit 
(pencil) icon.   
 
Depending on your selection, the New Event displays, as shown below, or the Event edit screen 
displays, open at the Basic Fields tab.  In either screen, scroll to the bottom of the page to enable 
(check) or disable (uncheck) the Event Cart Add Additional Registrant section and button with the 
Enable Add Registrant Button checkbox.   

 
This is how the Event Cart displays when the Enable Add Registrant Button checkbox is enabled 
(default setting). 



 
 
 

 

The contents of this document are confidential and proprietary to Healthgrades and are meant for private circulation only.  No part of this document may be 
disclosed, reproduced, transmitted or copied in any form or by any means without the express written permission of Healthgrades  

©2019 HEALTHGRADES.  All rights reserved. 

33 

 
Event Cart mailing address fields, which include: Address1, City, State and ZIP Code are no longer 
only required fields, although they are defaulted as such.  These fields are now configurable by an 
Administrator within Events as Required or Not Required. 
 
Note: 

These fields will still be required for any paid events. 
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REGISTRATION FORM 
The Registration Form allows you to create, edit or remove custom event registration form fields. 
 

How to Access the Registration Form Page 
To access this page, choose the Registration Form link from the main Content Apps Events menu, 
or from the Data tab drop-down menu option.   

 
The Registration Form page displays.  Each row, or record displays columns as listed below.  The 
columns are sortable, as described in the Using the Column Sorting Options topic. 

• Template Name (This is the Registration Form template name.) 
• Actions (Click the Edit (pencil) icon to revise the Template Name.) 

 

 

 

 

 

  

Add Remove 

Edit 
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HOW TO CREATE A REGISTRATION FORM 
Click the Create New button from the lower right of the Registration Form screen.  
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The New Template screen displays, as shown below. 
 
Create a Registration Form by defining a Template Name and building Left and Right Columns, as 
shown below. 
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Enter a name for your template in the Template Name (*required) field, as shown above.  Add 
columns, using the Left and Right Column buttons.  Below, we clicked the Left Column button.  You 
have options to add existing columns or create new ones. 

 
  

Add new 
column, 

Select 
from 

existing. 
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ADDING A NEW LEFT OR RIGHT COLUMN TO YOUR REGISTRANT FORM 
Click the Add button from the New Template screen view (see How to Create a Registrant Form) 
and the screen changes to provide entry fields: 

• Field Name (Enter the name of your new column field.) (*required) 
• Field Label (Enter the column field label name.) (*required) 
• Is Required (Designate whether this is a required field by selecting or deselecting this 

checkbox.) 
• Data Type (Define this field’s data type as a text, number, date or drop-down field, using the 

drop-down options.) (*required) 

Choose Cancel to return to the previous screen without saving any of your changes.  Choose Save to 
commit your changes and remain in the Edit screen.  Choose Save and Return to the List to commit 
your changes and return to the list page.  Click the Delete button to remove the Left or Right column, if 
desired and confirm the deletion in the confirmation message that follows by clicking Ok. 
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SETTINGS 
Choose the Settings link from the Content App Events menu, or from the Events Settings tab.  The 
Event Settings management page displays. 

Search Setting Options on This Page 
• Search Results Page URL (Enter the URL of the referenced Search Results page.) 
• Default Page Size (Enter the number of results to display from a search (defaults to 10).) 
• Pager Position (Configure the placement of the pagination feature on the Search Results 

page. Available options are: Top and Bottom, Top, Bottom.) 
• ZIP Code Search Results Radius Options (Set the default ZIP Code search radius (in miles) 

Options are: 10, 50, 100, 200) 
• Refresh Site Search Index (Click this button to refresh site search after adding, editing or 

deleting records.) 
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Detail Settings Options on This Page 
• Detail Page URL (This is the full URL to the Events public profile page.) 
• Direct URL Path (Enter the direct URL path of the event.) 

 
 

The majority of consumers use search engines to make purchase decisions; therefore, top 
digital marketing organizations prioritize the practice of Search Engine Optimization (SEO). The 
following page elements are essential to SEO success, because combined, they communicate 

the essence of your message. 

 

SEO Settings Options on This Page 
Tokens1 comprise the formulas that create each element.  Consider them as objects.  A list of available 
tokens is provided for each section (see image below).  Copy and paste them in the fields in the order 
the chosen elements should appear, being mindful of syntax.  
 
You can also add static (non-dynamic) words around the tokens.  The intent is to replace the contents 
of the token fields on the published page with data referenced from a list.  
 

• Detail Page Formula (These tokens form the Events Detail page.) 
• Search Results Page Keyword Formula (This formula comprises the keyword search on the 

Events page, for example: Find {KeywordSearched} Wellness Classes and Events, etc.) 
• Search Results Page Event Name Formula (This formula comprises the Search Results page 

Event Name.) 
• Search Results Page Event Topic Formula (This formula comprises the Search Results page 

Event Topic.) 
• Search Results Page Event Type Formula (This formula comprises the Search Results page 

Event Type.) 
• Search Results Page ZIP Code Formula (These tokens comprise the Events ZIP search. For 

example, in the field displayed below, we see: Find Wellness Classes and Events near 
{ZIPCodeSearched} - Page {PageNum} - {FacilityName}, {FacilityCity}, {FacilityState} 
({FacilityStateAbbrev}.) 

 
  

                                                
1 A token, simply stated, is a symbolic representation of a larger piece of data. 
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• Search Results Page Base Formula (This is a standard formula for the page title on search 
results, for example: Find Wellness Classes and Events in {TargetCity}, {TargetState} 
({TargetStateAbbrev}) - Page {PageNum} - {FacilityName}, {FacilityCity}, {FacilityState} 
({FacilityStateAbbrev}.) 
 

• Below this area are additional entries for your use.  Enter these as instructed, to clean up extra 
or empty separator values in the SEO titles.  Use {sp} to denote spaces, as instructed. 

 
 
  

Available 
Tokens 
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DYNAMIC COLUMNS 
Choose the Dynamic Columns tab from within the Events Content App.  The Dynamic Columns – 
Events page displays. 
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From the Dynamic Columns – Events page, you can create custom Event detail fields.  To create a 
new field, click the Create New button.  The New Dynamic Column screen displays. 

 

Custom field options in the New Dynamic Column screen include the following: 
• Field Name (This is the name of the custom field.) (*required) 
• Field Label (This is the name that will display on the published page for the custom field.) 

(*required) 
• Is Required (Check this box to indicate that the custom field is required.) 
• Data Type (This is the type of data that will populate the custom field. Select the data type from 

this drop down, whether (Text, Number, Date, Dropdown or Content Editor).) 
• Max Length (If Text is selected as the Data Type, enter the maximum number of characters to 

be allowed in the custom field.) 
• Is Multiline (If Text is selected as the Data Type, check this box to designate the custom field 

as a multiline entry text box (only available for Text data type). Multiline text allows more than 
one line of text in the resulting text field, where applicable and supports word wrapping, vertical 
and horizontal scrolling.) 

• Dropdown Options (A selection of Dropdown as the Data Type renders this additional 
contextual configuration field. This field allows free-text entry and comprises the list items of the 
drop-down field.) 

  

Dropdown 
Options 
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Once you have made your selections and entered any needed information for your custom field, click 
Save and Continue. 
 

If you have used spaces in the first field: Field Name, you will see an error message restricting you 
from saving your custom field.  This will be the name of your custom field in for example: My_Event.  

Replace any spaces with an underbar to meet this requirement. 

If all information has been entered according to the restrictions for each of these fields, a confirmation 
message displays. 
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EVENTS REPORTING ENHANCEMENTS   
Additional report filters and result columns have been added, as well as new standard reports and 
instructions on how to use Event Reporting.  Additional enhancements are categorized below: 
. 
New headings: 

• Two new headings have been added to classify report fields: Event and Occurrence. 
 

Renamed: 
• Status has been renamed to Event Status. 
• Publish Date has been renamed to Event Publish Date. 
• Unpublish Date has been renamed to Event Unpublish Date. 
• Location has been renamed to Event Location. 
• Contact Name has been renamed to Occurrence Contact Name. 
• Presenter has been renamed to Occurrence Presenter. 
• Sponsoring Location has been renamed to Occurrence/Sponsoring Location. 
• Registration Start Date has been renamed to Occurrence Registration Start Date. 
• Registration End Date has been renamed to Occurrence Registration End Date. 

 
New filter options: 

• Event Title (drop-down) 
• Event Location (drop-down) 
• Event ID 
• Occurrence Custom Location (textbox) 
• Occurrence Cost Center 
• Occurrence ID 
• Occurrence Status 

 
New Available (Results) field options: 

• Event ID (This ID is system-generated when the Event is created.) 
• Event Status (This is the event status, whether All, Enabled or Disabled.) 
• Event Seats Available (This is the number of event seats that are available.) 
• Occurrence Custom Location (This is the location where the custom event occurrence will 

be/was held.) 
• Occurrence Cost Center (This is the name of the department or other type of unit within your 

organization to which costs may be charged for the event occurrence, for accounting purposes.) 
• Occurrence Seats Available (This is the number of event occurrence seats that are available.) 
• Occurrence ID (This ID is system-generated when the Event Occurrence is created.) 
• Occurrence Status (This is the event occurrence status, whether All, Enabled or Disabled.) 
• Occurrence Business Unit ID (This ID is system-generated when the Event Occurrence is 

created.) 



 
 
 

 

The contents of this document are confidential and proprietary to Healthgrades and are meant for private circulation only.  No part of this document may be 
disclosed, reproduced, transmitted or copied in any form or by any means without the express written permission of Healthgrades  

©2019 HEALTHGRADES.  All rights reserved. 

46 

 
The following has been removed from the Available (Results) field options: 

• Registrantdiscountcode 
  
Other enhancements: 

• Filter Criteria are now grouped together: (Events | Occurrences). 
• Six new standard out-of-the-box reports are now available. 
• Report data is now validated. 
• Document reporting functionality has been modified, by adding and removing available field 

options for the report, affecting how the data is filtered. 
  
Other modifications: 

• Amount Paid now has two decimal places, instead of four. 
• The <br/> tags within the Address field have been removed. 
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REPORTS 
Events includes several reporting features.  Choose the Reports tab from within the Events Content 
App.  The Reports page displays. 

From the Reports page, you can search for Event reports, run existing event reports or create new 
Event reports, with options to Run Report or Clear Filter. 
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Report Search/Filter Options 
The report filters are searchable from filters in two major categories: Event Options and Event 
Occurrence Options. 
 

 

Enter Your Criteria Using the Event Options 
• Keyword (Enter a keyword on which to search for a report.) 
• ID (This ID is system-generated when the event is created.) 
• Publish Date (Begin typing in this date field to enter the Publish Date.  The calendar widget 

displays for formatted selection.) 
• Unpublish Date (Begin typing in this date field to enter the Unpublish Date.  The calendar 

widget displays for formatted selection.  This is the date when event content was removed from 
view.) 

• Title (This is the event title.) 
• Location (Enter the event location in the free-text field.) 
• Topic (Select from Event Topic drop-down options, such as: ACLS CPR NRP COURSES, 

ACLS Topic, Bariatrics Weight Loss Surgery, Bone Health, Cancer, Cancer Support Groups to 
Transplant Organ, Weight Management, Wellness Programs, Women’s Health Education) 
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• Type (Choose a report type from the drop-down options, listing topics such as: Childbirth 
Education, Class, Fair or Health Fair, Free, Health Education, Online Class, Online Gift Shop, 
Screening, Seminar and Webinar) 

• Status (Make a selection from the drop-down: (All, Enabled, Disabled) 
 

Event Occurrence Options 
• ID (This ID is system-generated when the Event occurrence is created.) 
• Cost Center (Enter the name of the department or other type of unit within your organization to 

which costs may be charged, for accounting purposes.) 
• Registration Start Date (Begin typing in this date field to enter the Registration Start Date.  

The calendar widget displays for formatted selection.) 
• Registration End Date (Begin typing in this date field to enter the Registration End Date.  The 

calendar widget displays for formatted selection.) 
• Start Date Range (Begin typing in this date field to enter the Start Date Range.  The calendar 

widget displays for formatted selection.) 
• End Date Range (Begin typing in this date field to enter the End Date Range.  The calendar 

widget displays for formatted selection.) 
• Contact Name (Select a contact name from the populated list.) 
• Presenter (Select a name from the populated list.) 
• Location (Select a location from the populated list.) 
• Custom Location (Type in a location in this free-text field.) 
• Status (Make a selection from the drop-down.  Options are: (All, Canceled, Active, Disabled or 

Expired.) 
 

Note: 
The Event Occurrence Start Date and Event Occurrence Location are now sent to ULM when 
event registrations are captured.  If a custom location is used on an event occurrence, the 

custom location is sent as the event occurrence location. 
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REPORT SETTINGS 
The Report Settings section of this tab includes options to run Existing Reports or create New 
Reports. 
 

To Run an Existing Report 
Click the Existing Report tab, choose an existing report definition from the Select Existing Report 
Definition drop-down list and click the Run Report button.  You can modify the report, by dragging 
fields into the Report Fields area from the Available Fields pane, and clicking Run Report.  Save 
your modifications by clicking the Save button. 
 

Available Fields 
• EventId ID (This ID is system-generated when the report is created.) 
• EventTitle (This is the title of the event) 
• EventStatus (This is the event status, whether All, Enabled or Disabled.) 
• EventDescription (This is the description of the event that was entered on creation.) 
• EventCreatedDate (This is the date on which the event was created.) 
• EventPublishDate (This is the date on which the event was published.) 
• EventLocation (This is the location where the event will be / was held.) 
• EventTotalRevenue (This is the total revenue for the event.) 
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• EventTotalRegistrants (This is the total number of event registrants.) 
• EventSeatsAvailable (This is the number of event seats that are available.) 
• EventBusinessUnitId (This is the business unit ID that was entered when the event was 

created.) 
• OccurrenceId[1] (This is the system-generated event occurrence ID.) 
• OccurrenceStatus (This is the status of the event occurrence, whether All, Enabled or 

Disabled.) 
• OccurrenceContactName (This is the contact name that was entered for the event 

occurrence.) 
• OccurrenceContactPhone (This is the contact phone number that was entered for the event 

occurrence.) 
• OccurrenceContactEmail (This is the contact email address that was entered for the event 

occurrence.) 
• OccurrenceCostCenter (This is the name of the department or other type of unit within your 

organization to which costs may be charged, for accounting purposes.) 
• OccurrenceStartDate (This is the event occurrence start date.) 
• OccurrenceIsEnabled (This is the On state of the event occurrence status: Enabled.) 
• OccurrencePresenter (This is the entered event occurrence presenter.) 
• OccurrenceLocation (This is the location of the event occurrence.) 
• OccurrenceCustomLocation (This is the event occurrence custom location.) 
• OccurrenceCapacity (This is the seating capacity of the event occurrence. How many 

attendees can be accommodated at this location?) 
• OccurrenceSeatsAvailable (This is the number of event occurrence seats available.) 
• OccurrenceTotalRevenue (This is the total revenue from the event occurrence.) 
• OccurrenceTotalRegistrants (This is the total number of event occurrence registrants.) 
• RegistrantName (This is the event occurrence registrant name.) 
• RegistrantAddress (This is the event occurrence registrant address.) 
• RegistrantEmail (This is the event occurrence registrant email address.) 
• RegistrantPhone (This is the event occurrence registrant phone number.) 
• RegistrantDateRegistered (This is the date the registrant registered for the event occurrence.) 
• RegistrantAmountPaid (This is the amount the registrant paid for the event occurrence.) 
• RegistrantTransactionId (This is the system-generated transaction ID that was created, when 

the registrant paid for the event occurrence.) 
• RegistrantAttended (This field indicates whether the registrant attended the event occurrence.) 
• RegistrantNotes (This field holds the notes regarding the registrant that were entered in the 

Event Registrant Edit Screen.) 
  



 
 
 

 

The contents of this document are confidential and proprietary to Healthgrades and are meant for private circulation only.  No part of this document may be 
disclosed, reproduced, transmitted or copied in any form or by any means without the express written permission of Healthgrades  

©2019 HEALTHGRADES.  All rights reserved. 

52 

 

Custom Event Registration Fields 
New custom Event Registration fields are now listed under Available Fields for Event Reports, 
easily identifiable by the presence of the word, Custom at the beginning of the field name. 

• CustomCardioNewsletter 
• Customwaitlisted 
• Customdate_of_birth 
• CustomFoodChoice 
• CustomInsurance 
• CustomEvent Title  
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HOW TO CREATE A NEW EVENT REPORT 
To create a new Event report, click the New Report tab, enter your new report name into the Enter 
Report Definition Name free-text field, then drag and drop the desired report fields from the Available 
Fields pane into the Report Fields pane, as shown in the Report Settings topic. 

 
Tip:  
 
 

Once the fields are in the Report Fields column, you can also rearrange them using the drag and 
drop functionality. 
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THE PROVIDERS CONTENT APP 
The published Providers Content App allows consumers to search for providers who are associated 
with a health care organization. Provider profiles, including content, can be customized based on the 
health care organization’s preferences and include the following. 

• Philosophy of Care 
• Bio 
• Specialty 
• Locations 
• Contact Information 
• Provider Photo 
• Appointment Requests 

 
HOW TO ACCESS THE PROVIDER LIST 
Access the Providers Content App via the Content Apps console.  To access Content App 
components from anywhere within CMS, click the Content Apps option from within the Apps left 
menu.  Click the Provider List link from the Providers menu. 
 
From the Content Apps console, you can manage Providers, Events, Locations, Services and other 
configuration items.  Each content app has its own menu of management items. The Providers content 
app, identified in red below, provides a search (filter) and the ability to edit or remove existing provider 
records, as well as to create new records.  Click either the Providers image or the Providers List link. 
 
 

  

Content 
Apps 
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SEARCHING FOR PROVIDERS 
The Providers page displays. This page can also be accessed from the Data tab drop-down menu 
option of the at the top of the screen. From the Providers page, you can perform the following actions: 

• Search for a provider record by Name, Status (All, Enabled, Disabled) and/or Specialty. 
• Create New provider records. 
• Edit provider records. 
• Remove provider records. 

 
  

Edit 

 

Remove or 
Create New 
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HOW TO CREATE A NEW PROVIDER 
Clicking the Create New button from the lower right of the Providers page, opens the New Provider 
page. A red asterisk indicates that a field is required.  
Ꮵ 
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Scroll to the bottom of the page (image, below). The Show > link can be clicked on any applicable field 
to reveal a WYSIWYG editor. This is a field of the type, Content Editor. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Show > 

The WYSIWYG editor allows the addition of rich 
text, text formatting, text alignment, links, 
images, video and HTML, while you edit in 

human-readable format. 
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HOW TO EDIT PROVIDERS 
From the Providers page, click the Edit pencil icon for a record to revise information. The main (Basic 
Fields) screen displays. You can also navigate quickly to other available edit screens by topic, by 
clicking one of the selections from the left panel.  Basic Fields allow you to add information for your 
provider by category.  A checkmark on the right of a field indicates that the field is required.  Basic 
Fields are as follows: 

• Specialties and Conditions  
• Locations  
• Languages  
• Education  
• Clinical Interests  
• Types  
• Board Certifications  
• Direct URL History 

  

Edit 
screens by 
category 

This list is comprised of 
options selected in the Data 

> Genders screen. 
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HOW TO ADD AND EDIT LOCATION CONTENT 
This screen builds the Location content for the Provider Profile page.  The fields of this screen are 
detailed below.   The provider’s designated Primary Location is displayed at the top of the list on the 
public-facing detail page.  Any additional locations are listed alphabetically beneath the primary 
location. 
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Provider Profile Location Fields 
• Location Name (This is the read-only display name of the location.  To add an additional 

location, use the Add button and drop-down menu at the top-right of the page.  To delete the 
location, use the Delete button from the same area and confirm your selection.) 

• Is Primary (Check this box to designate this location as primary.  The Primary Location is 
listed first on the Provider Profile page.) 

• Phone Number (Enter the phone number to be used for this location.) 
• Fax Number (Enter the fax number to be used for this location, if applicable) 
• Is Accepting New Patients (Check this box if the provider is actively accepting new patients.) 
• Allow Appointment Requests (Check this box to indicate that the provider allows appointment 

requests.) 
• Hide from Display (Select the desired option from this drop-down field.  Options are: (No, Yes 

or Inherit from Location (Not Hidden)).) 
• Insurances (Expand this panel and use the drop-down list to select and display accepted 

insurances for this location.  Click an insurance name from the list to highlight it and use the 
Add Existing button to add the insurance to the list of accepted insurances.  Remove an 
insurance name from the list using the Delete button for that row and confirm your action in the 
box that displays.) 

• Services (Expand this panel and use the drop-down list to select and display the services 
provided at this location.  Click a service name from the list to highlight it and use the Add 
Existing button to add the service to the list of provided services.  Remove a service name from 
the list using the Delete button for that row and confirm your action in the box that displays.) 

• Hours (Expand this panel and click the Create New button to configure hours of operation for 
the location by Day, Open Time and Close Time.  Remove hours from the list using the Delete 
button for that row and confirm your action in the box that displays.) 
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How to Exclude Specific Locations from Displaying on Provider List and Provider Detail Pages 
Admins can now exclude specific locations from displaying on Provider List and Provider Detail 
pages.  From Content Apps > Providers List, select the Edit (pencil) icon for your provider.  In the 
edit screen that displays, under the Location tab, select the desired option from the Hide from Display 
drop-down field, whether No, Yes or Inherit from Location (Not Hidden). 
 
The Location and Provider APIs have also been updated with these new settings. 

 
Note:  
If this configuration is enabled on a specific Location record, that location will be 
inherited at the provider level.  That location will be excluded from displaying on 
the list and detail pages for all providers that are associated to that location, if it 

is not the provider’s primary location. 
 

Locations that are configured to be hidden can be overridden within the 
individual provider record’s configuration.   

  
If this configuration is enabled on a specific Provider record, that location will be 
excluded from displaying on the list and detail pages for that specific provider, if 

it is not the provider’s primary location. 
 

Any location that is flagged as a Primary Location cannot be hidden. 
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THE DATA TAB DROP-DOWN MENU 
The options that are available under the top Data tab drop down we displayed earlier, allow you to 
search, sort, add, edit or remove provider-related list data.  They are: 

• Providers List (Listed by: Last Name, First Name, Middle Name, Phone, Email, Direct List, Is 
Enabled, search by Name, Status (All, Enabled, Disabled) and Specialty.) 

• Provider Types (Listed by: Name (Doctor, Facility, Nurse Practitioner, Professor, Researcher), 
Is Enabled, ID, search by Status (All, Enabled, Disabled). 

• Board Certifications (Listed by: Name (AAPS, ABMX, ABPS, AMA, ADA, ADABS, Orthopedic 
Surgery), Is Enabled, ID, search by Status (All, Enabled, Disabled). 

• Clinical Interests (Listed by: Name (Adult reconstruction of the hip and knee, Arthritis of the 
hand, shoulder, and elbow, Arthroscopy of the wrist, elbow, and shoulder, Cardiology, etc.), Is 
Enabled, ID, search by Status (All, Enabled, Disabled). 

• Education Types (Listed by: Name (B. S. N - Bachelor of Science in Nursing, D. C. M. - Doctor 
of Chiropractic Medicine, etc.), Is Enabled, ID, search by Status (All, Enabled, Disabled.) 

• Genders (Listed by: Name (Female, Male, Unknown.), Is Enabled, ID, search by Status (All, 
Enabled, Disabled.) 

• Groups (Listed by: Name (Preferred, In Network, Out of Network or None), Is Enabled, ID, 
search by Status (All, Enabled, Disabled.) 

• Insurances (Listed by: Name, Is Enabled, ID, search by Status (All, Enabled, Disabled.) 
• Languages (Listed by: Name, Is Enabled, ID, search by Status (All, Enabled, Disabled.) 
• Specialties (Listed by: Name (Allergies, Immunology/Anesthesiology, etc.), Is Enabled, ID, 

search by Status (All, Enabled, Disabled.)  
 
Each Data page option contains a filter to assist with locating records by Status (All, Enabled, 
Disabled). 

  

Specialties provides filters 
for Specialty Name, Status 

and Category. 
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Note: 
Configurations in the screens of each of these data options appear as lists in a 

provider’s record. 

 

Genders Screen Example 
Click the Data menu from the top bar and select Genders to view or configure options for the Gender 
drop down list options in the New Provider and Edit Provider screens. 
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THE PROVIDER SETTINGS SCREEN 
The Provider Settings screen provides configuration options for Search Settings, Detail Settings 
and SEO Settings that are related to the Providers content app.   
 
Choose the Settings link from the Providers content app menu, or from the top Provider menu bar, as 
shown below. The Provider Settings management page displays. 

From here you can configure Provider Search Settings for the following: 
• Search Results Page URL (This is the URL of the Providers Search Results (list) page.) 
• Default Page Size (This is the number of results that will display on the Search Results page.) 
• Pager Position (Configure the placement of the pagination feature on the Search Results 

page. Available options are: Top and Bottom, Top, Bottom.) 
• ZIP Code Search Results Radius Options (Set the default ZIP Code search radius (in miles).) 
• Randomize Search Results (Check this checkbox to enable random search results to be 

returned.) 
• Sort by Provider Group (Check this checkbox to return search results sorted by provider 

group.) 
• Proximity Distances Based on Primary Location (Check this checkbox to display the 

distance to the various primary locations within the search results.) 
• Refresh Site Search Index (Click this button to refresh the site search index after adding, 

editing or deleting records.) 
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•  
• Configure Provider Detail Settings 
• Detail Page URL (This is the full URL to the provider’s public profile page.) 
• Direct URL Path (This is the relative 2path to the provider’s public profile page.) 

 
 

The majority of consumers use search engines to make purchase decisions; 
therefore, top digital marketing organizations prioritize the practice of Search 
Engine Optimization (SEO). The following page elements are essential to SEO 
success, because combined, they communicate the essence of your message. 

 
• SEO Settings 
• Tokens3 comprise the formulas that create each element. Consider them as objects. A list of 

available tokens is provided for each section. Copy and paste them in the fields in the order the 
chosen elements should appear, being mindful of syntax.  
You can also add static (non-dynamic) words around the tokens. The intent is to replace the 
contents of the token fields on the published page with data referenced from a list. 

• Configure Provider SEO Settings 
• Detail Page Formula (These tokens form the smart title that is displayed on the Provider detail 

page, for example: {ProviderName} - {PrimarySpecialty} - {PrimaryLocationCity}, 
{PrimaryLocationState} ({PrimaryLocationStateAbbrev}, or Dr. M. Welby, Internal Medicine, 
Birmingham, Alabama, AL)) 

• Search Results Page Keyword Formula (This formula comprises the keyword search on the 
Provider page, for example: Find {KeywordSearched}, etc.) 

• Search Results Page Name Formula (This formula comprises the search results page name 
for searches on provider name, for example: Find Providers {ProviderNameSearched} in 
{TargetCity}, {TargetState} ({TargetStateAbbrev}) - Page {PageNum} - {FacilityName}, etc.)) 

• Search Results Page Specialty Formula (This formula comprises the search results page title 
for searches on specialties, for example: Find {SpecialtySearched} Providers in {TargetCity}, 
{TargetState} ({TargetStateAbbrev}) - Page {PageNum} - {FacilityName}, etc.) 

• Search Results Page Base Formula (This is the standard formula for the page title on search 
results. 

  

                                                
2 A relative path defines the location of a directory in relation to another directory, only including the portion of the 

URL that describes the difference.  For example, if a local Word document is in 
C:\Sample\Documents\local.docx and the index is in C:\Sample\Index.html, the relative path from the Index.html 
would be \Documents\local.docx, whereas the absolute path would be C:\Sample\Documents\local.docx, or the 
entire path.   

3 A token, simply stated, is a symbolic representation of a larger piece of data. 



 
 
 

 

The contents of this document are confidential and proprietary to Healthgrades and are meant for private circulation only.  No part of this document may be 
disclosed, reproduced, transmitted or copied in any form or by any means without the express written permission of Healthgrades  

©2019 HEALTHGRADES.  All rights reserved. 

66 

Provider Name Settings 
Scroll further down in the screen, and below this area is Provider Name Settings. This allows you to 
determine how to display providers’ names in search results. You can determine how providers’ names 
display on detail and list pages while configuring those pages. Tokens that may be used for the custom 
display of Provider names are listed on the screen to guide you: 

• {Nameprefix} 
• {Firstname} 
• {Middlename} 
• {Lastname} 
• {Namesuffix} 
• {Additionalsuffix} 
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DYNAMIC COLUMNS - PROVIDERS 
The Dynamic Columns - Providers screen allows you to create and manage custom fields for the 
Providers screen. 
 

To Access Dynamic Columns 
Click the Dynamic Columns link in the top menu of the Content App. The Dynamic Columns - 
Providers screen displays.  Here, you can create, edit or remove dynamic columns (custom provider 
fields). 

For our example, we will look at a new field that has been created, Blog Posts. Here are the field's 
properties and selected values. The Type property for this field displays contentEditor. Other available 
data types are: Text, Number, Date and Dropdown. 
 

Name  Blog_Posts 

Label  Blog Posts 

Type  contentEditor 

Size  50 

Required  False 

Actions  Edit 

 
 
If you click the Edit pencil icon, as shown above, you can see these options and make non-permission-
restricted changes. 

Edit 

 

Create New 

Data Type 
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Data Type 
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TO CREATE A NEW CUSTOM FIELD 
Click the Cancel button, as shown above, to return to the Dynamic Columns - Providers screen, or 
click the Dynamic Columns tab at the top left. From the Dynamic Columns - Providers screen, click 
the Create New button in the screen's lower right.  The New Dynamic Column screen displays. 
 

 
 
 

• Field Name (This will be the name of your custom field in the data base. For our example, this 
is Blog_Posts.) 

• Field Label (This is the display name of the custom field. For our example, this is Blog Posts.) 
• Is Required (Check this box to make this a required field. For our example, we left this property 

unchecked; therefore, completing the resulting custom field will not be required for the user.) 
• Data Type (These are the data type selections that define what type of field you are creating, 

whether Text, Number, Date, Dropdown or Content Editor. Additional options display below, 
depending on the data type selection.) 
 

  

Data Type 

Additional 
Contextual 

Configuration 
Fields 



 
 
 

 

The contents of this document are confidential and proprietary to Healthgrades and are meant for private circulation only.  No part of this document may be 
disclosed, reproduced, transmitted or copied in any form or by any means without the express written permission of Healthgrades  

©2019 HEALTHGRADES.  All rights reserved. 

70 

Additional Contextual Configuration Fields 
• Max Length (Enter the maximum number of characters allowed in this custom field. This does 

not apply to the Content Editor data type, so once the selection of Content Editor is made, there 
are no additional options displayed below. Max Length applies to the Text data type only.) 

• Is Multiline (This data type property selection applies to the Text data type only. Check this box 
to allow more than one line of text in the resulting textfield, where applicable. Multiline text 
supports word wrapping, vertical and horizontal scrolling.) 

• Dropdown Options (A selection of Dropdown as the Data Type renders this additional 
contextual configuration field. This field allows free text entry.) 

  



 
 
 

 

The contents of this document are confidential and proprietary to Healthgrades and are meant for private circulation only.  No part of this document may be 
disclosed, reproduced, transmitted or copied in any form or by any means without the express written permission of Healthgrades  

©2019 HEALTHGRADES.  All rights reserved. 

71 

Once you have made your selections and entered any needed information for your custom field, click 
Save and Continue. 
 
If you have used spaces in the first field, Field Name, you will see an error message restricting you 
from saving your custom field. Remember, this will be the name of your custom field in the data base, 
which in our example, is Blog_Posts.  Replace any spaces with an underbar to meet this requirement. 

If all information has been entered according to the restrictions for each of these fields, a confirmation 
message displays. 
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HOW TO REMOVE A FIELD 
Below, we have added an additional test field, in order to demonstrate how to remove one. Return to 
the Dynamic Columns – Providers screen and click the checkbox at the beginning of the row, or 
record you wish to delete, as shown below.  

 
Then, at the bottom right of this page, click the Remove button. 

 
A confirmation message displays. Click OK. 

Your custom field has successfully been created. 
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THE BLOG POSTS FIELD 
In the Data > Providers List > Edit Provider Information screen, is a custom Blog Posts WYSIWYG 
field we created, with the Content Editor data type.  
 
The field is available in the New Provider screen, from which you can create new provider records, and 
upload or browse existing provider records. 

 
 
 
 

 

 

 

 

  

Show > 
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PROVIDER RATINGS 
CMS recently introduced Provider Ratings, a feature which allows visitors/patient prospects to 
research and compare hospital providers, based on patient feedback. 
 
Provider Ratings and Reviews are now an available layout configuration option for Provider Detail 
and List page layouts, including the Compare List view and Refinement panel on the Provider List 
page. 
 
Rating Comments, Rating Details, and Ratings Image fields have also been added to the Provider 
Detail Available Fields.  
 

How to Configure Provider Ratings for Your Page 
Navigate to your Site Root/_Widgets folder and your Providers Profile page and double click the 
directory name to load it.  Our example uses the following path: 
.. /Reference Sites/Sample/Site Root/_Widgets/Peachtree Widgets/Peachtree 
Providers/Providers Profile. 
 
Our sample screen displays, with the new Ratings and Comments tab visible, mid screen.  Click the 
Form view to edit.   
 

 
From the form that loads, Click the Web View button to preview and configure this Content App 
instance.  When the Configure button displays, click it to configure the page. 

Ratings and 
Comments 
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When the next screen displays, drag Raw Text with Tokens4 from Available Fields to the desired 
Column on the right of the screen as shown below, then click the Edit (pencil) icon to access and apply 
the tokens, {ProviderRatingsCount} and {ProviderCommentsCount}.   
 

 

Rating Comments, Rating Details, and Ratings Image fields have also been 
added to the Provider Detail Available Fields. 

                                                
4 The Raw Text editor is an advanced feature intended for use by engineers who are aware of the risks of 

injecting code into pages. The CMS system does not validate code placed into this control.  Healthgrades is not 
responsible for validating or debugging client code, or for triaging or correcting problems caused by client code.  
By using this control, you agree that Healthgrades is held harmless for any negative effect to your website 
caused by code placement within this control. 
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Expand the Tokens tab.  Copy and paste these two token names (with their brackets) into the Raw 
Text area below, providing the desired labels where desired, using plain text. 
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The full list of  tokens that are available from this modal are:   
{

• AcceptingNewPatients} 

• {Age} 

• {DateOfBirth} 

• {dynamicCol_Blog_Posts} 

• {dynamicCol_clinicalTrials} 

• {dynamicCol_conditions} 

• {dynamicCol_educationCe
rtifications} 

• {dynamicCol_EpicProviderI
D} 

• {dynamicCol_EpicVisitType
s} 

• {dynamicCol_featured} 

• {dynamicCol_patientStories
} 

• {dynamicCol_procedures} 

• {dynamicCol_socialMediaB
logURL} 

• {ProviderRatingsCount} 

• {dynamicCol_socialMediaF
acebookHandle} 

• {dynamicCol_socialMediaLi
nkedInHandle} 

• {dynamicCol_socialMedia
NewsURL} 

• {dynamicCol_socialMediaT
witterHandle} 

• {dynamicCol_socialMediaY
elpHandle} 

• {dynamicCol_socialMediaY
ouTubeHandle} 

• {Experience} 

• {Gender} 

• {InPracticeSince} 

• {NPI} 

• {PrimaryEmail} 

• {PrimaryFax} 

• {PrimaryLocationComplete
Address} 

• {PrimaryLocationName} 

• {PrimaryPhone} 

• {PrimarySpecialty} 

• {ProviderCommentsCount} 

• {ProviderDirectUrl} 

• {ProviderExternalId} 

• {ProviderGroup} 

• {ProviderId} 

• {ProviderImageUrl} 

• {ProviderName.AdditionalS
uffix} 

• {ProviderName.FirstName} 

• {ProviderName.LastName} 

• {ProviderName.MiddleNam
e} 

• {ProviderName.NamePrefix} 

• {ProviderName.NameSuffix} 
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Another published page sample Is provided below. 
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THE LOCATIONS CONTENT APP 
The Locations content app allows consumers to search for locations that associated with the health 
care organization.  Here, services and associated content can be customized based on the health care 
organization’s preferences. 
 
HOW TO ACCESS THE LOCATIONS CONTENT APP 
To access Content App components from anywhere within CMS, click the Content Apps option from 
within the Apps left menu, as shown in the screen image below.  
 
The Content Apps console displays.  From the Content Apps console, you can manage Providers, 
Events, Locations, Services and other configuration items.  Each content app has its own menu of 
management items. 
 
Click the Locations widget, as shown below, or the specific Locations List link from the Locations 
menu 
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The Locations List Page 
Access the Locations list page displays.  The Locations page provides functionality for you to search 
and filter, with options to Apply (run) or to Clear Filter and to edit or remove existing location records, 
as well as create new records. 
 
From the Location page, you can perform the following actions: 

• Search for a location record by Name, Keyword and Status (All, Enabled, Disabled). 
• Create New location records. 
• Edit location records. 
• Remove location records. 

 

 

 
  

Remove or 
Create New 

Edit 
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HOW TO CREATE A NEW LOCATION 
Click the Create New button, as shown above, from the lower right of the screen.  The New Location 
screen displays, as shown below.  Following, are the fields in the screen that you will use to create a 
new Location record.  

• External ID (This is the system-generated record identification number that is used by the 
system for data association purposes.) 

• Enabled (This checkbox, if enabled, displays the location record.) 
• Name (Enter the name of the location.) 
• Address 1 (Enter address line 1 of location, for example: 3000 Riverchase Galleria Parkway.) 
• Address 2 (Enter address line 2 of location, for example: Suite 203.) 
• City (Enter the city of the location.) 
• State (Enter the state of the location.) 
• Postal Code (Enter the ZIP code of the location.) 
• Country (Enter the country of the location.) 
• Custom Coordinates (Click this checkbox to enable the custom coordinates that you will enter 

below.) 
• Latitude (Enter the latitude of the location.  Latitude is the angular distance of a place north or 

south of the earth's equator, usually expressed in degrees, for example: 51° N.  To find the 
latitude and longitude of a location, use a latitude and longitude finder such as Google Maps.) 

• Longitude (Enter the longitude of the location.  Longitude is the angular distance of a place 
west or east of the earth's equator, usually expressed in degrees, for example: 20° E.  

• Cost Center (This is a free-entry text field.) 
• Phone (Enter this information in contiguous numbers.  The field auto-formats as a dash-

delineated phone number, for example: 800-555-5555.) 
• Fax (Enter this information in contiguous numbers.  The field auto-formats as a dash-delineated 

phone number, for example: 800-555-5555.) 
• Email (This is a free-entry text field.) 
• Service Line URL (Enter the appropriate URL in this field.) 
• Potential Event Location (Check this box if the location may be used as a potential event 

location.  If left unchecked, then the location will not display as a location option when creating 
an event.) 

• Description (Click the Show button to enable this field.  When enabled, this field expands to 
reveal a WYSIWYG editor, so that you can create a rich-text formatted description of the 
location.) 

• Custom Keywords (These are keywords that will be associated with the location.) 
• Generated Keywords (These are system-generated keywords that are related to the location 

(non-editable).) 
• Custom Field 1-3 (Click the Show button to reveal a WYSIWYG editor, so that you can create 

custom fields with rich-text formatting.) 
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The majority of consumers use search engines to make purchase decisions; 
therefore, top digital marketing organizations prioritize the practice of Search 
Engine Optimization (SEO). The following page elements are essential to SEO 
success, because combined, they communicate the essence of your message. 

 
• SEO Page Title (This is found in the <head> element.  Title tags are often used on search 

engine results pages (SERPs) to display preview snippets for a given page, and are important 
both for SEO and social sharing.  

• The title element of a web page should be a concise description of a page's content.  Users see 
the title in two places: as the page's name in the browser tab and in search results.) 

• SEO Page Description (Also found in the <head> element, this describes what a page is about 
in 150 characters or less.  In search results, this returns as the main descriptive text.) 

• SEO Custom Metatags (Use custom meta tags to provide search engines with additional 
information about your pages.  Search engines use this information to create rich snippets or 
enable sorting of search results.) 

• SEO H1 Tag (This Heading 1 tag element is used near the top of the page as the page version 
of the page title, or to describe the page's content.) 

• SEO Primary Keyword (The primary keyword is the one searched most frequently.) 
• SEO Secondary Keyword (The secondary keyword is the one searched the second-most 

frequently.) 
• SEO Canonical URL (The SEO Canonical URL tag attribute bears similarity to a 301 redirect, 

but it communicates to search engines that multiple pages should be considered as one, without 
redirecting visitors to the new URL, so that you can still track visitors separately to unique URL 
versions such as Payment Gateway (PayFlow Pro, Authorize.net).) 
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The New Location Screen 
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WORKING WITH LOCATION TYPES 
The Location Types screen allows you to add, edit and remove location types.  This page also 
contains a filter to assist with locating location types by Status (All, Enabled, Disabled), with options to 
Apply (run) or to Clear Filter and by locations outside of the organization (Show Outside of 
Organization: Yes, No). 
 

To Access Location Types 
To access this page, choose the Location Types link from the Locations content app menu, we 
described earlier, or from the top Data tab dropdown option).   
 
The Location Types management page displays, with functionality as described earlier: Search, Edit, 
Remove and Create New.  Click the checkbox at the beginning of a row, or record, to act on it.  Fields 
may be sorted using the options in their drop downs, as shown below.  The fields are: 

• Name (This column displays the location type name, such as: Department, Emergency Room, 
Hospital, Printable Provider Directory, etc.) 

• Enabled (Displayed values are True or False.) 
• Outside of Organization (Displayed values are True or False.) 
• ID (This is the system-generated number that is associated with the location type record.) 
• Actions (Click the pencil icon beside a record to view and edit its properties.) 

 

Note: 
Location Types can also be added directly from a location record. 

  

Remove or 
Create New 

Edit 
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WORKING WITH INSURANCES 
The Insurances screen allows you to add, edit and remove the insurances that are associated with 
your locations.  This page contains a filter to assist with locating insurances by Status (All, Enabled, 
Disabled), with options to Apply (run) or to Clear Filter. 
 

To Access Insurances 
To access this page, choose the Insurances link from the Locations content app menu, as we 
described earlier, or from the Data tab dropdown option.  The Insurances management page displays.  
The fields are: 

• Name (This is the name of the insurance.) 
• Is Enabled (Displayed values are True or False.) 
• ID (This number is associated with the location type record.  It is system-generated.) 
• Actions (Click the pencil icon beside a record to view and edit its properties.) 

 
Note: 

Insurances can also be added directly from a location record. 

  

Remove or 
Create New 

Edit 
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Services 
The Services option allows you to add, edit and remove the services that are associated with your 
locations.  This page contains a filter to assist with locating services by Name and by Status (All, 
Enabled, Disabled). 
 
To access this page, choose the Services link from the Locations content app menu (or from the Data 
tab dropdown).  The Services management page displays.  

 
 
 

 

Note; 
Services can also be added directly from a location record. 
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SETTINGS 
The Services Settings page, available from the Settings tab, provides configuration options which are 
related to the Locations content app: Search Settings, Detail Settings and SEO Settings.  

To Access Location Settings 
Choose the Settings link from the Locations content app menu, as we described previously, or from 
the Settings tab.  The Settings management page displays. 

From here you can configure the following. 

 
Search Settings: 

• Search Results Page URL (Enter the URL of the Locations search results (list) page.) 
• Default Page Size (Enter the number of results that will display on the Search Results page.) 
• Pager Position (Configure the placement of the pagination feature on the Search Results 

page.  Available options are: Top and Bottom, Top, Bottom.) 
• ZIP Code Search Results Radius Options (Set the default ZIP Code search radius (in miles).) 
• Refresh Site Search Index (Click this button to refresh the site search after adding, editing or 

deleting records.) 

Detail Settings 

Refresh Site 
Search Index 

button 
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• Detail Page URL (This is the full URL to the Locations public profile page.) 

SEO Settings 
• Detail Page Formula (These tokens5 in this formula comprise the smart title that is displayed 

on the Locations detail page.) 
• Search Results Page Keyword Formula (This formula comprises the Keyword search on the 

Locations page: Find {KeywordSearched}, etc.) 
• Search Results Page ZIP Code Formula (These tokens comprise the Locations ZIP search.  

As an example, in the field displayed, below we see: Find Locations Near {ZipCodeSearched} - 
Page {PageNum} - {FacilityName}, {FacilityCity}, {FacilityState} ({FacilityStateAbbrev} 
 
This means: Find Search Type near ZIP Code – Page Number – Facility Name, Facility City, 
State (ST), for example: Find Emergency Department near 43257 – Page 2 – Healthgrades, 
Birmingham, Alabama (AL).) 

• Search Results Page Base Formula 

 
• Lead Management Settings 

                                                
5 A token, simply stated, is a symbolic representation of a larger piece of data. 
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• Lead Submission Settings 
• Base URL (This is the Lead Submission Settings base URL, or base location.  Once 

specified, converts all relative URLs on that page to absolute URLs.) 
• Client ID (Tier 2) (This is a free-entry text field.) 
• Default Business Unit IDs (Tier 3) 
• Event Registrations (This is a free-entry text field.) 

• Provider Appointment Requests (This is a free-entry text field.) 

Mapping Settings 
• Mapping Provider (Select your Locations map provider, for example: Google or Bing, from the 

provided drop down list.) 
• Bing Maps Key (This is the key authentication code that you get when you register for Bing 

maps.) 
• Google Maps Key (This is the key authentication code that you get when you register for 

Google maps.) 
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CMS Integration Settings 
• CMS Type (Make the CMS Type selection from this drop-down field.) 
• Publish Site Root (Live) (Enter the Live Site Root URL.) 
• Allow Non-SSL6 Sites 
• Host URL (Enter the Host URL.) 
• Instance Name (Enter the instance name for your site.) 
• User Name (Enter a username.) 
• Password (Enter a password.) 
• API Key (Enter the application programming interface (API) key.) 

Image Library Settings 
• CMS Path (Enter the path to your CMS, for example: /Your Site/Site Root/Assets/Images.) 
• Publish Server Path (Enter the path for your publish server, for example: /Assets/Images.) 
• Workflow ID (This is a free-entry text field.) 

 

Site Search Settings 
• Search G2 Instance Name (Search G2 is based on industry standard crawling, indexing and 

querying components, maintained by Apache.  Enter the instance name for your site.) 
• User Name (Enter a username.) 
• Password (Enter a password.) 
• API Key (Enter the application programming interface (API) key.) 

 
DYNAMIC COLUMNS - LOCATIONS 
                                                
6 Secure Sockets Layer (SSL) standard security technology encrypts Hypertext Transfer Protocol (HTTP) for 

secure communication over a computer network, resulting in a secure Hyper Text Transfer Protocol Secure 
(HTTPS) version, which is used to protect highly confidential online transactions like online banking and online 
shopping order forms.  To be able to create an SSL connection a web server requires an SSL Certificate. 

 

https://en.wikipedia.org/wiki/Hypertext_Transfer_Protocol
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The Dynamic Columns - Locations screen allows you to create and manage custom fields for the 
Locations screen. 
 

To Access Dynamic Columns 
Click the Dynamic Columns tab.  The Dynamic Columns - Locations screen displays.  Here, you 
can create, edit or remove dynamic columns (custom location fields). 
 

 
 
 
 
 
 
 
 
 
  

Create New 
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TO CREATE A NEW DYNAMIC COLUMN 
From the Dynamic Columns - Locations screen, click the Create New button in the lower right of the 
screen.  The New Dynamic Column screen displays.  The dynamic column we create here will create 
a field of the type we select.  

 

Create Your Custom Field Using These Options: 
• Field Name (This will be the name of your custom field in the data base.) 
• Field Label (This is the display name of the custom field.) 
• Is Required (Check this box to make this a required field.  If this property is left unchecked, 

completing the resulting custom field will not be required for the user.) 
• Data Type (These are the data type selections that define what type of field you are creating, 

whether Text, Number, Date, Dropdown or Content Editor.  Additional options display below this 
field, depending on the data type selection.) 

Additional Contextual Configuration Fields 
• Max Length (Enter the maximum number of characters allowed in this custom field.  This does 

not apply to the Content Editor data type.  Max Length applies to the Text data type only.) Once 
a data type of Content Editor is made for example, there are no additional options displayed. 

Data Type 

Additional 
Contextual 

Configuration 
Fields 
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• Is Multiline (This data type property selection applies to the Text data type only.  Check this 
box to allow more than one line of text in the resulting text field, where applicable.  Multiline text 
supports word wrapping, vertical and horizontal scrolling.) 

• Dropdown Options (A selection of Dropdown as the Data Type renders this additional 
contextual configuration field.  This field allows free text entry.) 

 

Once you have made your selections and entered any needed information for your custom field, click 
Save and Continue. 
 
If you have used spaces in the first field, Field Name, you will see an error message restricting you 
from saving your custom field.  Remember, this will be the name of your custom field in the data base.  

Replace any spaces with an underbar to meet this requirement. 

If all information has been entered according to the restrictions for each of these fields, a confirmation 
message displays. 
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THE LOCATION DESCRIPTION FIELD 
Here again, in the Data > Locations List > Edit Location Information screen, is a custom Location 
Description WYSIWYG field we created, with a Content Editor data type, in use.  
 
The field is also available in the New Location screen. 
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HOW TO REMOVE A FIELD 
Above, we added an additional test field, in order to demonstrate how to remove one.  Return to the 
Dynamic Columns – Locations screen and click the checkbox at the beginning of the row, or record 
you wish to delete, as shown below.  

 
Then, at the bottom right of this page, click the Remove button. 

 
A confirmation message displays.  Click OK.  
 

Your custom field has successfully been created. 

 
 
 
 

 
 
How to Add Insurances and Services to the Locations Search, List and Detail Widgets 
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Previously, the Locations Widget was searchable by Keyword, Location Type and ZIP Code (with 
Radius).  Services and Insurances have been added as drag-and-drop fields in the Locations 
Search, List and Detail Widget layouts. 
 
To access the widget, go to your relative path using our sample path as a reference.  For this 
demonstration, we used: ../Reference Sites/Sample/Site Root/_Widgets/.  Expand Widgets, then select 
Locations and a sample widget: Location Results Test Content App Widget.   
 
Double-click your Content App Widget.  Your widget opens in Preview mode.  The preview page has 
a message button: Content App Instance not configured.  Click this button to enable the Configure 
button, then click Configure to open the page.  The first thing you will see is a drop-down list to Select a 
Content App.  We selected Locations.  With each selection, additional fields enable, to guide you 
through the process.  We selected Detail View from View and Accordion from Layout. 
 
As depicted in the image below, drag the new Insurances and/or Services fields from Available 
Fields to either the Header or Accordion Zone field area.  Notice the hover-text information icon (Ⓘ) 
on these fields.  Services says: this is a complex field, which requires additional configuration prior to 
display.  Click the Preview Tab in the current screen to view your results. 
 

Remember, you can use Edit > Copy path to share,as well as Flag areas for quick 
access.  You can also create a new widget here, from File > New > Model > 

Widget > Content App Widget. 

 
 

  

 



 
 
 

 

The contents of this document are confidential and proprietary to Healthgrades and are meant for private circulation only.  No part of this document may be 
disclosed, reproduced, transmitted or copied in any form or by any means without the express written permission of Healthgrades  

©2019 HEALTHGRADES.  All rights reserved. 

98 

UPDATED LOCATIONS LIST AND DETAIL WIDGET OPTIONS 
Insurances, Services and Location Type are now available as selections in the When Field drop-down 
field, under the Conditional Settings section of the Raw Text with Tokens Configuration field edit 
screen, as well as within that of the standard Conditional field edit screen, in both the Locations 
List and Detail Widgets.   
 
Insurances, Services and Location Type are also available as Default Query options in the Locations 
List and Detail Widgets. 
 
Access to these screens are similar. 
 

How to Access the Location Results Widget 
To access this area, from the Content left panel icon, using a similar path to this one: Your Site/Site 
Root/_Widgets/Locations/, access the Location Results widget (also referred to as List Widget, or 
Search Results Widget).  Double-click to open Location Results.  Providers, Locations and Events 
each have a List Widget. 
 

 
  

Content 
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This is the Preview of a sample page.  Hover over the top-left corner of the page.  Click the Configure 
button that displays. 
 

Here, you can create or revise your layout, with fields you want displayed.  Notice the top section in the 
screen below, with drop-down selections:  Content App = Locations, View = List View, Layout = 
Search Results. Just below this section, click the Settings tab. 
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The Settings tab screen that opens has four sections, with fields in each section.  Here, is where you 
can configure your Default Query.  Each selection is restricted by the one above it. 

• Basic Settings 
• Detail Page URL (Enter the detail page link users will be redirected to if there are search 

results.) 
• Blank Search Results Page URL (Enter the page link users will be redirected to if there are no 

search results.) 

Default Query 
• Locations Per Page (Enter a number of locations to display per page, if desired.) 
• Location Type (Configurable drop-down options. See Working with Location Types.  Sample 

selections shown further below are: Departments, Locations, PrintableProviderDirectory, 
Provider Office, Regions, Services and Site.) 

• ZIP Code (Enter a ZIP code to narrow your Location Type selection to a specified 
geographical area.) 

• Search Within 
• Insurance (Refine your search to the configured health insurance drop-down options.) 
• Service (Refine your search to the configured health insurance drop-down options.  Sample 

selections may include provided services such as: MRI, Surgery or Imaging.) 
• Content Settings (Note the screen reference: These settings are ignored if location settings are 

present in the page's query string.) 
• Limit Results to Location (Make a selection here if you wish to restrict the display to a specific 

location.) 
• Include Child Locations 

  

Default 
Query 
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Search Settings 
There is a new field in the Default Query section, called Location Type.  A typical scenario may be 
placing this widget on your home page with a selected location type of Provider Office, to display its 
query results.   
You can continue to refine your default query using the fields in this section.  Restrict your selected 

Location Type of Provider Office to an entered ZIP Code, for example, or select only Provider Office 
Location Types that accept a selected Insurance. 
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Click the Preview tab to see what the selected data for your Default Query may look like on our 
sample published page.  
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You can control what elements display on your page in the Layout tab.  Below, we are dragging the 
Location Types field off the Header Zone, back onto the Available Fields panel. 
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Now, let’s preview the page again.  Location Types is gone (from view), but not forgotten (in your 
Default Query)! 

 
Default Query enables you to pull and display a list of data on your page when it loads. 
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HOW TO USE THE CONDITIONAL FIELD 
To demonstrate another recent feature enhancement, we dragged the Conditional field into our 
Layout and clicked the field to open it.  The When Field drop-down options now include Location Type, 
Insurances and Services.   

 
 
  

Conditional 
field 
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The Conditional dialog modifies the display of data based on conditional selections you make here, for 
example, the entries in the example below, create a condition of When Field Location Types = 
Hospital.  If Show Custom Value is selected, the text or image you add in the WYSIWYG Editor will 
display if the condition is True. 
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Similarly, dragging the Raw Text with Tokens field from here, then clicking the field opens the Raw 
Text with Tokens dialog, where you can set conditions. 

The When Field drop-down options here also include Location Type, Insurances and Services.   
Similarly, List Details may be modified using this same set of functionality.  Access List Details 
(named Location Details here) from Site Root/_Widgets/Locations/ and repeat the steps above.   
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Here, from the preview page, hover at its top left and click Configure.  Expand Location Details, drag 
and open the Conditional field. 

Raw Text 
with Tokens 
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THE SERVICES CONTENT APP 
The Services content app allows consumers to search for services that are associated with the health 
care organization. Here, services and associated content can be customized based on the health care 
organization’s preferences. 
 

To Access the Services Content App 
To access Content App components from anywhere within CMS, click the Content Apps option from 
within the Apps left menu, as shown in the screen image below.  

  



 
 
 

 

The contents of this document are confidential and proprietary to Healthgrades and are meant for private circulation only.  No part of this document may be 
disclosed, reproduced, transmitted or copied in any form or by any means without the express written permission of Healthgrades  

©2019 HEALTHGRADES.  All rights reserved. 

110 

 
The Content Apps console displays. From the Content Apps console, you can manage Providers, 
Events, Locations, Services and other configuration items.  Each content app has its own menu of 
management items. 
 
Click the Services widget, identified in red below, or the specific Service List link from the Services 
menu. 
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The Services Page 
The Services list page displays. The Services page provides functionality for you to search (filter), edit 
or remove existing Service records, as well as to create new records. 
 
From the Services page, you can perform the following actions: 

• Search for a service record by Name and Status (All, Enabled, Disabled). 
• Create New service records. 
• Edit service records. 
• Remove service records. 

 
 
 

 
 
  

Edit 

 

Settings 
 

Remove or 
Create New 
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To Create a New Service 
Click the Create New button, as shown above. The New Service screen displays, as shown below, on 
the following page of this document. Directly below, are descriptions of the fields in the screen that are 
used to create a new Service record.  

• ID (This is the record identification number that is used by the system for data association 
purposes.) 

• Name (This is the name of the service.) 
• Enabled (This checkbox, if enabled, displays the service record.) 
• Description (This field has a WYSIWYG editor, used for a rich text description of the service.) 
• Custom Keywords (These are the custom keywords associated with the service.) 
• Generated Keywords (These are system-generated keywords that are related to the service 

(non-editable).) 
 

The majority of consumers use search engines to make purchase decisions; 
therefore, top digital marketing organizations prioritize the practice of Search 
Engine Optimization (SEO). The following page elements are essential to SEO 
success, because combined, they communicate the essence of your message. 

 
• SEO Page Title (This is in the <head> element. Title tags are often used on search engine 

results pages (SERPs) to display preview snippets for a given page, and are important both for 
SEO and social sharing.  
 
The title element of a web page is a concise description of a page's content. Users can view the 
title in two places: as the page's name in the browser tab and in search results.) 

• SEO Page Description (Also found in the <head> element, the SEO Page Description 
describes what a page is about in 150 characters or less. In search results, this returns as the 
main descriptive text.) 

• SEO Custom MetaTags (Use custom meta tags to provide search engines with additional 
information about your pages that they use to create rich snippets or enable sorting of search 
results.) 

• SEO H1 Tag (This Heading 1 tag element is used near the top of the page as the page version 
of the page title, or to describe the page's content.) 

• SEO Primary Keyword (The primary keyword is the one searched most frequently.) 
• SEO Secondary Keyword (The secondary keyword is the one searched the second-most 

frequently.) 
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• SEO Canonical URL (The SEO Canonical URL tag attribute bears similarity to a 301 redirect, 
but it communicates to search engines that multiple pages should be considered as one, without 
actually redirecting visitors to the new URL, so that you can still track visitors separately to 
unique URL versions, such as: Payment Gateway (PayFlow Pro, Authorize.net). The term, 
canonical, refers to conforming to an accepted rule or procedure.) 

 
 

Required fields display an asterisk. 

 
 
 

 
  

Show/Hide 

The WYSIWYG editor allows the addition 
of rich text, text formatting, text 

alignment, links, images, video and 
HTML, while you edit in human-readable 

format. 
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Services Settings 
The Services Settings page, available from the Settings tab, provides configuration options which are 
related to the Services content app: Search Settings, Detail Settings and SEO Settings. 

Services Settings Field Descriptions 

From the Search Settings section, displayed above, complete the following fields: 
• Search Results Page URL (Enter the URL of the Services search results page.) 
• Default page Size (Enter the number of results records to display on the page.) 
• Pager Position (Choose the page placement (Top and Bottom, Top or Bottom) of the 

pagination widget.) 
  

 

Settings 
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• Refresh Site Search Index (Click this button to refresh, or rerun the site search index. A 
message displays indicating that the site search index is being updated in the background and 
that changes should be visible in a few minutes.) 
 

From the Detail Settings section, displayed in the Services Settings image above, options are: 
• Detail Page URL (Enter the full URL of the Services public page.) 
•  
•  
The majority of consumers use search engines to make purchase decisions; 

therefore, top digital marketing organizations prioritize the practice of Search 
Engine Optimization (SEO). The following page elements are essential to SEO 
success, because combined, they communicate the essence of your message. 

SEO Settings  
• Tokens7 comprise the formulas that create each element. Consider them as objects. A list of 

available tokens is provided for each section. Copy and paste them in the fields in the order the 
chosen elements should appear, being mindful of syntax.  
 
You can also add static (non-dynamic) words around the tokens. The intent is to replace the 
contents of the token fields on the published page with data referenced from a list.  
 
From the SEO Settings section, options are: 

• Detail Page Formula (Add or remove, or change the order of these tokens to form the 
Services Detail Page.) 
• {TargetCity} 
• {TargetState} 
• {TargetStateAbbrev} 
• {FacilityName} 
• {FacilityCity} 
• {FacilityState} 
• {FacilityStateAbbrev} 

                                                
7   A token, simply stated, is a symbolic representation of a larger piece of data. 
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• {ServiceName} 
• Search Results Page Keyword Formula (This formula comprises the keyword search on the 

Services page, for example: Find {KeywordSearched}.)  
• Search Results Page Name Formula (This formula comprises the Search Results page 

Service Name, for example: Find Services Near {ZipCodeSearched} - Page {PageNum}, etc.)  
• Search Results Page Base Formula (This is a standard formula for the page title on search 

results, for example: Find Services in {TargetCity}, {TargetState} ({TargetStateAbbrev}) - Page 
{PageNum} - {FacilityName}, {FacilityCity}, {FacilityState} ({FacilityStateAbbrev}.) 
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CONTENT APPS - API INTEGRATION – EVENTS, OVERVIEW 
This document provides API Integration information for the Events Content App within CMS. 
 
Note: 
 This document is intended for users who are skilled in consuming Web services 
and have access to an applicable software application that allows this capability. 

The API is RESTful and all requests are made up of properly-formatted HTTP requests.  Appropriate 
URLs are defined in each corresponding section of this guide for each Content App. 

Request Method and Content-Type 
All requests use the HTTP POST method. 
Content-Type:  For all requests where data is being sent to the system in the request body, the content-
type of the request can either be text/xml or application/xml. 

Common Response Codes 
The most common response codes are explained in the table below: 

HTTP Response 
Code 

Description 

200 - OK The operation was successful. 
400 - Bad Request Client error. The information passed to the service method 

did not match what the server expected. This could be 
caused by XML passed to the method that did not match the 
schema for the method. 

403 - Forbidden Unauthorized.  The credentials passed to the service method 
were incorrect or the account specified did not have the 
permissions to perform the action that was requested. 

500 - Internal Server 
Error 

Server error.  The information passed to the service method 
matched what was expected syntactically, but the server was 
unable to process the request. This could be due to an 
invalid identifier passed within the XML to the method, an 
invalid value passed within the XML to the method, or the 
information specified an action that violated business rules 
for the method. 
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Working with XML in Request/Response Bodies 
All data sent to the server and returned from the server will be sent as XML. This section describes 
several things to keep in mind while working with the request/response XML. 

Request/Response NULL Fields 
Fields in the request/response XML can be set to Null in 2 ways: 

• The field has been identified as Null by its “nil” attribute – When a field contains the 
attribute i:nil="true", then its value will be Null. In the example below, MiddleName has been 
defined as a null field while PictureId is an empty node.  In any response from the server, all 
null fields will be represented in this way. 

 
<OrgUnitId>501</OrgUnitId>  

<MiddleName i:nil="true"/>  

<PictureId/>  

 
 

See the Namespaces section below, for the namespace needed when using this 
notation. 

 
• The field has been omitted from the request – When a field is not present in the request, then 

that field value will be Null.  The example below will be seen by the server exactly the same as 
method 1 above: 

•  
<OrgUnitId>501</OrgUnitId>  

<PictureId/>  

 

Namespaces 
In most cases, no XML Namespace is required when sending data to the server. The one exception is 
when using the i:nil=”true” notation to represent null fields. In this case the following namespace 
should be included in the root node of the request. 
 
xmlns:i=http://www.w3.org/2001/XMLSchema-instance 
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Null Fields vs. Empty Nodes When Updating Data 
In order to simplify the process of updating data through the API, null fields and empty nodes are treated 
differently. It is important to realize these differences and understand how the server will treat these 
fields in a request. 
 

See Request/Response Null Fields to see how null fields and empty nodes are 
defined differently. 

• Null Fields – When a null field is sent to the server during an “Update” request, the server 
ignores this field. 

• Empty Nodes – When an empty node is sent to the server, the server removes or deletes that 
value. 

 
In the example below, OrgUnitId will be updated to the value 501, MiddleName will be ignored (i.e. it’s 
previously existing value will not be altered), and PictureId will be deleted from the entity. 
 
<OrgUnitId>501</OrgUnitId>  

<MiddleName i:nil="true"/>  

<PictureId/>  
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AUTHENTICATION 
CMS now requires token-based authentication to utilize the API.  Authentication is achieved by passing 
an Authorization Header Value, using the Authenticate method and retrieving the token that will be 
used in all subsequent API methods within a given time frame. 
 
Several steps are involved in creating the Authorization Header Value. 

• Work with Healthgradesth to receive an API user and password. 
• Format a string in the following format: 
• <Content Apps User>:<Content Apps Password> (example: APIUser:MyP@ssWord) 
• Convert the string to binary. 
• Base64 encode the string. 
• Prepend the Base64 string with the text: "Basic ". 
•  

Example authentication code:  Basic ZnVsY3J1bWFkncbOkVBMV9xYWI= 
 

To authenticate, create a request with the following URL (where Instance Name is the name of your 
instance) with a POST request type: 
https://contentapps.influencehealth.com/<instance name>/api/public/v1/authenticate/ 
 
Pass a header in the following format: 
Authorization:<Authorization Header Value> 

 
Example Header: 
Authorization:Basic ZnVsY3J1bWFkncbOkVBMV9xYWI= 

 
The response will include a token in JSON format that you will use to access the API for all subsequent 
methods. 
 
{ 

"Token" : "221b2aad-ad56-4cd6-934d-233eb4970faf" 

} 
 
For each API request, include the token as a header in the following format: 
AuthorizationToken:<token> 

 
Example Header: 
AuthorizationToken:221b2aad-ad56-4cd6-934d-233eb4970faf 

 
EVENTS 

Endpoint URL 
For all Events API requests, the service endpoint URL is shown below: 
http[s]://<host url>/_vti_bin/MEDSEEK/EventServiceV2.svc 
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Request 
Request URL: 
<endpoint URL>/events  
 

Request Body: None 
 

Paging (Optional) 
We’ve now added Paging functionality in this request.  Paging can be achieved by appending the page 
and pageSize parameters to the query string: 
<endpoint URL>/events?page=3&pageSize=10  

  



 
 
 

 

The contents of this document are confidential and proprietary to Healthgrades and are meant for private circulation only.  No part of this document may be 
disclosed, reproduced, transmitted or copied in any form or by any means without the express written permission of Healthgrades  

©2019 HEALTHGRADES.  All rights reserved. 

122 

Response 
The response XML will return an array of EventSearchResultPortalDto nodes. Each node represents 
an event in the system: 
<ArrayOfEventSearchResultPortalDto 

xmlns="http://schemas.datacontract.org/2004/07/MEDSEEK.eHealth.Apps.Events.Common.S

earch" xmlns:i="http://www.w3.org/2001/XMLSchema-instance"> 

<EventSearchResultPortalDto> <AllGroupDiscountDescriptions/> 

<Availability>29</Availability> <CancellationMessage i:nil="true"/> <CustomKeywords 

i:nil="true"/> <DirectUrl>2011-clinical-trials-administration</DirectUrl> 

<EffectiveCost>10.0000</EffectiveCost> <EffectiveLocationName>Lakeland Community 

Hospital</EffectiveLocationName> <ExternalUrl i:nil="true"/> 

<GroupDiscountDescriptions 

xmlns:a="http://schemas.microsoft.com/2003/10/Serialization/Arrays"/> 

<HasGroupDiscountCodes>false</HasGroupDiscountCodes> 

<HasMultipleOccurrences>false</HasMultipleOccurrences> <Id>39</Id> <ImagePath 

i:nil="true"/> <IsCanceled>false</IsCanceled> 

<IsNotificationListEnabled>true</IsNotificationListEnabled> 

<IsRegistrationEnabled>true</IsRegistrationEnabled> <Keywords i:nil="true"/> 

<MaximumAttendees>30</MaximumAttendees> 

<ShowExternalUrlWarning>true</ShowExternalUrlWarning> 

<SingleOccurrenceId>39</SingleOccurrenceId> <StartDateFormatted>Sunday, June 08, 

2014, 10:26 AM</StartDateFormatted> <Title>2011 Clinical Trials 

Administration</Title> <AllowEventCart>false</AllowEventCart> 

<CurrentlyInCart>false</CurrentlyInCart> <Custom1 i:nil="true"/> <Custom2 

i:nil="true"/> <Custom3 i:nil="true"/> <DistanceUnit i:nil="true"/> 

<EffectiveAddress1>42024 Highway 195 E Post Office Box 780</EffectiveAddress1> 

<EffectiveAddress2/> <EffectiveCity>Haleyville</EffectiveCity> 

<EffectivePostalCode>35565</EffectivePostalCode> 

<EffectiveState>Alabama</EffectiveState> <EndDateFormatted>10:26 

AM</EndDateFormatted> <EventTopicId>6</EventTopicId> <EventTypeId>1</EventTypeId> 

<ExternalId/> <ExternalUrl/> <MostProximateLocationCompleteAddress i:nil="true"/> 

<MostProximateLocationDistance i:nil="true"/> <MostProximateLocationName 

i:nil="true"/> <SpecialInstructions i:nil="true"/> <SummaryDescription>A class that 

focuses on 2012 Clinical Trials Administration</SummaryDescription>    

</EventSearchResultPortalDto>     

<EventSearchResultPortalDto>        

<...>     

</EventSearchResultPortalDto>     

<EventSearchResultPortalDto>        

<...>     

</EventSearchResultPortalDto>  

</ArrayOfEventSearchResultPortalDto 
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Get Specific Event Request 

 

Request by Internal ID 
 

Request URL: 
<endpoint URL>/events/externalId/<externalId> 

 
In the example above, <Id> should be replaced with the Event Id. 
 
Request Body: None 
 
Request by External ID 
 

Request URL: 
<endpoint URL>/events/externalId/<externalId> 

 
In the example above, <externalId> should be replaced with the Event External Id. 
 
Request Body: None 
 
Response 
The response XML will return an EventDetailViewModelV2 node which contains a single Event node 
and also include all Event Occurrences inside the Occurrences node. 
 
<Eventdetailviewmodelv2 Xmlns:I="Http://Www.W3.Org/2001/Xmlschema-Instance"> 

<Event>  

<Title>ACLS Provider Course</Title> 

<Directurl>Acls-Provider-Course</Directurl> 

<Summarydescription>a Class That Focuses on ACLS Provider Course 

</Summarydescription>  

<Eventtopic>ACLS CPR NRP COURSES 

</Eventtopic>  

<Eventtype>Class</Eventtype>  

<Eventcontent>A Class That Focuses On &Lt;B> ACLS Provider Course 

&Lt;/B>&Lt;Br/>&Lt;Br/></Eventcontent>  

<Publishdate>03/11/2014 00:00:00</Publishdate>  

<Unpublishdate>09/27/2014 00:00:00</Unpublishdate>  

<Contactname>Bill Gates</Contactname> <Contactemail>Blah@Test.Com</Contactemail>  

<Contactphone>205-555-1234</Contactphone> <Maximumattendees>30</Maximumattendees>  

<Cost>0.0000</Cost> <Isenabled>True</Isenabled> <Externalurl/>  

<Orgunitid I:Nil="True"/> <Imagepath I:Nil="True"/> <Pictureid I:Nil="True"/> 
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<Internalonly>False</Internalonly> <Publiconly>False</Publiconly> <Costcenter/> 

<Paymentprocessorconfigurationid I:Nil="True"/> 

<Isnotifycontactenabled>True</Isnotifycontactenabled> 

<Notificationfrequency>Immediately</Notificationfrequency>  

<Eventexternalid I:Nil="True"/> <Keywords>Acls Cpr Nrp Courses</Keywords> 

<Customkeywords I:Nil="True"/> <Isregistrationenabled>True</Isregistrationenabled> 

<Isnotificationlistenabled>True</Isnotificationlistenabled> <Discountcodes/> 

<Specialinstructions/> <Custom1/> <Custom2/> <Custom3/> <Eventid>2</Eventid> 

</Event> <Occurrences> <Eventoccurrence> <Credentials I:Nil="True"/> 

<Eventid>2</Eventid> <Eventexternalid I:Nil="True"/> <Isenabled>True</Isenabled> 

<Orgunitid>501</Orgunitid> <Orgunitexternalid I:Nil="True"/> <Locationorgunitid 

I:Nil="True"/> <Locationorgunitexternalid I:Nil="True"/> <Locationname 

I:Nil="True"/> <Address1>849 South Three Notch Street</Address1> <Address2/> 

<City>Andalusia</City> <State I:Nil="True"/> <Postalcode>36420</Postalcode> 

<Country I:Nil="True"/> <Latitude I:Nil="True"/> <Longitude I:Nil="True"/> 

<Contactname>James Mcgowers</Contactname> 

<Contactemail>Blah@Test.Com</Contactemail> <Contactphone>205-555-

1234</Contactphone> <Maximumattendees>30</Maximumattendees> <Presenter>James 

Mcgowers</Presenter> <Cost>0.0000</Cost> <Costcenter I:Nil="True"/> 

<Registrationstartdate>03/11/2014 10:26:39</Registrationstartdate> 

<Registrationenddate>06/08/2014 10:26:39</Registrationenddate> 

<Ispricescheduleenabled>False</Ispricescheduleenabled> <Earlycost I:Nil="True"/> 

<Earlycostenddate I:Nil="True"/> <Earlycostenddays I:Nil="True"/> <Latecost 

I:Nil="True"/> <Latecoststartdate I:Nil="True"/> <Latecoststartdays I:Nil="True"/> 

<Paymentprocessorconfigurationid I:Nil="True"/> <Dynamicformsid I:Nil="True"/> 

<Publishorgunitentityassociations I:Nil="True"/> <Occurrenceexternalid 

I:Nil="True"/> 

<Isregistrationenabled>True</Isregistrationenabled> 

<Isnotificationlistenabled>True</Isnotificationlistenabled> 

<Isnotifycontactenabled>True</Isnotifycontactenabled> <Specialinstructions 

I:Nil="True"/> <Eventoccurrencedates> <Eventoccurrencedate> <Startdate>06/08/2014 

10:26:39</Startdate> <Enddate>06/08/2014 10:26:39</Enddate> </Eventoccurrencedate> 

</Eventoccurrencedates> <Occurrenceid>2</Occurrenceid> </Eventoccurrence> 

</Occurrences> </Eventdetailviewmodelv2> 
 
The Event node in this response is presented in the same format as the request body for the Add 
Event request (except for the EventId node) as well as the Update Event request. 
 
Inside the Occurrences node, each EventOccurrence node is presented in the same format as the 
request body for the Add Event Occurrence request (except for the OccurrenceId node) as well as the 
Update Event Occurrence request. 
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Add Event Request 

 

Request 
Request URL: 
<endpoint URL>/Add Event 
 

Request Body: 
The request body is in the same format as the Event node from the response from the Get Specific 
Event Request, except for the Credentials and EventId . 
 
The Credentials must be supplied as the first child node of the request. 
 
The EventId will be generated when the event is added, and therefore cannot be specified when 
adding an event. 
 
An EventExternalId may be specified in order to keep records in sync with an external system. Events 
can later be queried through this API via the EventExternalId. 
 

<Event xmlns:i="http://www.w3.org/2001/XMLSchema - instance">  

<Credentials> 

<UserName>Username Goes Here</UserName> <Password>Password Goes Here</Password> 

</Credentials> <Title>ACLS Provider Course</Title> <DirectUrl>acls-provider-

course</DirectUrl> <SummaryDescription>A class that focuses on ACLS Provider 

Course</SummaryDescription> <EventTopics> <EventTopic> <Name>ACLS CPR NRP 

COURSES</Name> </EventTopic> <EventTopic> <Name>Cancer Support</Name> </EventTopic> 

</EventTopics> <EventTypes> <EventType> <Name>Class</Name> </EventType> <EventType> 

<Name>Presentation</Name> </EventType> </EventTypes <EventContent>A class that 

focuses on &lt;b> ACLS Provider Course &lt;/b>&lt;br/>&lt;br/></EventContent> 

<PublishDate>03/11/2014 00:00:00</PublishDate> <UnpublishDate>09/27/2014 

00:00:00</UnpublishDate> <ContactName>Bill Gates</ContactName> 

<ContactEmail>blah@test.com</ContactEmail> <ContactPhone>205-555-

1234</ContactPhone> <MaximumAttendees>30</MaximumAttendees> <Cost>0.0000</Cost> 

<IsEnabled>true</IsEnabled> <ExternalUrl/> <OrgUnitId i:nil="true"/> <ImagePath 

i:nil="true"/> <PictureId i:nil="true"/> <InternalOnly>false</InternalOnly> 

<PublicOnly>false</PublicOnly> <CostCenter/> <PaymentProcessorConfigurationId 

i:nil="true"/> <IsNotifyContactEnabled>true</IsNotifyContactEnabled> 

<NotificationFrequency>Immediately</NotificationFrequency> <EventExternalId 

i:nil="true"/> <Keywords>acls cpr nrp courses</Keywords> <CustomKeywords 

i:nil="true"/> <IsRegistrationEnabled>true</IsRegistrationEnabled> 

<IsNotificationListEnabled>true</IsNotificationListEnabled> <DiscountCodes/> 

<SpecialInstructions/> <Custom1/> <Custom2/> <Custom3/> 

</Event>  
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equired Fields 
The following fields are required when adding an event: 

• Title 
• DirectUrl 
• SummaryDescription 
• Topic 
• Type 

 

Update Event Request 

Request 
Request URL: 
<endpoint URL>/Update Event 

 
Request Body: 
 

The request body is in the same format as the Event node from the response from the Get Specific 
Event Request, except for the Credentials. 
 
The Credentials must be supplied as the first child node of the request. 
 

<Event xmlns:i="http://www.w3.org/2001/XMLSchema-instance"> <Credentials> 

<UserName>Username Goes Here</UserName> <Password>Password Goes Here</Password> 

</Credentials> <Title>ACLS Provider Course</Title> <DirectUrl>acls-provider-

course</DirectUrl> <SummaryDescription>A class that focuses on ACLS Provider 

Course</SummaryDescription> <EventTopics> <EventTopic> <Name>ACLS CPR NRP 

COURSES</Name> </EventTopic> <EventTopic> <Name>Cancer Support</Name> </EventTopic> 

</EventTopics> <EventTypes> 

<EventType> <Name>Class</Name> </EventType> <EventType> <Name>Presentation</Name> 

</EventType> </EventTypes <EventContent>A class that focuses on &lt;b> ACLS 

Provider Course &lt;/b>&lt;br/>&lt;br/></EventContent> <PublishDate>03/11/2014 

00:00:00</PublishDate> <UnpublishDate>09/27/2014 00:00:00</UnpublishDate> 

<ContactName>Bill Gates</ContactName> <ContactEmail>blah@test.com</ContactEmail> 

<ContactPhone>205-555-1234</ContactPhone> <MaximumAttendees>30</MaximumAttendees> 

<Cost>0.0000</Cost> <IsEnabled>true</IsEnabled> <ExternalUrl/> <OrgUnitId 

i:nil="true"/> <ImagePath i:nil="true"/> <PictureId i:nil="true"/> 

<InternalOnly>false</InternalOnly> <PublicOnly>false</PublicOnly> <CostCenter/> 

<PaymentProcessorConfigurationId i:nil="true"/> 

<IsNotifyContactEnabled>true</IsNotifyContactEnabled> 

<NotificationFrequency>Immediately</NotificationFrequency> <EventExternalId 

i:nil="true"/> <Keywords>acls cpr nrp courses</Keywords> <CustomKeywords 

i:nil="true"/> <IsRegistrationEnabled>true</IsRegistrationEnabled> 
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<IsNotificationListEnabled>true</IsNotificationListEnabled> <DiscountCodes/> 

<SpecialInstructions/> <Custom1/> <Custom2/> <Custom3/> <EventId>2</EventId>  

</Event> 

Get Specific Event Occurrence Request 

Request By Internal Id 
Request URL: 
<endpoint URL>/occurrence/<Id >  

 
In the example above, <Id> should be replaced with the OccurrenceId. 
 

Request Body: None 
 

Request by External ID 
Request URL: 
<endpoint URL>/occurrence/externalId/<externalId> 

 
In the example above, <externalId> should be replaced with the Occurrence External Id. 
 

Request Body: None 
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Response 
The response XML will return a single EventOccurrence node: 
<EventOccurrence xmlns:i="http://www.w3.org/2001/XMLSchema-instance"> 

<EventId>1</EventId> <EventExternalId i:nil="true"/> <IsEnabled>true</IsEnabled> 

<OrgUnitId>500</OrgUnitId> <OrgUnitExternalId i:nil="true"/> <LocationOrgUnitId 

i:nil="true"/> <LocationOrgUnitExternalId i:nil="true"/> <LocationName>River Falls 

Area Hospital</LocationName> <Address1>1629 E Division St</Address1> <Address2/> 

<City>River Falls</City> <State>Wisconsin</State> <PostalCode>54022</PostalCode> 

<Country i:nil="true"/> <Latitude i:nil="true"/> <Longitude i:nil="true"/> 

<ContactName>Kiki Dee</ContactName> 

<ContactEmail>kikidee@medseek.com</ContactEmail> 

<ContactPhone>4068458569</ContactPhone> <MaximumAttendees>30</MaximumAttendees> 

<Presenter>Kiki Dee</Presenter> <Cost>0.0000</Cost> <CostCenter i:nil="true"/> 

<RegistrationStartDate>03/11/2014 16:08:06</RegistrationStartDate> 

<RegistrationEndDate>06/08/2014 16:08:06</RegistrationEndDate> 

<IsPriceScheduleEnabled>false</IsPriceScheduleEnabled> <EarlyCost i:nil="true"/> 

<EarlyCostEndDate i:nil="true"/> <EarlyCostEndDays i:nil="true"/> 

<LateCost i:nil="true"/> <LateCostStartDate i:nil="true"/> <LateCostStartDays 

i:nil="true"/> <PaymentProcessorConfigurationId i:nil="true"/> <DynamicFormsId 

i:nil="true"/> <PublishOrgUnitEntityAssociations i:nil="true"/> 

<OccurrenceExternalId i:nil="true"/> 

<IsRegistrationEnabled>true</IsRegistrationEnabled> 

<IsNotificationListEnabled>true</IsNotificationListEnabled> 

<IsNotifyContactEnabled>true</IsNotifyContactEnabled> <SpecialInstructions 

i:nil="true"/> <EventOccurrenceDates> <EventOccurrenceDate> <StartDate>06/08/2014 

16:08:06</StartDate> <EndDate>06/08/2014 16:08:06</EndDate> </EventOccurrenceDate> 

</EventOccurrenceDates> <OccurrenceId>1</OccurrenceId> </EventOccurrence> 
 

The EventOccurrence node is presented in the same format as the request body for the Add Event 
Occurrence request (except for the OccurrenceId node), as well as the Update Event Occurrence 
request. 

Add Event Occurrence Request 

Request 
Request URL: 
 
<endpoint URL>/AddEventOccurrence 
 
REQUEST BODY: 
The request body is in the same format as the EventOccurrence node from the response from the Get 
Specific Event Occurrence Request, except for the Credentials and OccurrenceId. 
 
The Credentials must be supplied as the first child node of the request. 
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The OccurrenceId will be generated when the event is added, and therefore cannot be specified when 
adding an event. 
 
An OccurrenceExternalId may be specified in order to keep records in sync with an external system. 
Occurrences can later be queried through this API via the OccurrenceExternalId. 
 
<EventOccurrence xmlns:i="http://www.w3.org/2001/XMLSchema-instance"> <Credentials> 

<UserName>Username Goes Here</UserName> <Password>Password Goes Here</Password> 

</Credentials> <EventId>1</EventId> <EventExternalId i:nil="true"/> 

<IsEnabled>true</IsEnabled> <OrgUnitId>500</OrgUnitId> <OrgUnitExternalId 

i:nil="true"/> <LocationOrgUnitId i:nil="true"/> <LocationOrgUnitExternalId 

i:nil="true"/> <LocationName>River Falls Area Hospital</LocationName> 

<Address1>1629 E Division St</Address1> <Address2/> <City>River Falls</City> 

<State>Wisconsin</State> <PostalCode>54022</PostalCode> <Country i:nil="true"/> 

<Latitude i:nil="true"/> <Longitude i:nil="true"/> <ContactName>Kiki 

Dee</ContactName> <ContactEmail>kikidee@medseek.com</ContactEmail> 

<ContactPhone>4068458569</ContactPhone> <MaximumAttendees>30</MaximumAttendees> 

<Presenter>Kiki Dee</Presenter> <Cost>0.0000</Cost> <CostCenter i:nil="true"/> 

<RegistrationStartDate>03/11/2014 16:08:06</RegistrationStartDate> 

<RegistrationEndDate>06/08/2014 16:08:06</RegistrationEndDate> 

<IsPriceScheduleEnabled>false</IsPriceScheduleEnabled> <EarlyCost i:nil="true"/> 

<EarlyCostEndDate i:nil="true"/> <EarlyCostEndDays i:nil="true"/> <LateCost 

i:nil="true"/> <LateCostStartDate i:nil="true"/> <LateCostStartDays i:nil="true"/> 

<PaymentProcessorConfigurationId i:nil="true"/> <DynamicFormsId i:nil="true"/> 

<PublishOrgUnitEntityAssociations i:nil="true"/> <OccurrenceExternalId 

i:nil="true"/> <IsRegistrationEnabled>true</IsRegistrationEnabled> 

<IsNotificationListEnabled>true</IsNotificationListEnabled> 

<IsNotifyContactEnabled>true</IsNotifyContactEnabled> <SpecialInstructions 

i:nil="true"/> <EventOccurrenceDates> <EventOccurrenceDate> <StartDate>06/08/2014 

16:08:06</StartDate> <EndDate>06/08/2014 16:08:06</EndDate> </EventOccurrenceDate> 

</EventOccurrenceDates> </EventOccurrence> 

 

Required Fields 
The following fields are required when adding an event occurrence: 

• EventId or EventExternalId 
• ContactName 
• ContactEmail 
• At least 1 EventOccurrenceDate with StartDate and EndDate 
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Update Event Occurrence Request 

Request 
Request URL: 
<endpoint URL>/UpdateEventOccurrence 
 
Request Body: 
The Request Body is in the same format as the EventOccurrence node, from the response from the 
Get Specific Event Occurrence Request, except for the Credentials. 
 
Credentials must be supplied as the first child node of the request. 
 
<EventOccurrence xmlns:i="http://www.w3.org/2001/XMLSchema-instance"> <Credentials> 

<UserName>Username Goes Here</UserName> <Password>Password Goes Here</Password> 

</Credentials> <EventId>1</EventId> <EventExternalId i:nil="true"/> 

<IsEnabled>true</IsEnabled> <OrgUnitId>500</OrgUnitId> <OrgUnitExternalId 

i:nil="true"/> <LocationOrgUnitId i:nil="true"/> <LocationOrgUnitExternalId 

i:nil="true"/> <LocationName>River Falls Area Hospital</LocationName> 

<Address1>1629 E Division St</Address1> <Address2/> <City>River Falls</City> 

<State>Wisconsin</State> <PostalCode>54022</PostalCode> <Country i:nil="true"/> 

<Latitude i:nil="true"/> <Longitude i:nil="true"/> <ContactName>Kiki 

Dee</ContactName> 

<ContactEmail>kikidee@medseek.com</ContactEmail> 

<ContactPhone>4068458569</ContactPhone> <MaximumAttendees>30</MaximumAttendees> 

<Presenter>Kiki Dee</Presenter> <Cost>0.0000</Cost> <CostCenter i:nil="true"/> 

<RegistrationStartDate>03/11/2014 16:08:06</RegistrationStartDate> 

<RegistrationEndDate>06/08/2014 16:08:06</RegistrationEndDate> 

<IsPriceScheduleEnabled>false</IsPriceScheduleEnabled> <EarlyCost i:nil="true"/> 

<EarlyCostEndDate i:nil="true"/> <EarlyCostEndDays i:nil="true"/> <LateCost 

i:nil="true"/> <LateCostStartDate i:nil="true"/> <LateCostStartDays i:nil="true"/> 

<PaymentProcessorConfigurationId i:nil="true"/> <DynamicFormsId i:nil="true"/> 

<PublishOrgUnitEntityAssociations i:nil="true"/> <OccurrenceExternalId 

i:nil="true"/> <IsRegistrationEnabled>true</IsRegistrationEnabled> 

<IsNotificationListEnabled>true</IsNotificationListEnabled> 

<IsNotifyContactEnabled>true</IsNotifyContactEnabled> <SpecialInstructions 

i:nil="true"/> <EventOccurrenceDates> <EventOccurrenceDate> <StartDate>06/08/2014 

16:08:06</StartDate> <EndDate>06/08/2014 16:08:06</EndDate> </EventOccurrenceDate> 

</EventOccurrenceDates> <OccurrenceId>1</OccurrenceId> </EventOccurrence> 
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Get Event Registrants 

Request Based on Start Date 
Request URL: 
<endpoint URL>/OccurrenceRegistrants?startDate={startDate} 

 
Retrieves all event occurrence registrants that were registered after the specified startDate.  
 
Request Body: 
<Credentials>  

<UserName>Username Goes Here </UserName>  

<Password>Password Goes Here </Password>  

</Credentials> 

 

Response 
The response XML will return a collection of EventDto nodes that contain relevant information about 
each event, occurrence, and attendee. 
 
<ArrayOfEventsDto 

xmlns="http://schemas.datacontract.org/2004/07/MEDSEEK.eHealth.Apps.Events.Common.A

dmin.Attendees" xmlns:i="http://www.w3.org/2001/XMLSchema-instance">  

<EventsDto>  

<EventId>1</EventId>  

<ExternalEventId i:nil="true"/>  

<Occurrences>  

<OccurrenceDto>  

<Attendees>  

<AttendeeDto>  

<Address>85495 Spain Ct.</Address>  

<AmountPaid>0.0000</AmountPaid>  

<City>Birmingham</City>  

<DidAttend i:nil="true"/>  

<EmailAddress>Phyllis@hendrerit.us</EmailAddress>  

<FirstName>Wylie</FirstName>  

<Id>1</Id>  

<LastName>Raja</LastName>  

<Name>Wylie Raja</Name>  

<Phone>271-118-0355</Phone>  

<PostalCode>35244</PostalCode>  

<RegistrationDate>2011-10-22T13:54:18.5</RegistrationDate>  

<StateName>Alabama</StateName>  

</AttendeeDto>  

</Attendees>  
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<ExternalId i:nil="true"/>  

<Id>1</Id>  

</OccurrenceDto>  

</Occurrences>  

</EventsDto>  

<EventsDto>  

<...>  

</EventsDto>  

<EventsDto>  

<...>  

</EventsDto>  

</ArrayOfEventsDto> 

 

Get Specific Event Occurrence Registrants 

Request by Internal Id 
Request URL: 
<endpoint 

URL>/OccurrenceRegistrantsByOccurrenceId?eventOccurrenceId={eventOccurrenceId} 
 

In the example above, eventOccurrenceId represents the internal id of the occurrence. 
 

Request Body: 
<Credentials>  

<UserName>Username Goes Here </UserName>  

<Password>Password Goes Here </Password>  

</Credentials> 

 

Request by External ID 
Request URL: 
<endpoint URL>/OccurrenceRegistrantsByExternalId?externalId={externalId} 

 
In the example above, externalId represents the external id of the occurrence. 
 
Request Body: 
<Credentials> <UserName>Username Goes Here </UserName> <Password>Password Goes Here 

</Password> </Credentials> 
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Response 
The response XML will return a single EventOccurrenceAttendeesViewModel node, which contains 
relevant information about all attendees for a specified event occurrence. 
 
<EventOccurrenceAttendeesViewModel 

xmlns="http://schemas.datacontract.org/2004/07/MEDSEEK.eHealth.Apps.Events.SharePoi

nt.ViewModels" xmlns:i="http://www.w3.org/2001/XMLSchema-instance"> <Attendees 

xmlns:a="http://schemas.datacontract.org/2004/07/MEDSEEK.eHealth.Apps.Events.Common

.Admin.Attendees"> <a:AttendeeDto> <a:Address>85495 Spain Ct.</a:Address> 

<a:AmountPaid>0.0000</a:AmountPaid> <a:City>Birmingham</a:City> <a:DidAttend 

i:nil="true"/> <a:EmailAddress>Phyllis@hendrerit.us</a:EmailAddress> 

<a:FirstName>Wylie</a:FirstName> <a:Id>0</a:Id> <a:LastName>Raja</a:LastName> 

<a:Name i:nil="true"/>  

<a:Phone>2711180355</a:Phone>  

<a:PostalCode>35244</a:PostalCode>  

<a:RegistrationDate>2011-10-22T13:54:18.5</a:RegistrationDate>  

<a:StateName>Alabama</a:StateName>  

</a:AttendeeDto>  

<a:AttendeeDto>  

<...>  

</a:AttendeeDto>  

<a:AttendeeDto>  

<...>  

</a:AttendeeDto>  

</Attendees>  

<EventId>1</EventId>  

<EventOccurrenceId>1</EventOccurrenceId>  

</EventOccurrenceAttendeesViewModel> 

Get Event Registrant Changes 

Request Based on Date 
Request URL: 
<endpointURL>/GetEventOccurrenceRegistrantUpdates?changedSinceUtcDateTime={changedS

inceUtcDateTime} 

 
Retrieves all event occurrence registrants that were registered or cancelled after the specified 
date/time. 
 
Request Body: 
<Credentials>  

<Username>Username Goes Here </Username>  

<Password>Password Goes Here </Password>  

</Credentials> 
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Response 
The response XML will return a single EventOccurrenceAttendeeUpdatesDtoV2 node, which 
contains all newly registered and cancelled registrants for all events since the specified date/time. 
 
<EventOccurrenceAttendeeUpdatesDtoV2 

xmlns="http://schemas.datacontract.org/2004/07/MEDSEEK.eHealth.Apps.Events.Common.A

pi.V2" xmlns:i="http://www.w3.org/2001/XMLSchema-instance">  

<EventInfo>  

<EventsDtoV2>  

<EventExternalId i:nil="true"/>  

<EventId>1</EventId>  

<Occurrences> 

<OccurrenceDtoV2> <Attendees> <AttendeeDtoV2> <Address1>85495 Spain Ct.</Address1> 

<Address2/> <AmountPaid>0.0000</AmountPaid> <City>Birmingham</City> <DidAttend 

i:nil="true"/> <DynamicColumnData i:nil="true"/> 

<EmailAddress>Phyllis@hendrerit.us</EmailAddress> <FirstName>Wylie</FirstName> 

<Id>1</Id> <LastName>Raja</LastName> <Name i:nil="true"/> <Phone>271-118-

0355</Phone> <PostalCode>35244</PostalCode> <RegistrationDate>2011-10-

22T13:54:18.5</RegistrationDate> <StateName>Alabama</StateName> <UpdatedDate>2013-

05-01T00:00:00</UpdatedDate> </AttendeeDtoV2> </Attendees> <ExternalId 

i:nil="true"/> <Id>1</Id> </OccurrenceDtoV2> </Occurrences> </EventsDtoV2> 

<EventsDtoV2> <...> </EventsDtoV2> <EventsDtoV2> <...> </EventsDtoV2> </EventInfo> 

<EventOccurrenceAttendeeCancellations/> <RequestReceivedDateTime>2014-03-

12T20:25:04.535278Z</RequestReceivedDateTime> 

</EventOccurrenceAttendeeUpdatesDtoV2> 
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Add Event Occurrence Registrant Request 

Add by Internal ID 
Request URL: 
<endpoint URL>/AddRegistrant?eventOccurrenceId={eventOccurrenceId} 

 
In the example above, {eventOccurrenceId} should be replaced with the OccurrenceId. 
 

Request by External ID 
Request URL: 
<endpoint URL>/AddRegistrantByExternalId?externalId={externalId} 

 
In the example above, {externalId} should be replaced with the Occurrence External Id. 
 

Request Body: 
<Attendee> <Credentials> <UserName>Username Goes Here</UserName> <Password>Password 

Goes Here</Password> </Credentials> <FirstName>Bob</FirstName> 

<LastName>Barker</LastName> <Address1>200 Clinton Road</Address1> <Address2/> 

<City>Birmingham</City> <StateAbbreviation>AL</StateAbbreviation> 

<PostalCode>35244</PostalCode> <Phone>555-333-4567</Phone> 

<EmailAddress>blah@blah.com</EmailAddress> <AmoundPaid>0</AmoundPaid> 

<DidAttend>true</DidAttend> </Attendee> 
 

Update Event Occurrence Registrant Request 

Update by Internal ID 
Request URL: 
<endpoint URL>/UpdateRegistrant?eventOccurrenceId={eventOccurrenceId} 

 
In the example above, {eventOccurrenceId} should be replaced with the OccurrenceId. 
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Request by External ID 
Request URL: 
<endpoint URL>/UpdateRegistrantByExternalId?externalId={externalId} 

 
In the example above, {externalId} should be replaced with the Occurrence External Id. 
 

The attendee to modify will be looked up based on the FirstName, LastName and Email values. 
 

Request Body: 
<Attendee> <Credentials> <UserName>Username Goes Here</UserName> <Password>Password 

Goes Here</Password> </Credentials> <FirstName>Bob</FirstName> 

<LastName>Barker</LastName> <Address1>200 Clinton Road</Address1> <Address2/> 

<City>Birmingham</City> <StateAbbreviation>AL</StateAbbreviation> 

<PostalCode>35244</PostalCode> <Phone>555-333-4567</Phone> 

<EmailAddress>blah@blah.com</EmailAddress> <AmoundPaid>0</AmoundPaid> 

<DidAttend>true</DidAttend> </Attendee> 3.14  

 

Delete Event Occurrence Registrant 

Delete by Internal ID 
Request URL: 
<endpointURL>/DeleteRegistrant?eventOccurrenceId={eventOccurrenceId}&firstName={fir

stName}&lastName={lastName}&email={emailAddress} 

 

Delete by External ID 
Request URL: 
<endpointURL>/DeleteRegistrantByExternalId?externalId={externalId}&firstName={first

Name}&lastName={lastName}&email={emailAddress}  

 
Request Body: 
<Credentials>  

<UserName>Username Goes Here</UserName>  

<Password>Password Goes Here</Password>  

</Credentials> 
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CONTENT APPS - API INTEGRATION - LOCATIONS, OVERVIEW 
This document provides API Integration information for the Locations Content App within CMS. 
 
The API is RESTful and all requests are made up of properly-formatted HTTP requests.  Appropriate 
URLs are defined in each corresponding section of this guide for each Content App. 
 
Note: 
 This document is intended for users who are skilled in consuming Web services 
and have access to an applicable software application that allows this capability. 

Request Method and Content-Type 
All requests use the HTTP POST method. 
 
Content-Type:  For all requests where data is being sent to the system in the request body, the content-
type of the request can either be text/xml or application/xml. 
 

Common Response Codes 
The most common response codes are explained in the table below: 

 
HTTP Response 
Code 

Description 

200 - OK The operation was successful. 
400 - Bad Request Client error. The information passed to the service method did not 

match what the server expected. This could be caused by XML 
passed to the method that did not match the schema for the 
method. 

403 - Forbidden Unauthorized.  The credentials passed to the service method were 
incorrect or the account specified did not have the permissions to 
perform the action that was requested. 

500 - Internal Server 
Error 

Server error.  The information passed to the service method 
matched what was expected syntactically, but the server was 
unable to process the request. This could be due to an invalid 
identifier passed within the XML to the method, an invalid value 
passed within the XML to the method, or the information specified 
an action that violated business rules for the method. 
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Working with XML in Request/Response Bodies 
All data sent to the server and returned from the server will be sent as XML. This section describes 
several things to keep in mind while working with the request/response XML.  
 
References to Org Unit are synonymous with Location throughout this document. 
 

Request/Response NULL Fields 
Fields in the request/response XML can be set to Null in 2 ways: 

• The field has been identified as Null by its “nil” attribute – When a field contains the 
attribute i:nil="true", then its value will be Null. In the example below, MiddleName has been 
defined as a null field while PictureId is an empty node.  In any response from the server, all 
null fields will be represented in this way. 

 
<OrgUnitId>501</OrgUnitId>  

<MiddleName i:nil="true"/>  

<PictureId/>  

 
 

See the Namespaces section below, for the namespace needed when using this 
notation. 

 
• The field has been omitted from the request – When a field is not present in the request, then 

that field value will be Null.  The example below will be seen by the server exactly the same as 
method 1 above: 

•  
<OrgUnitId>501</OrgUnitId>  

<PictureId/>  

 

Namespaces 
In most cases, no XML Namespace is required when sending data to the server. The one exception is 
when using the i:nil=”true” notation to represent null fields. In this case the following namespace 
should be included in the root node of the request. 
 
xmlns:i=http://www.w3.org/2001/XMLSchema-instance 
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Null Fields vs. Empty Nodes When Updating Data 
In order to simplify the process of updating data through the API, null fields and empty nodes are treated 
differently. It is important to realize these differences and understand how the server will treat these 
fields in a request. 
 

See Request/Response Null Fields to see how null fields and empty nodes are 
defined differently. 

• Null Fields – When a null field is sent to the server during an “Update” request, the server 
ignores this field. 

• Empty Nodes – When an empty node is sent to the server, the server removes or deletes that 
value. 

 
In the example below, OrgUnitId will be updated to the value 501, MiddleName will be ignored (i.e. its 
previously existing value will not be altered), and PictureId will be deleted from the entity. 
 
<OrgUnitId>501</OrgUnitId>  

<MiddleName i:nil="true"/>  

<PictureId/>  
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AUTHENTICATION 
CMS now requires token-based authentication to utilize the API.  Authentication is achieved by passing 
an Authorization Header Value, using the Authenticate method and retrieving the token that will be 
used in all subsequent API methods within a given time frame. 
 
Several steps are involved in creating the Authorization Header Value. 

• Work with Healthgradesth to receive an API user and password. 
• Format a string in the following format: <Content Apps User>:<Content Apps Password> 

(example: APIUser:MyP@ssWord) 
• Convert the string to binary. 
• Base64 encode the string. 
• Prepend the Base64 string with the text: "Basic ". 

 
Example authentication code:  Basic ZnVsY3J1bWFkncbOkVBMV9xYWI= 

 
To authenticate, create a request with the following URL (where Instance Name is the name of your 
instance) with a POST request type: 
https://contentapps.influencehealth.com/<instance name>/api/public/v1/authenticate 
 
Pass a header in the following format: 
Authorization:<Authorization Header Value> 

 
Example Header: 
Authorization:Basic ZnVsY3J1bWFkncbOkVBMV9xYWI= 

 
The response will include a token in JSON format that you will use to access the API for all subsequent 
methods: 
{ 

"Token" : "221b2aad-ad56-4cd6-934d-233eb4970faf" 

} 

 
For each API request, include the token as a header in the following format: 
AuthorizationToken:<token> 

 
Example Header: 
AuthorizationToken:221b2aad-ad56-4cd6-934d-233eb4970faf 
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LOCATIONS 
For all Locations API requests, the base service endpoint URL is shown below: 
https://contentapps.influencehealth.com/<instance name>/api/admin/v1/api/location 

 
In the example above, <instance name> should be replaced with the instance name associated with the 
target instance. 
 

Get All Locations Request 

Request 
Request URL: 
<endpoint URL>/locations 

 
Request Body: None 
 

Paging (Optional) 
 
Paging can be achieved by appending the pageNumber and pageSize parameters to the query string: 
<endpoint URL>/locations?pageNumber=3&pageSize=10 
 

Response 
The response XML will return an array of OrgUnitSearchResultDto nodes. Each node represents an 
organizational unit in the system: 
 
<ArrayOfOrgUnitSearchResultDto 

    

xmlns="http://schemas.datacontract.org/2004/07/MEDSEEK.eHealth.Apps.OrgUnits.Common

" 

    xmlns:i="http://www.w3.org/2001/XMLSchema-instance"> 

    <OrgUnitSearchResultDto> 

        <Address1>849 South Three Notch Street</Address1> 

        <Address2/> 

        <City>Andalusia</City> 

        <CompleteAddress>849 South Three Notch Street Andalusia, Alabama 

36420</CompleteAddress> 

        <Custom1 i:nil="true"/> 

        <Custom2 i:nil="true"/> 

        <Custom3 i:nil="true"/> 

        <CustomKeywords i:nil="true"/> 

        <Description i:nil="true"/> 

        <DirectUrl/> 

        <DistanceUnit i:nil="true"/> 

        <Fax>2059822345</Fax> 
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        <Id>501</Id> 

        <IsSite>false</IsSite> 

        <Keywords i:nil="true"/> 

        <Name>Andalusia Regional Hospital</Name> 

        <OrgUnitDistance i:nil="true"/> 

        <OrgUnitExternalId i:nil="true"/> 

        <ParentId>2</ParentId> 

        <Path i:nil="true"/> 

        <Phone>3342228466</Phone> 

        <PictureId i:nil="true"/> 

        <PictureUrl i:nil="true"/> 

        <PostalCode>36420</PostalCode> 

        <StateName>Alabama</StateName> 

    </OrgUnitSearchResultDto> 

    <OrgUnitSearchResultDto> 

<...> 

    </OrgUnitSearchResultDto> 

    <OrgUnitSearchResultDto> 

<...> 

    </OrgUnitSearchResultDto> 

</ArrayOfOrgUnitSearchResultDto> 

 

Get Specific Location Request  

Request by Internal Id 
Request URL: 
 
<endpoint URL>/locations?id=<Id>  

 
In the example above, <Id> should be replaced with the Location Id. 
 
Request Body: None 

Request by External Id 
Request URL: 
<endpoint URL>/locations?externalId=<externalId>  

 
In the example above, <externalId> should be replaced with the Location External Id. 
 
Request Body: None 
 

Response 
The response XML will return a single OrgUnit node. 
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<OrgUnit 

    xmlns:i="http://www.w3.org/2001/XMLSchema-instance"> 

    <OrgUnitExternalId i:nil="true"/> 

    <Name>Andalusia Regional Hospital</Name> 

    <IsEnabled>true</IsEnabled> 

    <Address1>849 South Three Notch Street</Address1> 

    <Address2/> 

    <City>Andalusia</City> 

    <State>Alabama</State> 

    <PostalCode i:nil="true"/> 

    <Country>United States</Country> 

    <Latitude>31.297980844974500</Latitude> 

    <Longitude>-86.494771912694000</Longitude> 

    <Phone>3342228466</Phone> 

    <Fax>2059822345</Fax> 

    <Email i:nil="true"/> 

    <CustomUrl/> 

    <Description i:nil="true"/> 

    <ImageUrl i:nil="true"/> 

    <PictureId i:nil="true"/> 

    <OrgUnitTypes> 

        <OrgUnitType> 

            <Name>Departments</Name> 

            <IsPrimaryOrgUnitType>false</IsPrimaryOrgUnitType> 

        </OrgUnitType> 

        <OrgUnitType> 

            <Name>Locations</Name> 

            <IsPrimaryOrgUnitType>true</IsPrimaryOrgUnitType> 

        </OrgUnitType> 

    </OrgUnitTypes> 

    <OrgUnitInsurances> 

        <OrgUnitInsurance> 

            <Name>American Family Insurance</Name> 

        </OrgUnitInsurance> 

        <OrgUnitInsurance> 

            <Name>Aetna</Name> 

        </OrgUnitInsurance> 

        <OrgUnitInsurance> 

            <Name>Aflac</Name> 

        </OrgUnitInsurance> 

    </OrgUnitInsurances> 

    <OrgUnitServices> 
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        <OrgUnitService> 

            <Name>Cosmetic Services</Name> 

        </OrgUnitService> 

        <OrgUnitService> 

            <Name>DNA Testing</Name> 

        </OrgUnitService> 

    </OrgUnitServices> 

    <OrgUnitHours> 

        <WeekDayHours> 

            <DayOfWeek>Tuesday</DayOfWeek> 

            <OpenTime>8:00 AM</OpenTime> 

            <CloseTime>5:00 PM</CloseTime> 

        </WeekDayHours> 

        <WeekDayHours> 

            <DayOfWeek>Wednesday</DayOfWeek> 

            <OpenTime>8:00 AM</OpenTime> 

            <CloseTime>5:00 PM</CloseTime> 

        </WeekDayHours> 

        <WeekDayHours> 

            <DayOfWeek>Thursday</DayOfWeek> 

            <OpenTime>8:00 AM</OpenTime> 

            <CloseTime>5:00 PM</CloseTime> 

        </WeekDayHours> 

        <WeekDayHours> 

            <DayOfWeek>Friday</DayOfWeek> 

            <OpenTime>8:00 AM</OpenTime> 

            <CloseTime>5:00 PM</CloseTime> 

        </WeekDayHours> 

        <WeekDayHours> 

            <DayOfWeek>Saturday</DayOfWeek> 

            <OpenTime>8:00 AM</OpenTime> 

            <CloseTime>5:00 PM</CloseTime> 

        </WeekDayHours> 

    </OrgUnitHours> 

    <OrgUnitDiscountCodes/> 

    <ParentInternalId>2</ParentInternalId> 

    <ParentExternalId i:nil="true"/> 

    <CopiedInternalId i:nil="true"/> 

    <CopiedExternalId i:nil="true"/> 

    <CostCenter i:nil="true"/> 

    <Keywords i:nil="true"/> 

    <CustomKeywords i:nil="true"/> 

    <Custom1 i:nil="true"/> 
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    <Custom2 i:nil="true"/> 

    <Custom3 i:nil="true"/> 

    <OrgUnitInternalId>501</OrgUnitInternalId> 

</OrgUnit> 

 
The response returned by this request is presented in the same format as the request body for the Add 
Location request (except for the OrgUnitInternalId node) as well as the Update Location request. 
 

Add Location Request 

Request 
Request URL: 
<endpoint URL>/addlocation 

 
Request Body: 
The request body is in the same format as the response from the Get Specific Location Request, 
except for OrgUnitInternalId .  The Credentials section can be ignored. 
 
The OrgUnitInternalId will be generated when the location is added, and therefore cannot be specified 
when adding a location. 
 
An OrgUnitExternalId may be specified in order to keep records in sync with an external system. 
Locations can later be queried through this API via the OrgUnitExternalId. 
 
<OrgUnit 

    xmlns:i="http://www.w3.org/2001/XMLSchema-instance"> 

    <Credentials> 

        <UserName></UserName> 

        <Password></Password> 

    </Credentials> 

    <OrgUnitExternalId i:nil="true"/> 

    <Name>My Test Hospital</Name> 

    <IsEnabled>true</IsEnabled> 

    <Address1>849 South Three Notch Street</Address1> 

    <Address2/> 

    <City>Andalusia</City> 

    <State>Alabama</State> 

    <PostalCode i:nil="true"/> 

    <Country>United States</Country> 

    <Latitude>31.297980844974500</Latitude> 

    <Longitude>-86.494771912694000</Longitude> 

    <Phone>3342228466</Phone> 

    <Fax>2059822345</Fax> 

    <Email i:nil="true"/> 
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    <CustomUrl/> 

    <Description i:nil="true"/> 

    <ImageUrl i:nil="true"/> 

    <PictureId i:nil="true"/> 

    <OrgUnitTypes> 

        <OrgUnitType> 

            <Name>Departments</Name> 

            <IsPrimaryOrgUnitType>false</IsPrimaryOrgUnitType> 

        </OrgUnitType> 

        <OrgUnitType> 

            <Name>Locations</Name> 

            <IsPrimaryOrgUnitType>true</IsPrimaryOrgUnitType> 

        </OrgUnitType> 

    </OrgUnitTypes> 

    <OrgUnitInsurances> 

        <OrgUnitInsurance> 

            <Name>American Family Insurance</Name> 

        </OrgUnitInsurance> 

        <OrgUnitInsurance> 

            <Name>Aetna</Name> 

        </OrgUnitInsurance> 

        <OrgUnitInsurance> 

            <Name>Aflac</Name> 

        </OrgUnitInsurance> 

        <OrgUnitInsurance> 

            <Name>Allstate</Name> 

        </OrgUnitInsurance> 

        <OrgUnitInsurance> 

            <Name>American Fidelity Insurance</Name> 

        </OrgUnitInsurance> 

        <OrgUnitInsurance> 

            <Name>American National Insurance Company</Name> 

        </OrgUnitInsurance> 

        <OrgUnitInsurance> 

            <Name>Amerigroup</Name> 

        </OrgUnitInsurance> 

    </OrgUnitInsurances> 

    <OrgUnitServices> 

        <OrgUnitService> 

            <Name>Cosmetic Services</Name> 

        </OrgUnitService> 

        <OrgUnitService> 

            <Name>DNA Testing</Name> 
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        </OrgUnitService> 

    </OrgUnitServices> 

    <OrgUnitHours> 

        <WeekDayHours> 

            <DayOfWeek>Tuesday</DayOfWeek> 

            <OpenTime>8:00 AM</OpenTime> 

            <CloseTime>5:00 PM</CloseTime> 

        </WeekDayHours> 

        <WeekDayHours> 

            <DayOfWeek>Wednesday</DayOfWeek> 

            <OpenTime>8:00 AM</OpenTime> 

            <CloseTime>5:00 PM</CloseTime> 

        </WeekDayHours> 

        <WeekDayHours> 

            <DayOfWeek>Thursday</DayOfWeek> 

            <OpenTime>8:00 AM</OpenTime> 

            <CloseTime>5:00 PM</CloseTime> 

        </WeekDayHours> 

        <WeekDayHours> 

            <DayOfWeek>Friday</DayOfWeek> 

            <OpenTime>8:00 AM</OpenTime> 

            <CloseTime>5:00 PM</CloseTime> 

        </WeekDayHours> 

        <WeekDayHours> 

            <DayOfWeek>Saturday</DayOfWeek> 

            <OpenTime>8:00 AM</OpenTime> 

            <CloseTime>5:00 PM</CloseTime> 

        </WeekDayHours> 

    </OrgUnitHours> 

    <OrgUnitDiscountCodes/> 

    <ParentInternalId>2</ParentInternalId> 

    <ParentExternalId i:nil="true"/> 

    <CopiedInternalId i:nil="true"/> 

    <CopiedExternalId i:nil="true"/> 

    <CostCenter i:nil="true"/> 

    <Keywords>cosmetic services,departments,dna testing,locations</Keywords> 

    <CustomKeywords i:nil="true"/> 

    <Custom1 i:nil="true"/> 

    <Custom2 i:nil="true"/> 

    <Custom3 i:nil="true"/> 

</OrgUnit> 
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Required Fields 
The following fields are required when adding a location: 

• Name 
 

Update Location Request  

Request   
Request URL: 
<endpoint URL>/updatelocation 

 
Request Body: 
The request body is in the same format as the response from the Get Specific Location Request. The 
Credentials section can be ignored. 
 
<OrgUnit 

    xmlns:i="http://www.w3.org/2001/XMLSchema-instance"> 

    <Credentials> 

        <UserName></UserName> 

        <Password></Password> 

    </Credentials> 

    <OrgUnitExternalId i:nil="true"/> 

    <Name>My Test Hospital</Name> 

    <IsEnabled>true</IsEnabled> 

    <Address1>849 South Three Notch Street</Address1> 

    <Address2/> 

    <City>Andalusia</City> 

    <State>Alabama</State> 

    <PostalCode i:nil="true"/> 

    <Country>United States</Country> 

    <Latitude>31.297980844974500</Latitude> 

    <Longitude>-86.494771912694000</Longitude> 

    <Phone>3342228466</Phone> 

    <Fax>2059822345</Fax> 

    <Email i:nil="true"/> 

    <CustomUrl/> 

    <Description i:nil="true"/> 

    <ImageUrl i:nil="true"/> 

    <PictureId i:nil="true"/> 

    <OrgUnitTypes> 

        <OrgUnitType> 

            <Name>Departments</Name> 

            <IsPrimaryOrgUnitType>false</IsPrimaryOrgUnitType> 

        </OrgUnitType> 
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        <OrgUnitType> 

            <Name>Locations</Name> 

            <IsPrimaryOrgUnitType>true</IsPrimaryOrgUnitType> 

        </OrgUnitType> 

    </OrgUnitTypes> 

    <OrgUnitInsurances> 

        <OrgUnitInsurance> 

            <Name>American Family Insurance</Name> 

        </OrgUnitInsurance> 

        <OrgUnitInsurance> 

            <Name>Aetna</Name> 

        </OrgUnitInsurance> 

        <OrgUnitInsurance> 

            <Name>Aflac</Name> 

        </OrgUnitInsurance> 

        <OrgUnitInsurance> 

            <Name>Allstate</Name> 

        </OrgUnitInsurance> 

        <OrgUnitInsurance> 

            <Name>American Fidelity Insurance</Name> 

        </OrgUnitInsurance> 

        <OrgUnitInsurance> 

            <Name>American National Insurance Company</Name> 

        </OrgUnitInsurance> 

        <OrgUnitInsurance> 

            <Name>Amerigroup</Name> 

        </OrgUnitInsurance> 

    </OrgUnitInsurances> 

    <OrgUnitServices> 

        <OrgUnitService> 

            <Name>Cosmetic Services</Name> 

        </OrgUnitService> 

        <OrgUnitService> 

            <Name>DNA Testing</Name> 

        </OrgUnitService> 

    </OrgUnitServices> 

    <OrgUnitHours> 

        <WeekDayHours> 

            <DayOfWeek>Tuesday</DayOfWeek> 

            <OpenTime>8:00 AM</OpenTime> 

            <CloseTime>5:00 PM</CloseTime> 

        </WeekDayHours> 

        <WeekDayHours> 
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            <DayOfWeek>Wednesday</DayOfWeek> 

            <OpenTime>8:00 AM</OpenTime> 

            <CloseTime>5:00 PM</CloseTime> 

        </WeekDayHours> 

        <WeekDayHours> 

            <DayOfWeek>Thursday</DayOfWeek> 

            <OpenTime>8:00 AM</OpenTime> 

            <CloseTime>5:00 PM</CloseTime> 

        </WeekDayHours> 

        <WeekDayHours> 

            <DayOfWeek>Friday</DayOfWeek> 

            <OpenTime>8:00 AM</OpenTime> 

            <CloseTime>5:00 PM</CloseTime> 

        </WeekDayHours> 

        <WeekDayHours> 

            <DayOfWeek>Saturday</DayOfWeek> 

            <OpenTime>8:00 AM</OpenTime> 

            <CloseTime>5:00 PM</CloseTime> 

        </WeekDayHours> 

    </OrgUnitHours> 

    <OrgUnitDiscountCodes/> 

    <ParentInternalId>2</ParentInternalId> 

    <ParentExternalId i:nil="true"/> 

    <CopiedInternalId i:nil="true"/> 

    <CopiedExternalId i:nil="true"/> 

    <CostCenter i:nil="true"/> 

    <Keywords>cosmetic services,departments,dna testing,locations</Keywords> 

    <CustomKeywords i:nil="true"/> 

    <Custom1 i:nil="true"/> 

    <Custom2 i:nil="true"/> 

    <Custom3 i:nil="true"/> 

    <OrgUnitInternalId>501</OrgUnitInternalId> 

</OrgUnit> 

 

Get All Location Types Request 

Request 
Request URL: 
<endpoint URL>/types 

 
Request Body: None 
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Response 
The response XML will return an array of OrgUnitTypeDto nodes. Each node represents an 
organizational unit type in the system. 
 
<ArrayOfOrgUnitTypeDto 

    

xmlns="http://schemas.datacontract.org/2004/07/MEDSEEK.eHealth.Apps.OrgUnits.Common

" 

    xmlns:i="http://www.w3.org/2001/XMLSchema-instance"> 

    <OrgUnitTypeDto> 

        <Id>5</Id> 

        <ImageUrl i:nil="true"/> 

        <IsEnabled>true</IsEnabled> 

        <IsOutsideOfOrganization>false</IsOutsideOfOrganization> 

        <Name>Departments</Name> 

        <SiteIndicator>false</SiteIndicator> 

    </OrgUnitTypeDto> 

    <OrgUnitTypeDto> 

        <Id>2</Id> 

        <ImageUrl i:nil="true"/> 

        <IsEnabled>true</IsEnabled> 

        <IsOutsideOfOrganization>false</IsOutsideOfOrganization> 

        <Name>Locations</Name> 

        <SiteIndicator>false</SiteIndicator> 

    </OrgUnitTypeDto> 

    <OrgUnitTypeDto> 

        <Id>3</Id> 

        <ImageUrl i:nil="true"/> 

        <IsEnabled>true</IsEnabled> 

        <IsOutsideOfOrganization>false</IsOutsideOfOrganization> 

        <Name>Regions</Name> 

        <SiteIndicator>false</SiteIndicator> 

    </OrgUnitTypeDto> 

</ArrayOfOrgUnitTypeDto> 

 

Get Location Type by Id Request 

Request 
 
Request URL: 
<Endpoint URL>/types?id={Id} 

 
In the example above, Id is the location type id. 
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Request Body: None 
 

Response 
The response XML will return a single OrgUnitTypeDto node with the Id specified. 
 
<OrgUnitTypeDto 

    

xmlns="http://schemas.datacontract.org/2004/07/MEDSEEK.eHealth.Apps.OrgUnits.Common

" 

    xmlns:i="http://www.w3.org/2001/XMLSchema-instance"> 

    <Id>1</Id> 

    <ImageUrl i:nil="true"/> 

    <IsEnabled>true</IsEnabled> 

    <IsOutsideOfOrganization>false</IsOutsideOfOrganization> 

    <Name>Site</Name> 

    <SiteIndicator>true</SiteIndicator> 

</OrgUnitTypeDto> 

•  
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CUSTOM CONTENT - BASIC CONFIGURATION, CREATING CUSTOM FIELDS 
Custom Fields are created at the site root level and can be used across the entire site. 

• From the Site Root folder, open the _Configuration folder: 
• Open the _Custom Content folder. 
• Open the Custom Fields folder. 
• Click New from the top menu and select Custom Field. 

• Name the new field and click OK. 
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To Complete Custom Field Configuration: 
• Select the Field Type (This is currently either Text or WYSIWYG.) 
• Enter a Field Label (This value defaults to [Field Name].) 
• Enter Maximum Length (This is the length of the field.  It defaults to 255 characters.) 
• Provide a Default Value if desired (This value will display as the default on the Admin Input 

Form.) 
• Provide Field Width, if desired. 
• Provide Field Height, if desired. 
• Provide Preview Value, if desired. (This value will display on the layout preview. It defaults to 

[Field Name].) 
• Click Save or Save & Preview. (You can verify that the new custom field has now been added 

within the Custom Fields folder.) 

•  
Custom Fields have no viewable output, so a preview is not available for them. 
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CREATING CUSTOM CONTENT TYPES AND LAYOUTS 
Custom Types are created at the site root level and can be used across the entire site. 

• From the Site Root folder, open the _Configuration folder. 
• Open the _Custom Content folder. 
• Double-click the Content Types folder. 
• Click File > New from the top menu and select Custom Content Type.  (Your path would look 

something like this: .. /Reference Sites/Sample/Site Root/_Configuration/_Custom 
Content/Content Types 

•  
• Name the new Custom Content Type and click Create. 
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• A new folder is created, with the name you entered in the step above for the new Custom 
Content Type, which contains a _Content Type Configuration file and a Layouts folder. 

• The _Content Type Configuration form view has a dropdown option which allows you to set 
the Default Layout for the content type. 

• The _Content Type Configuration form view also has a side-by-side multi-select box which 
allows you to select which Content Type Fields will be available as tokens when building a 
page of this custom content type. 

 
 

Custom Content Type Configurations have no viewable output, therefore nothing 
will appear in Preview mode. 

 
 

Important: 
The Default Layout option has no correlation to the Content Type Field selection. 

 
• The Layouts folder contains a Default Layout, or "out-of-the-box", basic layout. 
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• A Custom Layout can be created by clicking New from the top menu and selecting Custom 
Layout. 

• Name the new Custom Layout and click OK.  A new layout file is created for the content type.  
You will notice that the Content Type is pre-populated. 

 
• Check the Default Layout for [Content Type] box to use this new layout for the content type. 
• The Markup area is used to drop any HTML markup you want to use for the layout. 
• Available Tokens pull in data for custom fields, as well as for standard available fields.  

Highlight a token using your pointer, then copy/paste the token into the Markup area, as 
needed. 
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Checkbox for 
Default Layout 
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BASIC EXAMPLE OF HTML MARKUP WITH TOKENS: 
Following, is a basic example of HTML markup with tokens: 
 
<p> <b> Clinical Trial ID: </b> 
{ClinicalTrialID} </p>  
<br> 
<p> <b> Clinical Trial Name: </b>   
{ClinicalTrialName} </p> 
<br> 
<p> <b> Clinical Trial Description: </b> 
<br> 
{ClinicalTrialDescription} </p> 
<br> 
<p> <b> Contact Name: </b>  
{ContactName}</p> 
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Tabs Layout 
• Click Save or Save & Preview.   The preview renders8 the layout of the HTML markup with 

token placeholder descriptions. 
 

• Result on publish: 

 
 

 
CREATING CUSTOM CONTENT PAGES 
                                                
8 In software, rendering is the process of generating an image from a model by means of computer software.  
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Custom Content Pages can be built to render the custom fields and layouts as configured. 
• From the _Pages folder (or from a folder within the _Pages folder), click New from the top 

menu and select Content Page. 

 
• Enter the new content page file name and click OK. 
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• A new Content Page is created, with the name you entered in the step above. 
• Expand the Tabs: Main Content, Additional Content, Page Properties… accordion. 

 
• Select the Drop Down: Content Type option.   

 
• Choose a Content Type from the drop-down menu.   
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Tabs: Main Content, Additional Content, Page Properties, Navigation, Page Meta, Snippets and 
Links 
You will notice that all the custom fields that were added for the Content Type are now available for 
selection. 
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• Enter all appropriate information in the fields provided. 
• Click Save & Preview to see the preview. 
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Preview Page 
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CREATING CUSTOM LIST WIDGETS 
Custom List Widgets can be built to render the custom fields within a list widget for a static page. 

• From the Site Root folder, go into the _Widgets folder. 

• Click New from the top menu and select Custom List Widget. 
 

• Name the new Custom List Widget and click OK.  The new widget is created.   
 

• Expand the Content App instance. 
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• Initially, there is no Instance ID, so click Save & Preview to view and configure the Content 

App instance. 
 

From the Preview, hover over the Content Query Placeholder text and click the Configure button 
when it appears. 
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The Content Query Content App Configuration page displays. 
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From the Basic Settings section, the following options can be configured: 
• Content Type 
• Layout (Currently, the only option is Default.  The next release should include additional 

layouts.) 
• Maximum # of Results 
• Sort Fields 
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From the Query Definition section, the following options can be configured: 
• Query Mode (Simple or Advanced) 
• Query Criteria 
•  

Drop the widget on a page to see the list results.  Don’t forget to publish the widget! 

 
 
Note:   

G2 must be set up in order for the Custom List Widget to query the results. 
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CUSTOM LIST QUERY CONFIGURATION 
Hospital Administrator users can now dynamically display related providers and services on the 
Locations Detail page.   
 
Configuration for this display is available within Custom Lists, where users can reference these Page 
Meta Tag values: 

• Location IDs,  
• Provider IDs and  
• Event IDs,  

 
as well as the Query String Param value, in the Query Criteria area of the Query Definition panel. 
 
Custom Lists display the correct list results based on the Meta Tag values on a page. 
 

Example: Accessing Locations List Widget Content Query Definition within Providers 
From the Content icon, access the Locations List Widget within Providers (sample path:   ../Site 
Root/_Widgets/Providers).  
 
From the File View panel, double-click the Locations List Widget asset.  When the page displays, 
hover over the Content Query Placeholder.  Click the Configure button that displays.   
 
Scroll down to view the Query Definition panel.  There are two fields: 

• Query Mode (This drop-down menu has two options: Advanced (default) and Simple.  For our 
example, we chose Simple.) 

• Query Criteria (This area populates with contextual button, drag and drop and drop-down 
controls, based on your Query Mode selection, with which to define your query criteria.  We 
clicked Add Group and in the WHERE drop-down, selected Services.  (Operators are: =, !=, <, 
<=, >, >=, Contains, Contains, Not Contains, Starts With, Ends With, In, Not In) and selected 
Location IDs.  

• Page Meta Tags drop-down menu.  
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Content 
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G2 SEARCH 
All custom content fields and types are indexed by G29, therefore the Site Search and Custom List 
Widget return results for the custom content. 
 
Site Search refiners also display and filter search results by Content Type. 
 

Content App-Specific Search G2 Index Additions 
All available Content App fields are now in o the Search G2 Index.  This includes 
all Providers, Events and Locations fields that are not currently indexed.  For example, Phone 
Numbers for Locations is now indexed in Search G2, thus will now display in Site 
Search and Content Query search results. 
  
Additional fields have also been added. 
 

Site Search Examples 

 

                                                
9 Search G2 is Crownpeak's industry standard indexing and cloud-based query platform, built for speed, fault 

tolerance and scalability. 
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Custom List Widget Example 
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CONTENT APPS CONFIGURATION FOR CUSTOM CONTENT 
For Custom Content Types to appear as options in the Content Type dropdowns, the CMS Path 
must be configured to point to the proper _Custom Content folder.   
 

To Configure the CMS Path 
• Navigate to Locations Settings within Content Apps,  
• Expand CMS Integration Settings,  
• Scroll down to the Custom Content CMS Path, 
• Paste the path of the Custom Content folder into the CMS Path and click Save. 

 

Content Apps – Location Settings 
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Custom Content Folder Path 
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CREATING SUB-SITES IN CMS AND FILTERING CONTENT APPS DATA SPECIFIC TO SUB-SITE 
• Create a new folder within the Site Root/_Pages folder. 

 
Note 
A sub-site must be under the main/parent site domain and will use the main site 

publishing rules. 

• Name the folder the name of the Sub-Site.  Note that the name will be used in the URL of the 
site. 
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• The sub-site folder will contain the following sub-folders specific to the sub-site: 
• _Assets (This option is used for digital asset management for this specific sub-site.  Note that 

the main site assets may be used within the sub-site as well.) 
• _Configuration (This option is used to configure the sub-site logo, site properties, utilities, top 

and footer navigation, SEO parameters, Google Analytics code and default content zones.) 
• _Pages (This option Houses all the content pages for the sub-site.) 

 
 
 
Note:   

Sub-sites use their own master pages, so you will need to publish the sub-site 
master page (found in the Assets folder of the Sub-site). 

 

• Configure the sub-site to filter Content Apps data specific to the sub-sites as follows: 
• Associate a location to the sub-site by opening the Locations Content App, editing the desired 

location, and selecting the Site Association option from the Location’s left menu.  

 
The Site Association configuration will allow you the ability to break inheritance 

of the content apps from the Global (Site) level to the Sub-site level. 

• Check the Enable Site Association checkbox to enable the Public Domain URL, Internal 
Live URL and Internal Stage URL fields. 
 
 

• Enter fully qualified URLs10 for the Public Domain URL, the Internal Live URL and the 
Internal Stage URL to include the http:// and the domain.  However, if default is in the URL, 

                                                
10 A fully qualified URL contains “http://” (or “https://www”). 

Enable Site 
Association 
checkbox 
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you will want to remove default. 
Example:  http://www.healthsystem.com/sub-site-name 
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• When associating a location to a site or sub-site, only the Content App data (Providers, 
Events, etc.) related to the location will be visible on pages and Content App searches within 
the site / sub-site.   
 

 
Site Search from the sub-site will still perform a global site search (not just a 

sub-site search). 

• Save the configuration. 
 

• Go to the Providers Content App, choose Settings from the top menu.  At the top-left corner 
of the Provider Settings page, change the drop-down value from Global Defaults to the 
desired location (i.e. sub-site) value. 
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• Click Break Inheritance and then click Save.  

To un-break inheritance, simply click the Inherit from Parent button and then click Save. 
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• Ensure that the Content App Search Results Page URL and Detail Page URL point to the 
correct Detail page. 
 

 
• If they do not already exist, create the Content Apps pages (Provider List, Provider Detail, 

etc.) within the sub-site folder structure.  For example: Domain Name/Site Root/_Pages/Sub-
Site Name/_Pages/Providers/. 
 

• Configure the Content App page URLs (Provider List, Provider Detail pages), so that they 
include the relative sub-site URL.   To do so, preview the page within the sub-site.   
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• Hover over the content area and click Configure.   
 
 
 

• Choose the Settings tab at the top of the window and then change the Detail Page URL to use 
the relative path of the sub-site, as in the example below: 

 e 

 

 

 

 

• Sub-sites additionally allow different styling than the main site.  These settings can be changed 
by navigating to the sub-site within the folder structure, choosing the _Assets folder, then the 
CSS folder to reveal the configurable CSS.  For example: subsiteClient.css. 

 

Hover and 
click. 
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PERSONALIZATION SETUP INSTRUCTIONS, WHAT IS WCO? 
The Web Content Optimizer (WCO) is the ideal Personalization platform.  It is a robust content 
delivery engine that provides testing and targeting capabilities at run-time, all on the client-side.  WCO 
gives clients all the power they need to quickly and easily deliver and test content, capture form data 
and target content to specific users, with real-time reports and analytics. 
 
WCO TARGETING GROUPS 
Targeting Groups are used to help website visitors focus on items of interest, for example displaying 
an East Coast conference to a website visitor from Vermont.  This feature enables editors to easily 
create targeting groups using drag-and-drop technology.  The ability to use drag and drop has made 
using this feature more intuitive and allows much quicker building of Targeting Groups. 

Targeting Groups describe which visitors can see your content, based on a set of Targeting Rules or 
conditions that you specify and whether or not they match these conditions.   

For example, you can deliver optimized and personalized content to visitors who: 
• Visit your site on a specific date or at a specific time of day. 
• Visit your site on certain devices or browsers. 
• Visit your site from certain sources (search engine, social media sites) or geolocations (regions, 

states, countries and ZIP codes). 
• Have viewed or interacted with certain parts of your site. 
• Have filled out a form and entered or selected certain field values. 
• Have a profile in your backend systems or any third-party CRM or Marketing Automation 

platform. 
 

WCO Targeting offers the best experience to manage, optimize and personalize your visitors’ web 
experience, directly in the CMS, since it: 

• Is fully and directly integrated in the CMS authoring experience. 
• Leverages a simple drag-and-drop user interface to ensure ease of use. 
• Requires no reading, editing, or copying of code. 
• Is designed to integrate with third party systems such as CRM’s and Marketing Automation 

systems. 
• Contains many the most popular Targeting Group examples to get you started. 
• Offers a large number of Targeting Rules to choose from including Time, Date, Geolocation, 

Browser, Device, Form fields, query-string parameters, page views and conversions, back 
office and 3rd-party attributes, and more. 

• Can store hundreds of custom Targeting Groups and Targeting Rules combinations. 
• Measures your marketing campaign success via the Analytics and Optimization Dashboards. 
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HOW TO USE TARGETING GROUPS 
CMS allows authors and editors to vary the content of WCO Snippets which can be applied to text and 
WYSIWYG controls, directly within your CMS pages.   
 
Creating and managing a targeting campaign within the CMS is done by defining your content variants 
in a WCO Snippet, and the associated Targeting Groups that describe the visitors you want to 
target.  Both new and existing Targeting Groups can easily be managed via a new drag-and-drop user 
interface, allowing the author to select from a number of Targeting Rules to define the audience or 
persona they want to target. 
 
Targeting Rules fall into the following categories: 

• Ambient (Data or attributes that are readily available for all visitors including anonymous 
visitors.) 

• Source (This data describes how the visitor arrived at your site.) 
• Demographic (This data shows what is known about the user from their web connection.) 
• Behavioral (This data describes the visitor’s interactions and engagement level on your site by 

tracking page views, and conversions.) 
• Form (This data is collected from any form on your site.) 
• Integration (This data is retrieved from your backend system, or any 3rd party system via 

WCO’s connectors.) 
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TARGETING RULES  
Use the following Targeting Rules to create your Targeting Groups: 
 
RULE TYPE USE CASE EXAMPLE 

Time Target users based on time of day they 
visit the site. 

Target "at word" visitors if they visit 
during the day and "at home" if they visit 
in the evening. 

Date Target users based on date or date-range 
they visit the site. 

Deliver content at beginning, before, 
after or during a campaign. 

Device Target user based on device and 
browser, or on a custom condition in their 
browser agent. 

Deliver relevant content to iPhone or 
Safari users or based on their specific 
Operating System. 

Referrer Target users based on the previous site 
they were on prior to arriving at yours. 

Identify users from search engines, 
social media sites or partner sites. 

Location Identify and target users from specific 
regions, states, countries or zip code 
ranges. 

Target users in Texas. 

Snippet Target users who view any snippet on 
any page in your site. 

Track user interest based on pages 
viewed. 

DemandBase* Target users with specific DemandBase 
attributes based on their IP address. 

Identify competitors, partners, and/or 
potential customers in various industry 
segments. 

Marketo* Target users based on their Marketo 
profile. 

Optimize your visitor's site experience 
with data from Marketo. 

* Require third party integration 
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STEP-BY-STEP WORKFLOW TO SUCCESSFUL TESTING AND TARGETING  
The workflow diagram below, illustrates the steps involved in setting up variants of content for your site. 

• Assign to any WYSIWYG on a page. 
• Create a Snippet. 
• Set up a Testing or Targeting Variant. 
• Set up a Targeting Group with rule set, if targeted content. 
• Add content to your Testing or Targeting Variants in the WYSIWYG editor. 
• Set up Conversion links to track. 
• Assign your Snippet to Collection for analytics. 
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ADD TARGETING GROUPS TO PAGE ELEMENT 
In Edit mode: 

• Navigate to the page where you want to set up a variant of content, i.e. Personalization or a 
Testing Variant. 

• Open the selected asset in Inline edit mode by clicking the Inline tab, as shown below, then 
hovering over the specific page element until you see the Settings tool wheel icon. 

• Click the Settings icon that displays at the top-left of that element on hover. 
• Select any WCO control on the page 
• A set of actions will appear in the white menu bar just above the editor 
• If you already have a snippet, skip to the next stop, otherwise click on Create Snippet to create 

a new snippet.  Enter the snippet name when prompted. 
• Click on Add Targeting Variant to define a new content variant. 
• Enter a name for your new variant. 
• Associate the variant with a Targeting Group, either by selecting one from the dropdown, or by 

clicking on Create Targeting Group, which will launch WCO’s Targeting Groups interface. 
• Refer to the Creating or Editing a Targeting Group section below for detailed instructions on 

how to create a new Targeting Group.  Once created, the Targeting Group will now be 
available for selection from the Targeting Group drop-down menu. 

• Enter your optimized content for your newly created and/or selected Targeting Group. 

 

Settings 

Inline 
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CREATE A SNIPPET 
• Click on the Clone menu item or the Create Snippet icon.  The Create Snippet dialog displays.  
• Enter the name for your Snippet.  It is recommended that you use a naming convention for 

example, {Facility}_{Location on Page}_{Type of Element}_{Element Description}:  
Home_CTA_Health Action. 
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ADD VARIANTS INTO YOUR SNIPPET 
• Select Add Variant. 
• Name your variant (You will see your variants in the dropdown as you create them.) 
• Start adding content into each variant.  Toggle between variants, by selecting each from the 

drop-down menu. 
• Variants of content can be deleted via the Delete Variant button or menu item.   
• As an example, the snippet might be Orthopedics, with Variants: Location A, Location B, and 

Location C. 

 
  

Add 
Variant 

Delete 
Variant 
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ADD TESTING OR TARGETING VARIANTS MENU 
Depending on your Zoom level, you may see a menu or menu with icons.   

  

Build a 
Form 

 

Insert 
Conversion 

Link 
 

Testing 
Settings 

Delete 
Variant 

Also used 
by 

Create 
Snippet 
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OVERVIEW OF STEPS 

Key Concept 
Always set Snippets and Targeting Variants on the page element itself.  Make your configuration 
changes, then save and publish. 

 
 
 
  

On Page: Set up snippet, variant, 
conversion, etc.

Save & Publish: This action "deploys" 
the personalization to WCO
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CREATING OR EDITING A TARGETING GROUP 
• Launch the WCO Targeting Groups interface from the left navigation WCO icon. 
• To create a new Targeting Group, select the New Group button. 
• To edit an existing Targeting Group, click the Edit link next to one of the pre-existing forms in 

the table. 
• The WCO drag-and-drop Targeting Group window will appear. 
• Enter a name in the Group Name field at the top of the page. 
• Add a Description (field has a character limit of 150).   
• (Optional) Add an image for the Targeting Group. 
• Click Profile Photo. 
• In the Upload Photo window, select Browse. 
• Select an image from your hard drive and click Open. 
• In the Upload Photo window click Upload. 
• The selected image will be displayed for your Targeting Group. 
• Select from the list of 11 New Rule or custom Existing rule types. 
• Drag the desired rules(s) into the Targeting Group. 
• Click Edit next to each new rule and enter the rule criteria. 
• Save the Targeting Group by clicking the Save button. 
• The Group Saved Message displays.  Your Targeting Group is now ready to use within WCO. 
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ADDING SNIPPET TO TARGETING GROUP, OR ASSOCIATING EXISTING SNIPPET  
Drag the Snippet Rule item into the main Rules Entered area of the Targeting Group edit screen.  
Click the Edit button for the Snippet Rule to display its edit dialog.  In the Snippet dialog that displays 
(below), when you click Edit, you can associate and configure your Snippet with Variant and Links 
from the drop-down lists.   
 
Do you want to count Views or Conversions?  Select your chosen option from these two radio buttons.  
Enter the number of hits (# of Hits) to count, for the page assessed from (Assessed from Page), in 
the free-text entry fields.   

• The number of hits (# of Hits) entered tells CMS that if the consumer goes to this page, or 
section of your site and hits the page that number of times, that this is an interested consumer 
and will serve up the variant you want them to see.  These stats will show up in your 
Dashboard Analytics. 
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HOW TO SET UP A TESTING VARIANT 
The WCO testing panels allow you to see the results of your testing variants in one chart.  The panel 
displays Testing Variants with the following information: 

• Variant Name 
• Distribution Percentage 
• Number of Visits 
• Conversions 
• Conversion Rate 

 
The data can be displayed based on a rolling number of days (7, 14, 30 or 90), or according to a 
timeframe: This Month, This Quarter, Last Month or Last Quarter.  Additionally, the default display will 
show the Conversion Rate winner from your testing variants. 

• Click the Add Variant menu item to add a Testing Variant. 
• In the Add Testing Variant dialog that displays, give your variant a meaningful name, specific 

to what you are targeting, for example: Heart Risk Assessment. 
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You can delete a variant, if needed using the icon or menu item. 

 

 

 

 

 

  

Delete 
Variant 
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SETTING UP CONVERSIONS 
Click on the Insert Conversion Link menu item or icon.  The Insert Conversion Link dialog displays.  
Enter the requested information in the fields of the dialog as follows: 

• What is the address of the conversion link?  (Enter the URL of where the call-to-action 
should go, or use the Browse button.) 

• Please enter the link text.  (Enter the name of the link the consumer will click on, for example: 
Take Free Assessment.)  

• Select the target attribute for this conversion link.  (How do you want this conversion link to 
open?  Options are: _self, _blank, _top, _parent 

• _blank opens the linked document in a new window or tab. 
• _self (default) opens the linked document in the same frame where it was clicked. 
• _top opens the linked document in the full body of the window. 
• _parent opens the linked document in the parent frame.) 
• Optional: Receive email notifications when a conversion is made.  (Enter a correctly-formatted 

email address here; then click the Add button, if and where you want to receive an email each 
time a consumer clicks on the link on the website. 

• Click Insert Converion Link to save your selections. 

  

Insert 
Conversion 

Link 
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You will see a line of code now displayed under HTML Code that you’ve created with your 
selections.  The purpose of this conversion code is for tracking how many people click on the 
personalization element, or call to action (CTA). 
 

Save and publish your page via the Workflow to take your changes live. 
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WHAT ARE SNIPPETS? 
A snippet is a piece of code which is used by WCO.  The snippet is the backbone to creating a 
testing/targeting piece on your webpage.  Within a snippet you can: 

• Insert a Form. 
• Insert a Conversion Link. 
• Target your content to offer slightly different content based on information, such as the web 

visitor's location. 
• Change the text or image based off a Testing Variant. 
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HOW TO BUILD A FORM 
See the first few steps of Add Targeting Groups to Page Element for additional navigation tips.  After 
selecting your asset, in Inline mode, in the Settings > WCO control view, click the Build a Form icon 
or menu item.  
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The Build a Form edit screen displays. 
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Actions 
In the Build a Form edit screen, the familiar Actions section contains four options: 

• Insert a Form (Click this option to insert the existing form below your selected asset.) 
• Edit (Click this option to edit the existing form.  This opens the WCO Form Builder screen.  

Any revisions saved here will overwrite the data on your existing form.) 
• Delete (Click this option to delete the existing form.  A confirmation dialog will display prior to 

deletion, for you to confirm deletion.) 
• Copy (Click this option to copy the existing form.  This opens the WCO Form Builder screen, 

with existing data from the copied form populated in the fields, so that you can edit it and save 
your changes, to create a similar form, without affecting the original form.) 

 

Buttons 
• Create a New Form (This opens the WCO Form Builder screen, with no data, so that you can 

create a new form.) 
• Cancel (Click this button to cancel your changes and return to the previous screen.) 
• Next Step (Click this button to proceed to the next step in building the form.) 
•  

Tabs 
Drag any of the fields listed below onto the form and use their Edit control at the far right to configure 
contextual fields.  Information icons  provide additional information on each field of the dialog.  Below 
is the edit screen for the Date of Birth field.  After entering required data, click the Next Step button to 
configure additional options, as described in Next Step, Tabs, WCO Form Builder. 
 

• Textbox 
• Text Area 
• Dropdown List 
• Radio Buttons 
• Checkboxes 
• Hidden Field 
• US Phone 

Number 
• Intl Phone 

Number 
• US Currency 
• EU Currency 
• US Date 
• EU Date 
• Email 
• URL 
• reCAPTCHA 

• Existing 
• Accepted 

Insurance 
• Account Number 
• Address 
• Amount 
• Best Way to 

Contact Me 
• City 
• Date of Birth 
• email2 
• Facility 
• First Name 
• first_name 
• Gender 
• Hidden Field 
• Hidden Field 

• Hidden Field 
• Hidden Field 
• Hidden Field 
• Hidden Field 
• I AM A 
• Interest Area 
• last_name_baria

tric 
• Patient First 

Name 
• Patient 

Information 
• Patient Last 

Name 
• phone_number 
• Please send me 

periodic updates 
about Women's 

Health related 
topics. 

• Preferred 
Location 

• Profile Selector 
• Provider 
• Reason for Visit 
• Specialty 
• State 
• Take a FREE 

Risk 
Assessment 

• Take a FREE 
Risk 
Assessment 

• Test Snippet 
• Would you like a 

free Fitness 
Pass? 
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• Yes Add Me to 
Your Mailing List 

• Your Age: 
• Your Question 
• ZIP 
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Date Input Settings 
 

 

Placement 
Click one of these options to position your form relative to your asset’s placement on the page. 

• None  
• Top 
• Right 
• Left 

 

Next Step, Tabs, WCO Form Builder 
See the image below, to view the WCO Form Builder tabs, as described here.  Navigate to each step 
using WCO Form Builder’s intuitive features.  Simply click on each tab to configure and continue.  
Buttons are: Cancel, Previous Step, Save As, Save Form and Save and Insert Form. 

• General (In this tab screen, enter your Form Name and select Yes or No to the question, 
Transmit form via HTTPS connection?) 

• Notifications (Answer the questions in this tab screen to indicate: 
• What do you want this Form to do?  Send an Email in your selected format: XML or Text.   
• Add Recipient Email Address (Enter a valid email address and click the Add button.   
• Select the checkbox to Validate custom email recipients against above list.   
• Select your Sender Email Address from the drop-down options.  
• The Email Subject is added for you. 
• A standard message is entered for you under Email Body.  For example: Your request is being 

processed and we will be contacting you within 24 hours.  You can delete this message or 
append it with any text you want.) 
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• Rules (Answer the questions in this tab screen to indicate: 
• What is the redirect URL? * (Required field, use the document icon to select your asset URL.) 
• Select where to post data to, in addition to storing it directly in Web Content Optimizer.  Use 

the checkbox to indicate: Do not store form submission data. 
• Select a connector from the drop-down options (example: Bariatric Campaign, Cardio Risk 

Assessment, etc.) and click the Add Connector button. 
• Connectors displays any previously added connector.  Click the x icon to delete, if desired.) 
• Auto-Reply (You have the option here to Clear Auto-Reply Settings. 
• Recipient Addresses Field: * (Required field.  Select from the drop-down options:  for example 

Patient Last Name, Date of Birth, Patient First Name.) 
• Sender Email Address: * (Required field.  Select from the drop-down options.) 
• Email Subject: * (Required field.  Enter the subject of your email.) 
• Email Body: * (Required field.  Enter the content of your email.) 
• Email HTML Body: (Enter the formatted content of your email.) 
• BCC Recipients: (Add (or delete) any recipients for this field.  Use the Add button after 

entering a valid email address.) 
• Add BCC Email Address: (Add (or delete) any recipients for this field.  Use the Add button 

after entering a valid email address.) 
• Embed Code (In this tab screen under the Code tab (default) you can view the embed code of 

your form (once you have saved it) that has been created from your selections.) 
• Advanced (If you select this tab, you can use your own form with WCO, by simply adding the 

following two form attributes to your own custom form: 
• Form Action: Replace your current Form Action property with the following: (See screen.) 
• Select Variant Form ID: Add the following Hidden Form Field to your existing form: (See 

screen.) 
 
See the next page for sample screens of the above.  
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SOME TIPS FOR EDITING WCO FORMS 
Here are some tips on what to expect when editing WCO forms snippets, for admins and developers 
about editing WCO form snippets through CMS. 

Body 
• If you make an update to the Form settings itself (Redirect URLs, Autoreply, Connectors, 

etc.) it will be reflected automatically if your HTML forms use that WCOFormID. 
• If the snippet containing your form is managed by a CMS asset, then it is not recommended to 

change it directly in the WCO, it will be overridden next time the asset with the Snippet is 
republished. 

• Direct WCO Snippet changes are committed immediately, but do not update the asset's content 
automatically and are applicable only until the original page is redeployed (which will override 
your direct changes). 
 

A Note about Updating Snippet Content after Editing 
The actual HTML of the form is added to the Snippet content manually, or by selecting Insert HTML 
Code at End of Snippet when inserting a form, so: 

• If you add or remove fields from the Form you will need to update the Snippet content, even if 
you make the edits directly in the WCO Form editor.   
 

• In other words, if Snippet X uses Form A, and you edit Form A directly, by adding new fields, 
the form HTML in Snippet X won't be updated automatically, so it won't include those new 
fields. 

• If you add or remove Form fields directly through WCO the Snippet content won't be updated 
automatically. 
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REPORTING 
Access Reports via the Dashboard to see high-level results.  To drill down into specific 
variants, select either Analytics or Optimization in the Dashboard dropdown. 

• Collection 
• Content Snippets 
• Target  
• Website 
• Website Page  
• Date Range  
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TARGETING GROUPS FAQ 
Question: 
Does WCO support AND / OR logical operations? 
 
Answer: 
WCO automatically inserts an “AND” after every Targeting Rule.  This allows you to create target 
audiences that are as specific as your business requirements dictate. 
 
In cases where you need to deliver the same content to different target audiences, WCO provides a 
number of techniques to facilitate this requirement 

• Most WCO Targeting Rules support an Is Contained in and Is Not Contained in logical 
operations which allow you to define any number of values you would like to match against.   

• These values should be clearly delimited by a space, comma, or a pipe. 
 

Examples: 
• Demographic:  Geo-Location:  State is contained in ”CA”, “NY”, “TX”. 
• Form:  Field Value:  JobTitle is contained in “Marketer”, “Project Manager”, “IT Developer”. 

 
Certain ambient attributes such as Browser and Device provide checkboxes to 

select from.  You may choose one or more checkboxes with an implied OR. 

 

Examples: 
• Ambient: Browser: Chrome, Safari, IE 
• Ambient: Device: iPhone, Android, Blackberry 
•  
• Behavioral attributes natively support OR operations, due to the parent/child relationship 

between Snippets and their variants, as well as between Variants and embedded Conversion 
Links 

• Selecting the parent Snippet reports on all embedded Variant views and is essentially an OR 
between the Variants. 

• Selecting a Variant reports on all embedded conversion links and is essentially an OR between 
the Conversion Links. 
 

Examples: 
• Behavioral: Views: All Variants of a particular Snippet (essentially an OR between the 

Variants) 
• Behavioral: Conversions: All conversions of a particular Variant or Snippet (essentially an 

OR between all the Conversion Links) 
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• WCO also allows you to repeat the same Variant, as many times as you like within a Snippet.  
These identical Variants can be associated with any Targeting Group, allowing you to deliver 
the same content to different target audiences. 
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Question: 
How do I pass custom parameters or values to a WCO Snippet for targeting purposes? 
 
Answer: 
WCO recognizes any custom parameters included in the Snippet’s JavaScript call, and exposes these 
parameters for targeting purposes as Form field values. 
 
This capability is extremely useful in instances where you need to pass user profile-specific attributes to 
WCO in real-time, or asset specific parameters to the WCO Snippet. 
 
 

This data is not stored in WCO and will not impact your conversion counts. 

 
 
Let’s say for example, that we need to pass the label or the page that is delivering the WCO Snippet.  
To add this custom real-time attribute to WCO, add the following code to your Output Template. 
 
<%= asset["wco_snippet"].Replace("\" ></script>", "?asset =” + asset.Label + “\" 
></script>")%> 

 
This code will produce the following output: 
 
<script type="text/javascript" src="//snippet.omm.crownpeak.com/s/2c4764a1-b91d-

4d37-9aeb-eaabecfa2fc2?asset=Homepage" ></script> 

 
The custom attribute will now be targetable in WCO as a Form field value. 
 
 
Question: 
How can I preview my optimized experiences in the CMS? 
The CMS provides an intuitive interface directly within the authoring experience to preview your content 
variations for each of the Targeting Groups you’ve defined.  While previewing and/or editing an asset, 
the View tab > WCO Targeting opens a WCO panel which lists all of the Targeting Groups used on 
the page.  Clicking on any Profile (which is the same as a Targeting Group), will result in re-rending 
the page in real-time, reflecting what the targeted audience would see. 
 
  

http://asset.label/
http://snippet.omm.crownpeak.com/s/2c4764a1-b91d-4d37-9aeb-eaabecfa2fc2
http://snippet.omm.crownpeak.com/s/2c4764a1-b91d-4d37-9aeb-eaabecfa2fc2
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WCO TERMINOLOGY 
• Browser Cookie (Information and behavior stored in a user's web browser that can later be 

used to personalize digital experiences.) 
• Browser Session (Information about a web visitor’s session (i.e., location, device type, time) 

based on IP address.) 
• Business Logic (Using targeting rules to identify web visitors.  When the rules are triggered, 

personalized content is then displayed.) 
• Collection (Collections are a group of Snippets.  Group Snippets for targeting purposes, or to 

funnel a web visitor to a specific item, such as a white paper.) 
• Persona (A semi-fictional representation of a type of buyer or customer that helps companies 

better understand and communicate to their audiences.  Personas are useful in crafting 
marketing messages, campaigns and digital marketing experiences tailored to a specific 
audience segment.) 

• Snippet (A Snippet is a piece of code which is used by WCO.  The Snippet is the backbone to 
creating a testing/targeting piece on your webpage.  Within a Snippet you can: 

• Insert a Form, 
• Insert a Conversion Link, 
• Target your content to offer slightly different content based on information, such as the web 

visitor's location, 
• Change the text or image based off a Testing Variant.) 
• Targeting Group (Targeting Groups describe which visitors can see your content, based on a 

set of Targeting Rules or conditions that you specify and whether or not they match these 
conditions.) 

• Targeting Rules (Targeting Rules fall into the following categories: 
• Ambient (Data or attributes that are readily available for all visitors including anonymous 

visitors) 
• Source (This data describes how the visitor arrived at your site.) 
• Demographic (This data shows what is known about the user from their web connection.) 
• Behavioral (This data describes the visitor’s interactions and engagement level on your site by 

tracking page views, and conversions.) 
• Form (This data is collected from any form on your site.) 
• Integration (This data is retrieved from your backend system, or any 3rd party system via 

WCO’s connectors.)) 
• Variant (Each Variant defines a test or target associated with a given Snippet.  After creating a 

Snippet, authors select the variant type, whether testing or targeting.  Multiple variants of the 
same type can be added to a Snippet.  Content Variant refers to a specific set of text or 
images that are displayed for each Target Group.) 
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GENERAL INFORMATION ABOUT COOKIES STORED BY WCO 
The following contains a listing and general information about cookies stored by WCO. 

• Cookie Name: a 
• Cookie Domain: snippet.omm.crownpeak.com 
• The a cookie keeps track of IP address recorded for this client's OmmAnonId. 
• Cookie Name: OmmAnonId 
• Cookie Domain: .omm.crownpeak.com 
• The OmmAnonId is a GUID used as the key to the user’s identity 
• Cookie Name: ASP.NET_SessionId 
• Cookie Domain: snippet.omm.crownpeak.com 
• The ASP.NET_SessionId is the session cookie used by WCO. 
• Cookie Name: OmmValues80112474-504a-4bcb-9f86-e212c0b0039a 
• Cookie Domain: .omm.crownpeak.com 
• The OmmValues(key) is a unique identifier to the specific Snippet to which the cookie is 

related. 

 

  

http://snippet.omm.crownpeak.com/
http://omm.crownpeak.com/
http://asp.net_sessionid/
http://snippet.omm.crownpeak.com/
http://omm.crownpeak.com/
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WHAT IS DQM? 
Digital Quality Management (DQM) is a platform that provides reporting, by a library of continually 
updated digital technical and legal specification standards on all issues detected on your site, whether 
your site is Live, in development or in Staging. 

DQM Capabilities 
CMS provides the only automated digital governance solution that integrates directly with your 
healthcare web Content Management Solution (CMS), assuring a high quality, consistent customer 
experience across every page and asset of your site.  
 
With DQM, you can: 

• View a consolidated analysis of error classifications on all your web pages from a central 
dashboard, with links to make corrections on the fly. 

• Ensure Web Content Guidelines (WCAG) 1.0 and 2.0 and Section 508 accessibility standards-
compliant content.  For more information see Accessibility in DQM. 

• Easily correct details such as broken links, orphaned pages, readability and misspellings (in 
multiple languages), which can have a strong impact on public perception. 

• Quickly target and resolve Search Engine Optimization (SEO) issues, which can affect how 
easily your pages are found, and ultimately conversion rates, using included best practices and 
rule customization. 

• Quickly target and resolve URL structure and code issues, as well as privacy and cookie policy 
inclusion and mobile device optimization. 

• Automatically monitor your digital properties 24/7, by crawling your sites, regardless of channel, 
with configurable frequency. 

• Protect your brand with reporting for brand violations, such as usage of an incorrect logo or 
color palette, incorrect font, punctuation or image assets, consistent use of terminology, 
language clarity, use of prohibited terms, etc., across all digital experiences. 

• Detect and track key digital assets across all of your sites, making it easy to review and replace 
files. 
 

Take your web presence to the next level by proactively detecting and resolving 
all major digital presence issues. 

  



 
 
 

 

The contents of this document are confidential and proprietary to Healthgrades and are meant for private circulation only.  No part of this document may be 
disclosed, reproduced, transmitted or copied in any form or by any means without the express written permission of Healthgrades  

©2019 HEALTHGRADES.  All rights reserved. 

 

218 

ACCESSIBILITY IN DQM, DEFINITIONS 
Providing a good user experience is crucial for the success of any website.  For users with limited 
abilities, browsing a website can be difficult.  Improving your website so that it is easy to navigate for all 
users increases your range of potential customers and improves your SEO11.  
 

What is WCAG? 
The word Wide Web Consortium (W3C) has published Web Content Accessibility Guidelines (WCAG) 
in order to help businesses make their websites accessible for users with disabilities, or users with 
limited devices (such as mobile phone and tablets).  The latest guidelines released are the WCAG 2.0 
on which DQM bases their checkpoints. 
  

What are Accessibility Levels A, AA and AAA? 
These levels indicate the degree of compliance.  While level A covers the basic needs of a website to 
be easily accessible, level AA and AAA are based on higher standards.  Most businesses aim to 
achieve a level of at least AA.  
 

What is a Benchmarking Score? 
The Benchmarking Score will give you an indication of how compliant your website is to WCAG 
standards.  The score ranks form 1 (low) to 10 (high).  However, please note that the level AA and AAA 
contain checkpoints that cannot be tested by scanning your website.  For those, you will need to check 
your pages manually.  An example for a manual checkpoint would be, whether your website has 
supporting audio or whether the colors used in the design are easy to see for a person with impaired 
vision.  
 

Why Is One Checkpoint Flagged for A Lot of My Pages? 
There are a number of reasons why one checkpoint exists on many pages.  The first reason could be 
that the flagged item is a part of your website’s template and is shown incorrectly on every page.  In this 
case, fixing the issue in one place will resolve many of your checkpoints at once.  Another possible 
reason could be images without alt tags.   
 

What are Alt Tags and Why are They Important? 
The alt tag is contained within the image tag <img>.  Although alt and title are commonly referred to 
as alt tag or alt text and title tag, they are not actually tags.  Alt and title are attributes of the HTML 
image <img> tag. 
 
A complete HTML image alt tag is written as follows:   
<img src=“my_image.png” alt=“my image description” title=“image tooltip”>The alt text (alt=“) should 
describe the image and its purpose. 

                                                
11 The object of Search Engine Optimization (SEO) is increasing targeted internet traffic and ultimately your 

Return on Investment (ROI).  This is best achieved by improving your search rankings, by optimizing your 
pages, so that search engines can find them. 
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Images without alt tags are highlighted as checkpoints for a few important reasons.  In fact, you cannot 
save changes to your page without an alt tag for all of your images. 
 
Alt tags are important for 508 compliance screen readers, such as Job Access with Speech (JAWS), 
which generates audial speech and Braille output for users with vision impairment.  
 
Images whose intent is strictly design-based, that are in the HTML of your page rather than in the 
preferred CSS, should have an empty alt tag attribute, for example: <img src="my_image.png" alt="">, 
so that screen readers will skip over that image. 
 
Alt tags are also important for SEO.  The title attribute is displayed as a tooltip when a site visitor 
hovers over the image.  It can even be used as an additional call-to-action (CTA), for example: “This 
service is now offered at a reduced price!” 
 
Alt tags with a title attribute also provide a text alternative for search engine crawlers and robots such 
as Googlebot and can positively impact search engine rankings.  Images with correctly-formatted alt 
tag attribute titles influence both indexing and ranking of the page.  They also enrich the user 
experience for those using browsers that cannot process images. 
 
Another reason to use the title attribute: Firefox, Chrome, and other HTML W3C standard-compliant 
browsers won’t display hover text for images if the title attribute is not present or is empty. 
 

Other Common Compliance Errors 
A warning for meaningless phrases such as "Click here." used for link text may seem trivial, but there is 
an important reason for this compliance flag.  The intent is that link phrases should make sense when 
read out of context, for screen readers.  
 
JAWS has an option to display a list of links on the page to the user.  Along with this, JAWS has an 
option to list all headings on a page, and is a popular way for visually-impaired users to orient 
themselves and more quickly discover what they're looking for in a document. 
 

The Priority Flag 
Issues with priorities are flagged as displayed below. 

 
Non-compliance can be a costly mistake for websites that do not provide 

accessibility to all. 
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Where Can I Find Help Understanding a Checkpoint? 
At the end of each checkpoint is an information Why? icon.  Hover over this icon for a quick view of 
additional information regarding why resolution of this checkpoint is important.  Click on the issue itself, 
and the Source tab to directly access the problem area in the code. 
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HOW DOES THE DQM PLATFORM WORK? 
The DQM platform works on three levels.  The DQM platform routinely crawls your websites and 
monitors for any violations based on the rules and priorities in place, without affecting performance.  
Crawl frequency can be adjusted to requirements.  Priority issues are flagged for immediate attention. 
 
This information is analyzed, organized and presented in an intuitive and comprehensive online 
dashboard, known as the Website Dashboard, to ensure quality and compliance for your live web 
presence.  
 
Once installed, the DQM Page Checker tab validates any selected website with one click, for these 
same brand, code, compliance, SEO and compliance risks, using the rules and priorities you have set.  
 
As you are building your site's pages, the DQM report accordion validates against all of these 
configured rules in place, so that you can address any issues prior to publishing.  
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ACCESSING THE DQM PANEL 
Let's start at the ground level, the authoring environment for your website.  To analyze and correct an 
individual page in your site, you can use the dockable Digital Quality Management panel.  With your 
page open in Inline view, you can see problem areas highlighted in yellow.  Open the DQM panel by 
clicking View > Digital Quality Management. 
 
The pie chart shows your Pass/Fail statistics visually and in percentages.  The blue area and 
coordinating blue bullets below it, indicate compliant (Pass) items.  The red chart percentage and 
bullets are your problem (Fail) areas.  Use the drop-down menu to view Pass/Fail information by 
category.   

Categories are: All Topics, Accessibility, Brand, Legal, SEO and Usability.  The pie chart and bullets 
update accordingly.  Errors and their solutions are defined in readable language with View More links 
for additional information, with Web Content Guidelines (WCAG) 2.0 section references.  
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ACCESSING THE DQM WEBSITE DASHBOARD FROM THE CMS APPLICATION 
You can view DQM information from a couple of places in the CMS application.  To quickly overview 
problem pages in your site and address them from one source, use the DQM Website Dashboard. 

• To access the DQM Website Dashboard, click the DQM icon from the left-hand panel.  This is 
a link to the dashboard view.  Log in with the username and password provided to you by your 
administrator. 

•  
  

Problem 
Areas 

Problem 
Areas 
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INSTALLING THE DQM PAGE CHECKER IN CHROME 
When you receive your DQM user account and log in to the platform, you will notice an orange button 
at the top-center of the Website Dashboard Overview page.  
 
If you are in Chrome, first be sure the bookmarks bar is displaying (Ctrl + Shift + B).  Click the Install 
DQM Page Checker button. 

 
The instruction screen displays.  Drag the orange box to the browser bookmarks bar, as shown below, 
in Chrome.  You will see a "+" sign in a white box when you are over the correct area of the bar.  
Release the mouse button.  The install is instantaneous.  Click the Got it! button to close the instruction 
screen. 

 
Once you have installed the DQM Page Checker, your browser view should have a bookmark, as 
shown below. 
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INSTALLING PAGE CHECKER IN IE11 
Installing the DQM Page Checker in IE11 involves the same steps, with one exception. 
 
You must first display the IE11 Favorites bar, by if you have not already, by right-clicking to the right of 
the address bar and selecting Favorites Bar.  This will provide space under the address bar for 
bookmarks.   
 
Continue, as above using the Install DQM Page Checker button.  

 
This is the DQM Page Checker installed in IE11.  Go to a site and click it for an instant evaluation, 
based on the currently configured rules in place. 
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USING THE DQM PAGE CHECKER 
You can now use the DQM Page Checker on any site.  Go to any site, then click the DQM Page 
Checker bookmark we just created.  You can view the issues on that site listed, and highlighted as 
demonstrated on our demo site, for whichever issue you click. 

 
You can check any site to compare how your site rates against competitors, without having access to 
the CMS. 
 

Assists your site editors in both pre and post publication mode. 

 
 
 
VIEWING A SINGLE PAGE IN THE DQM DASHBOARD FROM THE CMS AUTHORING 
ENVIRONMENT 
You can also open a single page in the DQM Website Dashboard from within the CMS 
application.  From an open page, whether in Preview , Inline or Form view, go to the Last 
Published Link icon and select an option.  For our demonstration, we chose Live.  For 
an example, see Where Can I Find Help Understanding a Checkpoint? under 
Accessibility in DQM, Definitions. 
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ANOTHER POINT OF VIEW, THE WEBSITE DASHBOARD OVERVIEW 
The online DQM Website Dashboard is also known as The Analyzer.  There are four tabs: Overview, 
Issues (with options: Priority issues, All issues, Issues by topic, Worst pages), Spelling, (with options: 
Misspellings by word, Misspellings by page) Inventory and Accessibility.  You can tackle the largest 
issues first, by selecting Worst pages from the Issues tab menu. 

 



 
 
 

 

The contents of this document are confidential and proprietary to Healthgrades and are meant for private circulation only.  No part of this document may be 
disclosed, reproduced, transmitted or copied in any form or by any means without the express written permission of Healthgrades  

©2019 HEALTHGRADES.  All rights reserved. 

 

229 

 

Much of your time will be spent within Issues.  Issues can be designated as prioritized.  Standards can 
range from content presentation, links and images to URL structure and cookies.  You can view the full 
list of Issues, as shown. 
 
Working with these tools empowers your content management team, by reducing the chance of 
compliance issues that can be created, so they can focus on creating conversion-centric content for 
your organization. 
 
You can have as many websites in the platform as desired and administer each one on a separate 
dashboard. 
 
The following table lists all the rules from this page. 
 

Category Rule 

Content All pages should contain headings. 

Content All pages should contain an <h1> heading. 

Content Do not use underlining to highlight text. 

Content Large blocks of content should be broken up using subheadings. 

Content Do not artificially create bullet lists. 

Content Do not use bold <b> tags to emphasize text. 

Content Do not use italic <i> tags to emphasize text. 

Content Do not have multiple headings with identical text. 

Content All data tables should correctly define header rows and column 
headers. 

Content Use correctly nested headings. 

Content Do not create blinking text. 

Content Do not use justified text. 

Content Paragraphs should be no longer than 100 words in length. 

Content H1 Headings should be no longer than 10 words in length. 

Content H2 Headings should be no longer than 10 words in length. 

Content H3 Headings should be no longer than 10 words in length. 

Content Do not use “Submit" as button text. 
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Category Rule 

Content Do not overuse uppercase formatting. 

Links Do not use meaningless phrases such as "click here" or "more" 
as entire link text. 

Links Do not have links without content. 

Links Indicate when a link will open in a new window. 

Links If an image is the only content in a link it must have "alt" text. 

Links Combine adjacent links together if they have the same 
destination. 

Links Broken external links. 

Links Broken internal links. 

Links Broken images. 

Links Do not make links too long. 

Images All images should specify an "alt" attribute. 

Images Provide "alt" text for each clickable hotspot within an image map 
(not for mobile). 

Images Image "alt" attribute should not be empty, except for on known 
"decorative" images. 

Images Image "alt" text should contain more than one word. 

Images Graphical form buttons should have "alt" text. 

Images Do not provide text alternatives for decorative images. 

Images Images between 50 - 200 KB. 

Images Images between 200 - 500 KB. 

Images Do not use unsuitable image file formats. 

Images Images larger than 500 KB. 

Rich Media PDFs should be tagged for accessibility. 

Rich Media PDFs should have a meaningful title specified. 

Rich Media EMBED tags must have an associated NOEMBED tag. 

Rich Media Specify the file type when linking to non-HTML files. 
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Category Rule 

Rich Media Include information about document size within or next to the 
link. 

Title and 
Metadata 

Does the page contain a title tag? 

Title and 
Metadata 

Is the title tag populated? 

Title and 
Metadata 

Does the title tag contain more than one word? 

Title and 
Metadata 

Pages should specify the natural language of a document. 

Title and 
Metadata 

Do not use meta refresh with a time limit. 

Title and 
Metadata 

Pages should contain metadata description. 

Title and 
Metadata 

Limit <title> tags to 60 characters or less. 

Title and 
Metadata 

The title tag should contain the company name. 

Title and 
Metadata 

Do not use multiple title tags. 

Template Copyright date should be the current year. 

Writing Style Do not use white space characters to control spacing within a 
word. 

Brand Always capitalize the company name correctly. 

Brand Always spell the company name correctly. 

URL Structure 
and Code 

Do not use deprecated tags or attributes. 

URL Structure 
and Code 

Use relative font measurements. 

URL Structure 
and Code 

Use linked style sheets to control layout and presentation. 

URL Structure 
and Code 

If using frames (or iframes) make sure they are titled. 
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Category Rule 

URL Structure 
and Code 

ID values must be unique. 

URL Structure 
and Code 

Do not use "onmouseout" without "onblur". 

URL Structure 
and Code 

Do not use "onmouseup" without "onkeyup". 

URL Structure 
and Code 

Do not use "onmouseover" without "onfocus". 

URL Structure 
and Code 

Do not use "onmousedown" without "onkeydown". 

URL Structure 
and Code 

Table summaries must not duplicate table captions. 

URL Structure 
and Code 

Do not use scripting to remove focus when focus is received. 

URL Structure 
and Code 

Do not use pre-ticked boxes in forms. 

URL Structure 
and Code 

Do not use inline styles. 

URL Structure 
and Code 

Deliver all code as UTF-8. 

URL Structure 
and Code 

Do not use special characters within file or directory names 
(URLs). 

Privacy and 
Cookies 

All pages should contain a privacy link. 

Privacy and 
Cookies 

All pages should contain a link to cookies policy. 

Privacy and 
Cookies 

Do not use Flash. 

Privacy and 
Cookies 

Do not use graphics for spacing. 

Privacy and 
Cookies 

Do not use onmouse and onkey triggers within your scripting. 

Privacy and 
Cookies 

Set the viewport on pages. 
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Category Rule 

Privacy and 
Cookies 

Do not disable or suppress the ability to zoom. 

Mobile Do not use nested tables. 

Mobile All pages should have a link to the desktop version of the site. 

Mobile Do not use the title attribute unless on a form input. 
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Resolving an Issue by Topic in the Website Dashboard 
For our demonstration of resolving issues in the Website Dashboard, we will look at Issues > Issues 
by Topic, Links.  We clicked on the Links topic, Do Not Have Links Without Content.  The right side 
of the page populates with the pages affected and statistics.  
 
Clicking on a link displays the actual live page, where the link is broken, with the issue area highlighted 
in the Source code. 
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Warning 



 
 
 

 

The contents of this document are confidential and proprietary to Healthgrades and are meant for private circulation only.  No part of this document may be 
disclosed, reproduced, transmitted or copied in any form or by any means without the express written permission of Healthgrades  

©2019 HEALTHGRADES.  All rights reserved. 

 

236 

Click the Information icon Ⓘ to view why resolving links without content is important.  The text states: 

Although these empty links will not be visible on the page, they will be apparent to some users and 
cause confusion.  For example, some browsers will allow tabbing to empty links and assistive 
technology will also announce the presence of a link.  
 
 

In addition, links without content  will be picked up by search engines, which 
may interpret them as spam and penalise the website. 
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Misspellings by Word 
Check Misspellings by Word under the Spelling tab of the Website Dashboard application.  The 
misspelled word list for your entire selected site loads in the viewer area.  Click the misspelled word 
and the pages where it appears load in the right panel.  Click the page link and as we demonstrated 
above, you can click the Source tab and go directly to the misspelled word in the code without 
scrolling, or you can view the highlighted text in the Browser tab view.   
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In the Browser tab view, once the page launches, you can use the standard <Ctrl+F> keyboard 
command to search the misspelled word on the page. 

Click on the Misspellings Highlighted button at the top right of the page to display information  
 
Crownpeak DQM is highlighting misspellings on this page. 
If you can't see them, it is probably because they are: 

• within a layer or menu that needs to be clicked on to see 
• within code that has been commented out 
• only visible to users without stylesheets or Flash 
• within an element not designed to appear on the page 

 
Try selecting the Source (code) view to see them all. 

 
 

; 
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Using the search function 
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Taking Inventory 
The Inventory tab, as its name implies, lists all the assets of your website by category.  Each asset 
type, such as Images, displays the count of that type of asset and is an active link that provides the 
pages of occurrence and their links.   

File Assets are listed by: Images, Acrobat (Pdf) Documents, Word (Doc) Documents, Excel (xls) 
Documents, PowerPoint (ppt) Documents, Zip Files, CSS Files, All Flash Files, WMV Files, Flv Files, 
Mp3 Files, Mp4 Files, JavaScript Files. 
 
Content Assets are listed by: All emails used, Title tag frequency, Links to external websites, All data 
collection forms,  
 
Metadata is listed by: Pages without metadata keywords, Pages without metadata description,  

Cookies are listed by: Pages using Facebook widgets that set cookies, Pages using Twitter widgets 

that set cookies, JavaScript files setting cookies, Persistent cookies by type, Pages using HTML5 local 
storage code, Pages using HTML5 session storage code. 
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The Accessibility Tab 
The Accessibility tab is a rich source for WCAG compliance information.  From this page you can 
analyze and correct all issues that might limit accessibility to your web content.  Your chosen target 
level is displayed at the top right of the screen.  Here, it displays as: Your target is WCAG Level AA 
compliance. 

You can choose the target levels to display here, by checking one or all of the following:  Level A, 
Level AA or Level AAA.  You can also toggle Hide Success Criterion without automated tests.  
The top-left panel displays the number of issues for each level and their benchmarking score, with a 
ranking from 1-10.  Each link on the right takes you to the specific W3 Consortium checkpoint.  As with 
all other checkpoint pages, drill down from the topics listed on the left to see additional detail and link to 
affected pages.  Not shown below, the checkmark icon indicates no issues were found, but manual 
testing is still required. 
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Target level 

Benchmark score 

Display Levels 

Average Compliance 

Issues found for this success criterion.  
Expand for additional details. 

This Success Criterion must be 
manually tested. 
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HOW DOES DQM CHECK FOR BROKEN LINKS? 
When DQM scans your site, it records every single link it encounters.  Each of these links is tested to 
check whether it should be flagged as broken, using HTTP response codes returned from the server. 
 
The table below details how DQM handles HTTP response codes, by type. 
 

HTTP 
Response 
Code 

Is marked 
as a broken 
link? 

What the code indicates 

400 - 499 Yes Codes that fall within this range indicate an error with the 
page.  Common statuses such as 404 fall within this range. 

401 No This code indicates that authentication is needed to reach 
the page that has not been provided.  The classification is 
"unauthorized". 

403 No This code indicates that the server understood the request, 
but has refused to fulfil it.  The classification is "forbidden". 

407 No This code is similar to the 401 classification, but indicates 
that the DQM should authenticate itself with the proxy.  The 
classification is "proxy authentication required". 

500 - 599 No This code indicates that the server could not service the 
request made by the DQM.  This can occur sporadically when 
the server gets busy. 

300 - 399 Link check 
is repeated 
on 
redirected 
URL 

This code indicates that the server is redirecting the DQM to 
another page.  The DQM link checks the new URL also.  To 
prevent these redirect loops, a rule marks a link visited more 
than seven times sequentially as broken. 

200 - 299 No Codes that fall within this range indicate a successful 
response.  These site pages are also checked to see if the 
page in question is an error page. 

 
 

These default responses can be modified if required. Contact your 
implementation represnetative, if you'd like to discuss this. 
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Other Reasons Links Can Be Marked as Broken 
Along with the HTTP server codes above, a link will also be flagged as broken if an error occurs at any 
part of the page's download process.  Reasons for such errors include: 

• The Host part of the URL is not valid 
• An issue with downloading the page via SSL 
• An attempt to connect or read times out.  Connects time out at 1 minute, reads time out at 2 

minutes 
• Illegal characters in the URL 
• Illegal characters in the URL that DQM is redirected to 
• The response code indicates a redirect, but gives no URL for the redirect 

 

Excluding Links from the Link-Checking Process 
DQM can ignore URLs, or parts of URLs that do not need to be checked.  For example: login pages.  
Contact your implementation representative if you would like to add some broken link exclusions to 
your DQM configuration.  For more detail, please see Reducing Errors Reported in Website DQM 
Reports. 
 
  



 
 
 

 

The contents of this document are confidential and proprietary to Healthgrades and are meant for private circulation only.  No part of this document may be 
disclosed, reproduced, transmitted or copied in any form or by any means without the express written permission of Healthgrades  

©2019 HEALTHGRADES.  All rights reserved. 

 

245 

REDUCING ERRORS REPORTED IN WEBSITE DQM REPORTS 
Our goal is to make Website DQM reports as meaningful and concise as possible by reducing 
unnecessary or unwanted errors.  Here are some areas that can inflate the error count: 

• Third Party code that we do not own or author 
• Client-authored documents 
• Page source content 
•  

Broken links 
CMS scans the content of *.pdf and *.doc files for broken links.  Broken links from legacy documents 
included with broken links found on pages can also inflate error count.  CMS can exclude certain URLs 
or parts of URLs, reducing the number of reported errors for broken links. 
 

The list of full or partial URLs must be provided and placed on an exclusion list.  We can also request 
that URLs ending with designated extensions be ignored, such as:  .pdf, doc, ppt or others.  Once 
provided, DQM will skip scanning for broken links inside these types of client documents. 
 
Alternately, the 2.10 PDFs – Documents with broken links checkpoint can be suppressed completely 
on client request. 

 
Errors can be sometimes be flagged in more than one checkpoint.  Errors flagged by the 2.10 
checkpoint can show up in both 2.1 Broken external links and 2.2 Broken internal links. 
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Cautionary Points 
When requesting exclusions by full or partial URL, consider if there are other pages or assets that 
share the full or partial URL with the *.pdf files.  If there are other assets that would be affected by an 
exclusion by URL or partial URL, then be sure to specify the file extension in the exclusion.  You can 
also describe the end result you are hoping to achieve to your implementation representative, who can 
give you suggestions on how best to exclude specific files. 
 

ADAM Content 
Adding American Accreditation HealthCare Commission (ADAM HRA) content will cause error counts 
in most checkpoints to escalate.  This content contains many images and image maps without alt 
attributes.  There are also errors that get flagged for Rich Media checkpoints. 
 
As we do not have any control over the ADAM code, a request to exclude all ADAM content from being 
scanned will be needed.  ADAM content is onion like; it is not a single product but a collection of 
product IDs, therefore ADAM exclusions are defined by individual product IDs. 
 
Once ADAM has been successfully excluded from the Website DQM scan, it can again show up if a 
client adds a new or different product ID.  When clients update or add new ADAM products to their site, 
we need to request a re-scan and provide notification of the new product IDs. 
 
ADAM exclusions can require some “fine tuning”.  Following, is a helpful chart and some tips that 
should be helpful. 
 
Indicate the exact product ID (productId) used by the client. 
 

PRODUCT NAME 
INCLUDED WITH ADAM SE PRODUCTID=127 

 PRODUCTID 

ADAM Health Illustrated Encyclopedia Multimedia productId=117 

Thomson Drug Notes productId=45 

ADAM Wellness Tools productId=20 

ADAM Health Navigator productId=65 

ADAM Pregnancy Health Center productId=14 

ADAM Complementary and Alternative Medicine productId=33 

ADAM Health Illustrated Encyclopedia Multimedia (Catholic 
filtered) 

productId=5117 

Thomson Drug Notes (Catholic filtered) productId=5045 

ADAM Wellness Tools (Catholic filtered) productId=5020 

ADAM Health Navigator (Catholic filtered) productId=5065 
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PRODUCT NAME 
INCLUDED WITH ADAM SE PRODUCTID=127 

 PRODUCTID 

ADAM Pregnancy Health Center (Catholic filtered) productId=5014 

ADAM Complementary and Alternative Medicine (Catholic 
filtered) 

productId=5107 

MyCheckUps productId=43 

 

Tips 
Use the word “article” in the exclusion “rule”; for example, request exclusion of all URLs that have the 
following string: “article?productId=43”, “article?productId=65”, “productId=5107”, etc.   
 
You cannot refer only to “productId=127”; you must list each productId included in SmartEngage to 
successfully exclude ADAM content. 
 
Clients might be using older ADAM products or contract directly with ADAM for their 3rd party content.  
Some URLs for article pages might be using ADAM2004_ or other similar URL parameters.  ADAM 
offers mixed content, so it is a good idea to also exclude the following: 

• .adam.com 
• www.adam.com 
• http://adam.com 
• https://ssl.adam.com 

 
The following are examples of other exclusions asked for on behalf of our clients.  They are specific to 
those clients, but will give you an idea of how to request exclusions. 
You should exclude code found in HTML comments.  At least one client had commented out code in 
the page source of at least 90% of the pages.  The commented-out code contained <img> tags without 
alt attributes.  As the code was throwing errors, the following exclusion was asked for: 

 
Please exclude any <img> tag with or without alt attributes found inside a comment tag. 
The comment tags being used are <!--- --->, but also we should exclude for <!-- --> comments as well. 
Example, there are places in the page source similar to the following: 
 

<!---<div class="cta-overlay"><img class="img-responsive" 

src="/assets/images/banners/fpo.jpg" /> 

<div class="overlay"> 

<h4>Book Your Yearly Physical Online</h4> 

<p><a class="btn btn-outline" href="/schedule-an-appointment-

online/default.aspx">Request Appointment</a></p> 

</div> 
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</div> 

</div> 

</div> 

</div>---> 

 

 

Images from cross-site origin or external sources 
One client was using forms which included buttons and images from an external source.  You can ask 
to exclude scanning image tags contain specific URLs; for example:  

 
Please exclude any <img> where the src is https://bbox.blackbaudhosting.com/webforms/images/. 
Since the image is coming from a source over which we have no control to change, we should exclude 
this from being reported as an error. 
 
Example, the following is found in the page source: 
 

<img 

src="https://bbox.blackbaudhosting.com/webforms/images/ajax_loader_border2.gif" 

alt="" style="vertical-align: middle;"/> 

 

Default Images Which are Used for Display or Decoration Only 
You can exclude certain image tags from the scan, but these images must have an alt attribute in the 
<img> tag.  They must be able to pass the “3.1 All images should specify an “alt” attribute” checkpoint. 
If the decorative or presentation role image passes the 3.1 checkpoint, but is flagged by the “3.3 Image 
alt attribute should not be empty, except for on known, decorative images” checkpoint, you can exclude 
it from the scan by asking for the following: 

 
Any <img> tag where the image file name has "_default_" 
In the class ih-blog ih-blog-detail is see images that are decorative. 
 
Example, the following can be found in page source: 
 
<div class="ih-blog ih-blog-detail"> 
<img src="/assets/images/news/news_default_front_hospital.jpg" alt="" class="img-responsive" 
itemprop="image"/> 

 
But, remember: the <img> tag must include an alt attribute (alt=””); this tells accessibility technology to 
ignore and not attempt to read the alt as it is NULL.   The criteria for an image to be considered 
“decorative” are: 

• the image is not used as a link 
• the image is decorative; if it was removed, no information would be lost 
• the <img> tag includes an empty alt attribute (alt=””) 
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Turning off or Suppressing Checkpoints 
Some clients have requested to turn off or suppress certain checkpoints.  Before turning off or 
suppressing a checkpoint, consider the following: 

• Is the checkpoint evaluating a key accessibility level?  If it is turned off will the website not reach 
the accessibility goal the client wants to achieve? 

• Is the checkpoint being turned off only to cut down on the error count?  If so, the error will still be 
present and it might not be noticed.  Also disabling one checkpoint doesn’t mean the error will 
disappear, it might show up in another checkpoint. 
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OTHER FREQUENTLY ASKED QUESTIONS (FAQ) 
How does the crawl of the site affect performance?  
The running site crawler is equivalent to a one-person page hit. 
 
How many checkpoint issues come with the platform? 
There are 120 standard checkpoint issues.  You can customize these standards for both code and 
content, including by country.  You write the logic.  There are also complex checkpoints in place for 
twitter tags and attributes, client IDs, etc. 
 
What browsers does the DQM Platform support? 
The DQM Platform supports the following browsers:  

• Internet Explorer 11.0 
• Latest version of Firefox 
• Latest version of Chrome 
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MANAGING YOUR SEO 
In this section, we will  explain what SEO is, why it is important and how to target and resolve SEO 
issues. 
 

Defining SEO 
The object of Search Engine Optimization (SEO) is increasing targeted internet traffic and ultimately 
your ROI. This is best achieved by improving your search rankings, by optimizing your pages, so that 
search engines can find them. 
 

Who Manages the SEO? 
Managing the SEO typically falls to the Power User, who also creates or modifies Page and Content 
App layouts, page content and site-level settings such as Site Configuration. 
 

SEO Keywords 
There are many SEO strategies site managers use to encourage search engines to rank their pages 
over competitors, including Pay Per Click (PPC) advertising campaigns.  Organic12 ranking can assist 
your website getting placed in the top 10 search results for your targeted keywords.  
 
SEO keywords are actually phrases that describe your services. These keywords are placed in the 
<TITLE> as well as <BODY> tags of your page, so that search engines can find them.  
 
Strategically selected, unique two to three-word keywords have the best chance of higher ranking in 
search results and return the highest quality traffic. You want a keyword phrase that is specific enough 
to direct your targeted audience (those most likely to purchase services) to your site, but that contains 
words visitors who are searching for your service are most likely to use.  
 

Think of how you search, not how you advertise. 

 
  

                                                
12 Organic search results are returned due to their relevance to search terms, whereas non-organic search results 

can include Pay-Per-Click advertising. 
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Keyword Syntax 
One example of keyword syntax: (single or multi-words that describe) adjective service location, or 
location adjective service 

• Enter the username (typically your email address) that is associated with your account. An email 
will be sent to 

• Adjective describing your service (narrows the search, results in a higher ranking when that 
term is used in a search, in combination with the remainder of the phrase),  

• Your Service (broadens the search, results in a lower ranking when used alone),  
• Your Location (narrows the search, results in a higher ranking when that term is used in a 

search, in combination with the remainder of the phrase). 
Example keywords:  

• laser back surgery birmingham al 
• birmingham al laser back surgery 

 
 

Enter the CODX V3 DQM 
Digital Quality Management (DQM) is a cutting edge, cloud-based platform that provides up-to-the-
minute reporting, by a library of continually updated digital, technical and legal specification standards 
on all issues detected on your site, whether it is Live, in Development or in Staging. 
 
CODX V3 DQM provides the only automated digital governance solution that integrates directly with 
your healthcare web Content Management Solution (CMS), assuring a high quality, consistent 
customer experience across every page and asset of your site. 
 
With DQM, you can quickly target and resolve SEO issues, which can affect how easily your pages are 
found, and ultimately conversion rates, using included best practices and rule customization. 
 
Other DQM Capabilities 

• View a consolidated analysis of error classifications on all your web pages from a central 
dashboard, with links to make corrections on the fly. 

• Ensure Web Content Guidelines (WCAG) 1.0 and 2.0 and Section 508 accessibility standards-
compliant content. 

• Easily correct details such as broken links, orphaned pages, readability and multi-lingual 
misspellings, which can have a strong impact on public perception. 

• Quickly target and resolve URL structure and code issues, as well as privacy and cookie policy 
inclusion and mobile device optimization. 

• Automatically monitor your digital properties 24/7, by crawling your sites, regardless of channel, 
with configurable frequency. 

• Protect your brand with reporting for brand violations such as usage of correct logo, color 
palette, font, punctuation, image assets, consistent use of terminology, language clarity, 
prohibited terms, etc., across all digital experiences. 
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• Detect and track key digital assets across all of your sites, making it easy to review and replace 
files. 

Browser Support 
CODX DQM supports the following browsers:  

• Internet Explorer 11.0 
• Latest version of Firefox  
• Latest version of Chrome 

 

Logging In to the DQM 
Access the new DQM by using a link. http://dqm.crownpeak.com/ 
 

 
INSTALLING THE DQM PAGE CHECKER 
When you receive your login for your CMS Crownpeak DQM user account and log in to the platform, 
you will notice an orange button at the top-center of the Website Dashboard Overview page. 
Installation is simple. Click the Install DQM Page Checker button. 

If IE is your current browser, make sure your Favorites bar is displaying. In Chrome or Firefox, enable 
Bookmarks.  
 

Note:  
If you are on Windows 10, using Microsoft Edge and wish to use IE11, simply 

switch to IE as your default browser. 

 

http://dqm.crownpeak.com/
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The instruction screen displays. Drag the orange box to the browser Favorites or Bookmarks bar. You 
will see an arrow in a white box when you are over the correct area of the bar. Release the mouse 
button. The install is instantaneous. Click the Got It! button to close the instruction screen. 

Using the DQM Page Checker 
Once the DQM Page Checker is installed, you can go to any site and click it for an instantaneous 
evaluation, based on the currently configured rules in place. 
 

Quickly target and resolve Search Engine Optimization (SEO) issues, which can affect how easily your 
pages are found, and ultimately conversion rates, using included best practices and rule customization. 

• Quickly target and resolve URL structure and code issues, as well as privacy and cookie policy 
inclusion and mobile device optimization. 

• Automatically monitor your digital properties 24/7, by crawling your sites, regardless of channel, 
with configurable frequency. 

• Protect your brand with reporting for brand violations such as usage of correct logo, color 
palette, font, punctuation, image assets, consistent use of terminology, language clarity, 
prohibited terms, etc., across all digital experiences. 

• Detect and track key digital assets across all of your sites, making it easy to review and replace 
files. 
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ANOTHER POINT OF VIEW, THE WEBSITE DASHBOARD OVERVIEW (18) 
• The online DQM Website Dashboard also known as the Analyzer.  
• There are five tabs: Overview, Issues (with options: Priority issues, All issues, Issues by topic, 

Worst pages), Spelling, (with options: Misspellings by word, Misspellings by page) Inventory 
and Accessibility.  

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

There are four tabs: 
Overview, Issues 

Spelling and Content. 
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ISSUES: CATEGORIES AND RULES 
Most of your time will be spent within Issues. Issues can be designated as prioritized. Standards can 
range from content presentation, links and images to URL structure and cookies. You can view the full 
list of Issues, as shown. 
  
Working with these tools empowers your content management team, by reducing the chance of 
introducing compliance issues, so they can focus on creating conversion-centric content for your 
organization. 
  
You can have as many websites in the platform as desired and administer each one on a separate 
dashboard. 
  
The table on your screen lists all the rules from this page. Use the scrollbar to view them all. 
 
 
MANAGING YOUR SEO USING THE DQM OVERVIEW DASHBOARD SCREEN 
To quickly manage your SEO using the DQM Overview Dashboard screen, go to the Issues tab and 
select Issues by Topic. 
 
From this screen, select the SEO category.  
 
The issues that are pertinent to SEO optimization are provided by topic: Content Presentation, Links, 
Images, Rich Media and Titles and Metadata. Each category displays the number of occurrences.  
 
Expand a category to immediately address those issues, in context from the Overview page. Let's look 
at one of the major issues that directly affects not only your site's ranking but user experience and 
response, Page Load Performance.  You can speed up page loading time by optimizing your images, 
with the goal of making file sizes as small as possible, without sacrificing image quality. 
 
Large images slow down page download, which can cause visitors to leave your site and go elsewhere, 
affecting the time spent on that page. This is an important ranking factor that tells Google how relevant 
your page is to visitors. 
 
 

Page download speeds of more than one second are subject to search engine 
penalties when exceeded, and affect not only consumer engagement but 

whether that consumer will ever return to your site. 
 

Google estimates that 61% of users are unlikely to return to 
a mobile site they had trouble accessing and 

40% visit a competitor’s site instead. 
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Here, we clicked Images larger than 500 KB.  View the images under this category by thumbnails or 
filenames and sort by size or date. Click on an image to see additional properties and a list of how 
many pages in your site the image is linked to, listed by links to each affected page in your site, so that 
you can address the issue and see the result. 
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Address Metadata Keywords by Page 
Remember those keywords we discussed earlier?  You can quickly analyze and address their usage in 
every page of your site, by going to Issues by Topic > TITLE & METADATA, you can view pages 
without Metadata Keywords or Metadata Descriptions, with counts and a link to each individual 
page.  Once a result link is clicked, you can sort page results in ascending or descending order by date, 
name and size.  Rules below are: 

• Pages should contain metadata description 
• Limit <title> tags to 60 characters or less 
• The title tag should contain the company name 
• Do not use multiple title tags   
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OPTIMAL KEYWORD DENSITY AND MODERN SEO POWER STRATEGIES AND TIPS 
Remember those keywords we discussed earlier?  You can quickly analyze and address their usage in 
every page of your site, by topic, with counts and a link to each individual page.  Once a result link is 
clicked, you can sort page results in ascending or descending order by date, name and size.  You can 
achieve maximum search engine effectiveness, by utilizing some strategies with this powerful tool. The 
following page elements are the best places to use keywords for maximum impact on your rankings. 

Meta Description Tag  
The content of this tag displays on the search engine results page, below your Page Title. This tag 
should be on every page and customized by page.  Quickly address all pages without this tag from one 
location by going to Issues > Issues by Topic > SEO > TITLE & METADATA. The Website 
Dashboard Analyzer returns results and links for pages breaking configured meta description rules 
such as: 

• Pages should contain metadata description 
 

Title Tag  
This is not the Page Title. This text displays in bolded blue text on Google search engine results pages.  
Also under Issues > Issues by Topic > SEO > TITLE & METADATA are rules such as: 

• Limit <title> tags to 60 characters or less 
• The title tag should contain the company name 
• Do not use multiple title tags   
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Page Title 
This is the actual page title your visitors see on the pages of your site. Don’t use images, include your 
keywords, and enclose in an <h1> tag. Access and address under Issues > Issues by Topic > SEO > 
Content Presentation. 
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HTML and JavaScript  
SEO ranking calculation evaluates how high up on the page keywords appear.  Externalizing 
JavaScript leaves more room in the top portion of your pages’ code. 

Site Text 
Utilize your keywords well in the text of your site, but with an eye toward high readability. 3-6% density 
is a good rule of thumb to avoid the risk search engine spam labeling. 
 

Keywords in Links 
Use your keywords in the links on your site and in the Name Attribute of your link tags, as well as in 
your sidebar and footer. 
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Alt Tags 
Each image on your site should have an Alt Tag.13  Alt Tags are important for 508 compliance screen 
readers, such as Job Access with Speech (JAWS), which generates audial speech and Braille output 
for users with vision impairment. You can also utilize this descriptive text to include your keywords! 
 
Address every page with missing alt tags by clicking Issues > Issues by Topic > Images.   

 
Non-compliance can be a costly mistake for websites that do not provide 

accessibility to all. 

 

Filenames 
Filenames of pages and images are another place to include your keywords. Filenames display in 
page URLs and using keywords here can really help your rankings. Optimize those URLs using the 
LINKS category under Issues by Topic > SEO.  
 
  

                                                
13 Alt tags, also known as "alt attribute" and "alt description," is an HTML attribute applied to image tags to provide 

a text alternative for search engines. Applying images to alt tags such as product photos can positively impact 
an ecommerce store's search engine rankings. 
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Your Domain Name 
Use your primary keyword in your domain name, if possible for considerable improvement in your 
rankings, because this implies to the search engine that the entire content of your site is centered 
around your keyword. 
 
http://www.wordstream.com/meta-tags 
 
  

http://www.wordstream.com/meta-tags
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SUPPORTED BROWSERS FOR CMS AND CROWNPEAK 
Below is a list of the browsers that are currently supported by both CMS and Crownpeak.  These 
browsers have been tested against the latest versions, as well as through an automated process and 
support both PC and Mac operating systems. 
 

• Latest version of Chrome (Chrome 67) 
• Internet Explorer 11.0 
• Latest version of Safari 

 

QUESTIONS? 
While one of the most obvious advantages of CMS's features is its ease of use, we understand that you 
may have questions.  Should you need additional training on a specific capability of the CMS 
application, or just need to develop a deeper understanding of how to most effectively wield its powerful 
potential, please reach out to our responsive delivery or support teams. 
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